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はじめに 1
Molecule Profiler ソフトウェアを使用して、Analyst TF ソフトウェアおよび SCIEX OS で取得した
データ内の分子およびその誘導体（不純物や代謝物の可能性を含む）を探索し、レポートを作成し
ます。

Molecule Profiler ソフトウェアは、10 kDa 未満の低分子、ペプチド、抗体薬物複合体、オリゴヌクレ
オチドの同定をサポートします。

化合物を選択する バッチを処理する 結果を確認する 結果を絞り込む

化合物ライブラリ バッチの作成 Results ワークス
ペースの概要

MS/MS データの
特性評価

生体内変換セット
の作成

処理パラメータの
設定

結果フィルターの
概要

結果の相関性

処理パラメータの
設定

バッチオプションを
指定する

結果の編集 Correlation ワーク
スペースでレポー

トを作成する

または

バッチのインポート Add MS/MS ボタ
ンで複数のスペク
トルを追加する

Results ワークス
ペースでレポート

を作成する

分子の候補とその誘導体の見つけ方
このソフトウェアには、目的のサンプルに含まれている可能性のある分子を見つけるために使用す
る、一連のピーク検出戦略またはアルゴリズムが備わっています。ピーク検出戦略の概要を参照し
てください。

見つかったピークが予測される分子である場合、ソフトウェアは前駆体または 1 つ以上の変換の組
み合わせから得た特定の名前を割り当てます。ワークフローに基づいて、選択した生体内変換セッ
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ト、開裂代謝物の候補または加水分解開裂の候補、または抗体からの配列フラグメントの候補を変
換に含めることができます。

低分子データ分析の場合は、選択した生体内変換セットと開裂代謝物の候補を変換に含めます。

ペプチドデータ分析の場合は、選択した生体内変換セットと加水分解開裂の候補を変換に含めま
す。

抗体薬物複合体（ADC）データ分析の場合は、選択した生体内変換セット、開裂代謝物の候補、消
化された抗体タンパク質からの配列フラグメントの候補を変換に含めます。

オリゴヌクレオチド分析では、代謝物と不純物の両方に適した生体内変換セットの選択、さらに開裂
代謝物の候補、内部 n-1 および末端 n+1 配列を変換に含めます。

一般的なピーク検出戦略を使用した場合、ピークが想定外の分子であれば、一般的な Loss of ま
たは Gain of の名前と、分子イオン電荷でのプロトン付加体が割り当てられます。

サンプルと一緒に対照ファイルを選択した場合は、ソフトウェアがサンプルと対照データの比較を行
います。サンプルと一緒にアナログファイルを選択した場合は、ソフトウェアが MS データとアナログ
データの比較を行います。

各アルゴリズムを制御するパラメータは、ユーザーが変更できます。パラメータ値の選択を参照して
ください。

Molecule Profiler ワークスペースを開く
SCIEX OS ソフトウェアバージョン 2.1.5 以降がインストールされ、有効な Molecule Profiler ソフト
ウェアライセンスが有効化されている必要があります。

1. Start メニューからソフトウェアを選択します: Start > SCIEX OS > SCIEX OS

ソフトウェアが Integrated モード用に構成されている場合は、ホームページが開きます。

ソフトウェアが Mixed モード用に構成されている場合は、Logon ダイアログが開きます。次の
手順に進みます。

2. Logon ダイアログが開いたら、ソフトウェアの使用を許可されているユーザーのユーザー名と
パスワードを入力し、OK をクリックします。
ホームページが開きます。

3. Molecule Profiler タイルをクリックします。

図 1-1 : Molecule Profiler タイル

Molecular Profiler ワークスペースが開きます。

はじめに
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Molecule Profiler ウィンドウ

図 1-2 : Molecule Profiler ウィンドウ

項目 説明

1 ワークスペースのリスト

2 Batch ワークスペース。このワークスペースを使用して、代謝物の候補を探索
できます。Batch ワークスペースの概要を参照してください。

3 Results ワークスペース。このワークスペースは、処理後の代謝物候補を表
示するために使用します。Results ワークスペースの概要を参照してくださ
い。

4 Correlation ワークスペース。このワークスペースは、異なる Results ファイル
で検出された代謝物を比較するために使用します。Correlation ワークスペー
スの概要を参照してください。

5 ワークフローリスト

6 化合物ライブラリ。化合物ライブラリを作成し、管理します。化合物ライブラリを
参照してください。

はじめに
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項目 説明

7 生体内変換。一般的な変換のリストを作成し、管理します。生体内変換セット
を参照してください。

8 パラメータの処理。Batch ワークスペースで使用できる処理メソッドを作成し、
管理します。処理メソッドの作成を参照してください。

9 メニューバー。表 1-1 を参照してください。

表 1-1 : メニューコマンド

項目 説明

File メニュー

New • Batch: 新しいバッチを作成します。バッチの作成を参照してください。

• Correlation: 新しい相関を作成します。相関の準備を参照してください。

Open • Batch: バッチを開きます。

• Correlation: 相関ファイルを開きます。

• Results: Results ファイルを開きます。

Save Batch Batch ワークスペースにバッチを保存します。

Save Batch As Batch ワークスペースにバッチを別名で保存します。

Create Report レポートを作成します。レポートを参照してください。

Recent reports 最近のレポートを開きます。

Edit メニュー

Edit Name 化合物の名前と式を編集します。

Copy Selected
Table

選択した表をコピーします。

Copy Selected
Graph

選択したグラフをコピーします。

Copy Batch
Row

選択したバッチ行をコピーします。

Paste Batch
Row

コピーしたバッチ行を、選択した場所に貼り付けます。

Clear Batch
Row

選択したバッチ行の内容を削除します。

Delete Selected
Row

選択した行を Results 表から削除します。ソフトウェアが結果を再計算しま
す。

Undo Delete 最後に削除された行を復元します。ソフトウェアが結果を再計算します。

はじめに
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表 1-1 : メニューコマンド (続き)

項目 説明

Hide
Unchecked
Rows

選択されていない行を非表示にします。

Show Hidden
Rows

選択されていない行を表示します。

Custom
Elements

Custom Elements ダイアログを開きます。このダイアログを使用して、アミノ
酸やオリゴヌクレオチド残基を定義します。Custom Elements を参照してくだ
さい。

Setup メニュー

Compound
Library

化合物ライブラリを開きます。化合物ライブラリを参照してください。

Biotransformati
ons

生体内変換セットのリストを開きます。生体内変換セットを参照してください。

Processing
Parameters

処理メソッドウィンドウを開きます。処理メソッドの作成を参照してください。

Filters • Results: Results ワークスペースのフィルターを設定します。結果フィルタ
ーの概要を参照してください。

• Correlation: Correlation ワークスペースのフィルターを設定します。相関
フィルターの概要を参照してください。

• Interpretation: Interpretation ワークスペースのフィルターを設定します。

Create New
Folder

フォルダーを作成します。フォルダーの作成を参照してください。

フォルダーの作成
フォルダーには、目的のサンプルに含まれる分子の候補を見つけるためにソフトウェアが必要とす
るファイルや、Results ファイルが格納されます。

カスタムフォルダーを作成して結果を整理することも可能です。

1. Setup > Create New Folder をクリックします。
Create New Folder ダイアログが開きます。

2. フォルダーの Name を入力します。

Location フィールドには、Data ディレクトリ
（C:\ProgramData\SCIEX\Molecule Profiler\Data）のインストール先が表示され

ます。作成されたすべてのフォルダーは、このディレクトリに格納されます。

3. OK をクリックします。

はじめに

ソフトウェアユーザーガイド
RUO-IDV-05-12707-JA-A

Molecule Profiler ソフトウェア
7/136



フォルダーを作成すると、Processing Parameters フォルダーおよび Results フォルダ

ーという 2 つのサブフォルダーが自動的に作成されます。

はじめに
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Custom Elements 2
Custom Elements ダイアログには、以下のタブが含まれています。

• AA List タブには、標準アミノ酸のリストに関する情報が含まれています。この情報は編集や削
除ができません。ユーザーはこのリストにカスタムアミノ酸を追加でき、必要に応じて追加した項
目を修正・削除できます。追加したアミノ酸は、自動的にリストの一番下に追加されます。ただ
し、列のヘッダーをクリックすることで並べ替えが可能です。

• AA Modifications タブには、ペプチドの末端基やアミノ酸残基の側鎖に適用できるさまざまな修
飾の質量シフト情報が含まれています。この情報は編集や削除ができません。ユーザーはリスト
にカスタムアミノ酸修飾を追加でき、必要に応じて追加した項目を修正・削除できます。追加した
アミノ酸修飾は、自動的にリストの一番下に追加されます。ただし、列見出しをクリックすることで
並べ替えが可能です。

• Oligo List タブには、事前に定義されたオリゴヌクレオチド残基と末端基がすべて含まれていま
す。この情報は編集や削除ができません。ユーザーはこのリストに新しいオリゴヌクレオチド残基
と末端基を追加でき、必要に応じて追加した項目を修正・削除できます。追加した残基は、自動
的にリストの一番下に追加されます。ただし、列のヘッダーをクリックすることで並べ替えが可能
です。

カスタムアミノ酸

カスタムアミノ酸の作成

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. AA List タブが選択されていることを確認します。

3. New をクリックします。
New Custom Amino Acid Residue ダイアログが開きます。

4. 次の表に説明しているフィールドに入力し、OK をクリックします。

表 2-1 : New Custom Amino Acid Residue ダイアログのフィールド

フィールド 説明 使用可能な値

Name アミノ酸の名前 英数字

Symbol アミノ酸の記号 • 英数字

• 最初の文字は大文字に

Residue
Formula

アミノ酸の式 周期元素を用いた実験式。濃縮同位
体を式の一部として使用することも可
能です。たとえば、13C は炭素数 13
の同位体を示します。

カスタムアミノ酸はアミノ酸表の一番下に追加され、名前、記号、質量が表示されます。

Custom Elements
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カスタムアミノ酸の編集

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. AA List タブが選択されていることを確認します。

3. 編集するアミノ酸を選択します。

注: 編集できるのは、ユーザーが追加したカスタムアミノ酸のみです。ソフトウェアに付属してい
るアミノ酸は編集できません。

4. Edit をクリックします。
Edit Custom Amino Acid Residue ダイアログが開きます。

5. 次の表に説明しているフィールドを編集します。

表 2-2 : Edit Custom Amino Acid Residue ダイアログのフィールド

フィールド 説明 使用可能な値

Name アミノ酸の名前 英数字

Symbol アミノ酸の記号 • 英数字

• 最初の文字は大文字に

Residue
Formula

アミノ酸の式 周期元素を用いた実験式

6. OK をクリックします。
選択したカスタムアミノ酸の名前、記号、質量が、該当する場合、アミノ酸表で更新されます。

カスタムアミノ酸の削除

注: 処理メソッドや結果で使用しているカスタムアミノ酸を削除すると、予期せぬ動作が発生すること
があります。

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. AA List タブが選択されていることを確認します。

3. 削除するアミノ酸を選択します。

注: 削除できるのは、ユーザーが追加したカスタムアミノ酸のみです。ソフトウェアに付属してい
るアミノ酸は削除できません。

4. Delete をクリックします。
カスタムアミノ酸がアミノ酸表から削除されます。

Custom Elements
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カスタムアミノ酸修飾

カスタムアミノ酸修飾の作成

注: カスタムアミノ酸修飾は、標準アミノ酸にのみ適用可能です。

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. AA Modifications タブが選択されていることを確認します。

3. New をクリックします。
New Custom Amino Acid ダイアログが開きます。

4. 次の表に説明しているフィールドに入力し、OK をクリックします。

表 2-3 : New Custom Modification ダイアログのフィールド

フィールド 説明 使用可能な値

Name 残基の名前 英数字

Symbol 残基の記号 • 必ず _ で始まること

• 英数字

• 最初の文字は大文字に

Formula Gain 残基で得られる式 周期元素を用いた実験式

Formula Lost 残基で失われる式 周期元素を用いた実験式

Mod Type 修飾の位置 アミノ酸、N 末端、C 末端、タンパク
質 N 末端、タンパク質 C 末端

Applies to AA 関連するアミノ酸の名前 カスタム修飾を適用する標準アミノ酸
を 1 文字で表したもの。たとえば、P
はプロリンを表します。すべての標準
アミノ酸にカスタム修飾を適用する場
合は、このフィールドを空欄にします。

カスタムアミノ酸はアミノ酸修飾表の一番下に追加され、記号、質量シフト、名前が表示されま
す。

カスタムアミノ酸修飾の編集

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. AA Modifications タブが選択されていることを確認します。

3. 編集する修飾を選択します。

注: 編集できるのは、ユーザーが追加した修飾のみです。ソフトウェアに付属している修飾は編
集できません。

Custom Elements
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4. Edit をクリックします。
Edit Custom Modification ダイアログが開きます。

5. 次の表に説明している適切なフィールドを編集します。

表 2-4 : Edit Custom Modification ダイアログのフィールド

フィールド 説明 使用可能な値

Name 残基の名前 英数字

Symbol 残基の記号 • 必ず _ で始まること

• 英数字

• 最初の文字は大文字に

Formula Gain 残基で得られる式 周期元素を用いた実験式

Formula Lost 残基で失われる式 周期元素を用いた実験式

Mod Type 修飾の位置 アミノ酸、N 末端、C 末端、タンパク
質 N 末端、タンパク質 C 末端

Applies to AA 関連するアミノ酸の名前 カスタム修飾を適用する標準アミノ酸
を 1 文字で表したもの。たとえば、P
はプロリンを表します。すべての標準
アミノ酸にカスタム修飾を適用する場
合は、このフィールドを空欄にします。

6. OK をクリックします。
選択したカスタム修飾の名前、記号、質量シフトが、該当する場合、修飾表で更新されます。

カスタムアミノ酸修飾の削除

注: 処理メソッドや結果で使用しているカスタムアミノ酸修飾を削除すると、予期せぬ動作が発生す
ることがあります。

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. AA Modifications タブが選択されていることを確認します。

3. 削除する修飾を選択します。

注: 削除できるのは、ユーザーが追加したカスタム修飾のみです。ソフトウェアに付属している
修飾は削除できません。

4. Delete をクリックします。
カスタム修飾が修飾表から削除されます。

Custom Elements
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カスタムのオリゴヌクレオチド残基または末端基
カスタム要素を使用して、オリゴヌクレオチドのコア構造に追加できるカスタム官能基を含む配列を
作成します。これらの修飾を配列に入力し、Molecule Profiler ソフトウェアで探索・識別できます。

オリゴヌクレオチドは、いくつかの部分構造に分解できます。

図 2-1 : オリゴヌクレオチドの部分構造

オリゴヌクレオチドのコア部分構造を変更したり、コア、末端、リン酸骨格を新規に定義したりできま
す。カスタム修飾配列を作成する場合は、この一般的な構造を使用します:

5'-(Terminus Moiety)-(Terminus Linker)-(Terminus Phosphate Core)-(Residue Type)1-…-
(Residue Type)n-(Terminus Phosphate Core)-(Terminus Linker)-(Terminus Moiety)-3'

New Oligo Residue or Terminus ダイアログの Type フィールドには、事前に定義されたいくつか
のタイプの残基または末端があります。これらの事前に定義されたタイプは、オリゴヌクレオチドの
特定の部分構造に編集を制限し、タイプ自体に特化した修飾の作成を簡素化するものです。各タイ
プが上記の一般的な構造にどのように当てはまるかを理解するために、次の表を参照してくださ
い。

表 2-5 : 種類

種類 カテゴリ 編集可能な部分構造

DNA 残基のタイプ 塩基

DNA* 残基のタイプ 塩基

RNA 残基のタイプ 塩基

RNA* 残基のタイプ 塩基

2'-O-Methyl RNA 残基のタイプ 塩基

2'-O-Methyl RNA* 残基のタイプ 塩基

Custom Elements
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表 2-5 : 種類 (続き)

種類 カテゴリ 編集可能な部分構造

ロック（LNA） 残基のタイプ 塩基

ロック（LNA）* 残基のタイプ 塩基

その他の残基 残基のタイプ 塩基

5'リンカー

糖コア

3'リンカー

リン酸コア

リン酸化末端* 末端部分 末端部分

リン酸化末端 末端部分 末端部分

もう 1 つの末端 末端部分

末端リンカー

末端リン酸コア

末端部分

末端リンカー

リン酸コア

* ホスホロチオエート骨格

化学式を追加・編集するための最も柔軟なタイプは「その他の残基」です。複数の異なるカスタム部
分構造に対応するように変更することも可能であり、ユーザーは高度にカスタマイズされたオリゴヌ
クレオチドを定義できます。同様に、「もう 1 つの末端」タイプでは、カスタムの 5' または 3'-末端、リ
ンカー、コアを定義することができます。

たとえば、カスタムオリゴヌクレオチドの例を参照してください。

オリゴヌクレオチド残基または末端基をカスタムで作成する

ヒント! 既存のものをコピーしてオリゴヌクレオチド残基や末端基を作成するには、Oligo List タブで
既存のものを選択し、New From をクリックします。

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. Oligo List タブが選択されていることを確認します。

このリストには、事前に定義されたオリゴヌクレオチド残基と末端基がすべて含まれています。

3. New をクリックします。
New Oligo Residue or Terminus ダイアログが開きます。

4. ダイアログのフィールドに入力します。たとえば、カスタムオリゴヌクレオチドの例を参照してくだ
さい。

5. OK をクリックします。

Custom Elements
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カスタム残基または末端基は、表の一番下に追加されます。

カスタムのオリゴヌクレオチド残基または末端基を編集する

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. Oligo List タブが選択されていることを確認します。

3. 編集する残基または末端基を選択します。

注: 編集できるのは、ユーザーが追加した残基と末端基のみです。ソフトウェアに付属している
残基と末端基は編集できません。

4. Edit をクリックします。
Edit Custom Amino Acid Residue ダイアログが開きます。

5. 残基または末端基のプロパティを編集します。

6. OK をクリックします。

カスタムのオリゴヌクレオチド残基または末端基を削除する

注: 処理メソッドや結果で使用しているカスタムのオリゴヌクレオチド残基または末端基を削除する
と、予期せぬ動作が発生することがあります。

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. Oligo List タブが選択されていることを確認します。

3. 削除する残基または末端基を選択します。

注: 削除できるのは、ユーザーが追加した残基と末端基のみです。ソフトウェアに付属している
残基と末端基は削除できません。

4. Delete をクリックします。
カスタム残基または末端基は、表から削除されます。

オリゴヌクレオチド残基と末端基のインポート

オリゴヌクレオチド残基と末端基はテキストファイルからインポートできます。

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. Oligo List タブが選択されていることを確認します。

このリストには、事前に定義されたオリゴヌクレオチド残基と末端基がすべて含まれています。

3. Import をクリックします。
Import Text File ダイアログが開きます。

4. テキストファイルに移動して右クリックし、Open をクリックします。
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オリゴヌクレオチド残基と末端基のエクスポート

オリゴヌクレオチド残基と末端基はテキストファイルに出力できます。

1. Edit > Custom Elements をクリックします。
Custom Elements ダイアログが開きます。

2. Oligo List タブが選択されていることを確認します。

このリストには、事前に定義されたオリゴヌクレオチド残基と末端基がすべて含まれています。

3. エクスポートするオリゴヌクレオチド残基と末端基を選択します。

ヒント! Ctrl+A を押して、リスト内のすべての残基と末端基を選択します。

4. Export をクリックします。
Save As ダイアログが開きます。

5. エクスポートしたオリゴヌクレオチド残基と末端基を保存するテキストファイルの名前を入力しま
す。
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化合物ライブラリ 3
化合物ライブラリは、化合物の化学式、構造または配列、同位体パターン、MS/MS スペクトルなど
の情報を格納しています。また、化合物ごとに基準スペクトルを指定することも可能です。ライブラリ
の各エントリを使用して、処理パラメータを作成できます。

ソフトウェアには基本的な化合物ライブラリがインストールされていますが、ユーザーはエントリを追
加、編集、削除してライブラリをカスタマイズできます。

注: 各エントリには、化学式と少なくとも 1 つの MS/MS スペクトルが必要です。

化合物ライブラリのオプション

構造の追加 ペプチド配列の追加 オリゴヌクレオチド配列の追加

構造と配列の使い方
化学構造、ペプチド、オリゴヌクレオチドの配列は、開裂代謝物の候補など、化合物固有のパラメー
タ値を生成するためにソフトウェアが使用します。

注: ソフトウェアは、構造または配列から化学式を自動生成します。

ソフトウェアは、マルクーシュ構造や多重構造を含む v2000 と v3000 の両方の mol ファイルを受
け入れます。

構造の追加
wiff ファイルや txt ファイルを使用して、化合物ライブラリの個々のエントリに基準スペクトルを追加
します。

1. Workflow パネルで Compound Library をクリックします。
Compound Library ダイアログが開きます。

2. 次のいずれかの操作を行います。

• 新しい化合物を作成します。

a. New をクリックし、オプションリストから Structure を選択します。

New Entry ダイアログが開きます。

b. 化合物に Name を入力し、OK をクリックします。

Compound Library ダイアログの Compound name フィールドに、指定した名前が
自動的に入力されます。

• Compound name フィールドに表示されるリストから化合物を選択します。
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Compound Library ダイアログが、選択した化合物に対応する情報で更新されます。

3. Open Structure をクリックします。
Open Structure File ダイアログが開きます。

4. 有効な mol ファイルに移動し、選択します。

5. Open をクリックします。

Compound Library ダイアログの以下のフィールドが自動入力されます。

• 構造

• 化学式

• 極性

• 同位体パターン

デフォルトでは、Adduct フィールドには一価のプロトン付加体 [M+H]+ または [M-H]- が入力
されます。ソフトウェアはまた、m/z フィールドを適切な情報に更新します。

6. 測定の Polarity を選択します。
選択した極性に基づいて、Compound Details タブの Isotope Pattern、m/z、Adduct の値
が更新されます。

7. 以下のフィールドに適切な情報を入力してください。

• 化合物クラス

• CAS 番号

• コメント（たとえば、代謝物クラスに関する情報をこのフィールドに追加できます。）

8. Experimental Data タブを開きます。

9. 次のいずれかの操作を行います。

• wiff ファイルから基準 MS/MS スペクトルを追加するには、wiff ファイルから基準 MS/MS
スペクトルを追加するに進んでください。

• txt ファイルから基準 MS/MS スペクトルを追加するには、txt ファイルから基準 MS/MS ス
ペクトルを追加するに進んでください。

ペプチド配列の追加
wiff ファイルや txt ファイルを使用して、化合物ライブラリの個々のエントリに基準スペクトルを追加
します。

1. Workflow パネルで Compound Library をクリックします。
Compound Library ダイアログが開きます。

2. New をクリックし、オプションリストから Sequence を選択します。
New Entry ダイアログが開きます。

3. 化合物に Name を入力し、OK をクリックします。
Compound Library ダイアログの Compound name フィールドに、指定した名前が自動的に
入力されます。
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4. Sequence フィールドに適切なペプチド配列を入力します。

注: 配列にはカスタム要素を含めることができます。Custom Elements を参照してください。

5. Chemical formula フィールドをクリックします。

Compound Library ダイアログの以下のフィールドが自動入力されます。

• 化学式

• 極性

• 同位体パターン

デフォルトでは、Adduct フィールドには二重電荷のプロトン付加体 [M+2H]2+ または
[M-2H]2- が入力されます。ソフトウェアはまた、m/z フィールドを適切な情報に更新します。

6. 測定の Polarity を選択します。
選択した極性に基づいて、Compound Details タブの Isotope Pattern、m/z、Adduct の値
が更新されます。

7. Experimental Data タブをクリックします。

8. 次のいずれかの操作を行います。

• wiff ファイルから基準 MS/MS スペクトルを追加するには、wiff ファイルから基準 MS/MS
スペクトルを追加するに進んでください。

• txt ファイルから基準 MS/MS スペクトルを追加するには、txt ファイルから基準 MS/MS ス
ペクトルを追加するに進んでください。

ペプチド配列の命名規則

表 3-1 : ペプチド配列

特性 入力規則 例

複数チェーン / LIGHTCHAIN /

HEAVYCHAIN

アミノ酸の修飾: 側鎖 [記号] M[Oxi]

アミノ酸の修飾: C 末端 -[記号] Y-[Ami]

アミノ酸の修飾: N 末端 [記号]- [1Me]-Y

結合 • 結合された各残基に [*#] を
付ける

• リンクしている各残基の番
号

S-S Bridge:

MYC[*1]PEPC[*1]TIDE

化合物ライブラリ

ソフトウェアユーザーガイド
RUO-IDV-05-12707-JA-A

Molecule Profiler ソフトウェア
19/136



表 3-2 : 結合

結合の種類 規則 例

S-S ブリッジ ブリッジの両残基に [*#] を追
加する

シングルチェーン:

MYC[*1]PEPC[*1]TIDE

マルチチェーン:

LIGHTC[*1]HAIN /

MC[*2]HEAVYC[*1]HAINC[*2
]AD

エステル / アミドブリッジ 結合残基の 1 つに '[O-1]' を追
加する

MYR[*1]PEPD[*1][O-1]TIDE

環状 C タームに '[H]' を追加する M[*1]YCPEPCTIDE[*1]-[H]

ループ: 最初または最後のイン
デックスでリンクしている残基
と、末端基が架橋結合の一部
でないもの

末端基を明示的に追加する [H]-C[*1]YCPEPCTIDC[*1]-
[OH]

オリゴヌクレオチド配列の追加
オプションで、化合物ライブラリにオリゴヌクレオチド化合物情報を追加します。ライブラリ内の化合
物には MS/MS スペクトルがあり、処理時に使用されます。

注: 化合物がライブラリにない場合は、ユーザーが手動で処理メソッドに追加できます。

配列はテキスト形式で追加されます。治療用オリゴヌクレオチドの多様な修飾やカスタム要素を取り
込むには、配列入力のルールを守ってください。オリゴヌクレオチド配列の命名規則を参照してくだ
さい。修飾やカスタム要素の詳細なリストについては、Custom Elements を参照してください。

1. Workflow パネルで Compound Library をクリックします。

2. New > Oligonucleoide Sequence をクリックします。
New Entry ダイアログが開きます。

3. オリゴヌクレオチド配列の Name を入力し、OK をクリックします。

4. Sequence 表に配列を入力します。

注: 配列にはカスタム要素を含めることができます。Custom Elements を参照してください。

5. Chemical formula フィールドをクリックすると化学式が自動的に更新されます。

6. （オプション）Compound Details タブのフィールドに情報を入力します。

7. Experimental Data タブをクリックします。

8. 次のいずれかの操作を行います。
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• wiff ファイルから基準 MS/MS スペクトルを追加するには、wiff ファイルから基準 MS/MS
スペクトルを追加するに進んでください。

• txt ファイルから基準 MS/MS スペクトルを追加するには、txt ファイルから基準 MS/MS ス
ペクトルを追加するに進んでください。

オリゴヌクレオチド配列の命名規則

オリゴヌクレオチド配列は、塩基に特徴的な 1 文字の識別子で指定できます。

• アデニン（A）

• シトシン（C）

• チミン（T）

• グアニン（G）

• ウラシル（U）

デオキシリボ核酸（DNA、d）、リボ核酸（RNA、r）などのオリゴヌクレオチド型は、配列の先頭に 1
文字、または混合オリゴヌクレオチド型は塩基間に 1 文字の識別子を追加して識別することができ
ます。

ロック核酸（LNA）のように合成ヌクレオチドを含むオリゴヌクレオチドでは、配列を定義する際に各
残基の完全な記号を使用します。たとえば、LNA-A は lA、2'-メトキシメチル-A は moA となります。

各塩基の末端にはホスホロチオエート（HPSO、*）などの骨格修飾が加えられています。

特定のオリゴヌクレオチド残基の後に炭素 13(/13Cn/)などの重原子が付加されます。n は重原子
の数を表します。

注: 上記の例では、"/13Cn/" という表記で、既存の式に重原子を追加しています。核酸塩基の原子
を重い標識に置き換えるわけではありません。同位体で標識された核酸塩基を定義するには、カス
タム修飾が必要です。

ユーザー定義のカスタム修飾を識別するために、最初と最後の文字としてスラッシュ（/）を使用しま
す。カスタム修飾の追加、および修飾の追加使用例と関連する命名規則については、Custom
Elements を参照してください。

表 3-3 : オリゴヌクレオチドの表記方法

特性 入力規則 例

DNA d dACG T

RNA r rACG U

DNA と LNA の混合 d, l dACG lT

ホスホロチオエート骨格 * dA*C*G* T*

2'　メトキシメチル（2'MOE）糖
修飾

mo moAmoCmoG moT

炭素 13 /13Cn/ dACG T/13C2/
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表 3-3 : オリゴヌクレオチドの表記方法 (続き)

特性 入力規則 例

カスタム残基 // dACG / その他の残基 /

wiff ファイルから基準 MS/MS スペクトルを追加する
1. Open wiff File をクリックします。

Select Data ダイアログが開きます。

2. 適切な場所に移動し、追加する化合物のスペクトルを含む wiff ファイルを選択し、OK をクリッ
クします。

注: wiff ファイルには、プレカーサーイオンとして化合物が含まれている必要があります。

表 3-4 : 基準スペクトルの追加

ファイルに複数の前駆体が含まれている ファイルに 1 つの前駆体が含まれている

選択した wiff ファイルに複数の前駆体がある
場合は、Select a Spectrum ダイアログが開
き、利用可能な前駆体ごとに Precursors 表に
以下の情報が表示されます。

• m/z

• 時間(分)

• 品質

• 電荷

wiff ファイルに前駆体が 1 つしか含まれていな
い場合、MS/MS Spectrum ウィンドウはそのス
ペクトルで更新されます。

適用するフィルターのチェックボックスをオンに
します。

必要に応じて、1 つまたは両方のフィルターオ
プションを選択します。Precursors 表が更新さ
れ、指定された条件を満たす行のみが表示さ
れます。

ソフトウェアは、選択した前駆体の m/z と
Charge、および実験の衝突エネルギーを使用
して、Compound Library ダイアログの
Spectra フィールドに一意の情報行を作成しま
す。たとえば、Prec(m/z), CE(collision energy
from experiment), Charge(Charge) がフィー
ルドに表示されます。

スペクトルのタイトルには、Compound
Information グループの Polarity と
Compound name に続き、Spectra フィール
ドの情報が表示されます。

Spectrum Details には、選択した MS/MS ス
ペクトルに対応する機器タイプ、保持時間、電
荷、衝突エネルギーが表示されます。この情報
は読み取り専用です。
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表 3-4 : 基準スペクトルの追加 (続き)

ファイルに複数の前駆体が含まれている ファイルに 1 つの前駆体が含まれている

Precursors 表の行を選択します。

MS/MS Spectrum ウィンドウが、選択した前駆
体のスペクトルで更新されます。

ヒント! 複数行を選択するには Ctrl+ クリックを
使用します。複数行を選択した場合は、最初に
選択した前駆体の MS/MS Spectrum が表示
されます。

—

Charge state from チェックボックスをオンに
した場合は、from と to の値をオプションから
選択します。from 値は Precursors 表の使用
可能な最小電荷状態と同等です。to 値は
Precursors 表に表示される使用可能な最大電
荷状態と同等です。

—

Quality above チェックボックスがオンの場合
は、表示されるフィールドに適切な値を入力し
ます。

—

OK をクリックします。 —

Precursors 表で選択した各行について、ソフト
ウェアは選択した前駆体の m/z と Charge、お
よび実験の衝突エネルギーを使用して、
Compound Library ダイアログの Spectra フィ
ールドに一意の情報行を作成します。たとえ
ば、Prec(m/z), CE(collision energy from
experiment), Charge(Charge) がフィールドに
表示されます。

Spectra フィールドに表示される情報と
MS/MS Spectrum フィールドに表示されるス
ペクトルは、Precursors 表で選択した最初の行
に対応します。

スペクトルのタイトルには、Compound
Information グループの Polarity と
Compound name に続き、Spectra フィール
ドの情報が表示されます。

Spectrum Details には、選択した MS/MS ス
ペクトルに対応する機器タイプ、保持時間、電
荷、衝突エネルギーが表示されます。この情報
は読み取り専用です。

—

3. （オプション）表示されたリストから別の Spectra を選択します。
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MS/MS Spectrum と Spectrum Details が更新され、選択内容に関連する情報が表示され
ます。

4. スペクトルを化合物の事前に定義されたスペクトルとして保存するには、表示されるリストから
適切な Spectra を選択し、Set as Reference をクリックします。
Spectra フィールドに表示される情報に - Reference が追加されます。たとえば、Prec
(xx.xx), CE(xx), Charge(xx) - Reference がフィールドに表示されます。

5. Save をクリックします。

6. OK をクリックします。
新しい化合物がライブラリに保存され、Compound Library ダイアログが閉じます。

txt ファイルから基準 MS/MS スペクトルを追加する
1. Open txt File をクリックします。

Open txt File ダイアログが開きます。

2. 適切な場所に移動し、MS/MS txt ファイルを選択して、OK をクリックします。
Spectrum Details ダイアログが開きます。

3. 選択したスペクトルの適切な情報を入力し、OK をクリックします。

ソフトウェアは、Precursor mass (m/z)、Collision energy、Charge フィールドの情報を使
用して、Compound Library ダイアログの Spectra フィールドの情報を生成します。フィールド
にはたとえば、Prec（前駆体質量（m/z））、CE（衝突エネルギー）、Charge（電荷）が表示されま
す。

Spectra フィールドに表示される情報と MS/MS Spectrum フィールドに表示されるスペクトル
は、選択した txt ファイルに対応します。

スペクトルのタイトルには、Compound Information グループの Polarity と Compound
name に続き、Spectra フィールドの情報が表示されます。

Spectrum Details には、選択した MS/MS スペクトルに対応する機器タイプ、保持時間、電
荷、衝突エネルギーが表示されます。この情報は読み取り専用です。

4. （オプション）表示されたリストから別の Spectra を選択します。
MS/MS Spectrum と Spectrum Details が更新され、選択内容に関連する情報が表示され
ます。

5. スペクトルを化合物の事前に定義されたスペクトルとして保存するには、表示されるリストから
適切な Spectra を選択し、Set as Reference をクリックします。
Spectra フィールドに表示される情報に - Reference が追加されます。たとえば、Prec
(xx.xx), CE(xx), Charge(xx) - Reference がフィールドに表示されます。

6. Save をクリックします。

7. OK をクリックします。
新しい化合物がライブラリに保存され、Compound Library ダイアログが閉じます。
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Results Table から化合物ライブラリに情報を追加す
る

注: この機能は、低分子およびペプチドの Results ファイルにのみ利用可能です。抗体薬物複合体
およびオリゴヌクレオチドの Results ファイルでは、この機能は利用できません。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Potential Metabolites 表の行を選択し、右クリックして Add to Compound Library を選択し
ます。

注: 選択した行に MS/MS スペクトルが含まれていない場合、Add to Compound Library オ
プションは利用できません。

6. 確認メッセージへの応答として OK をクリックします。

7. Workflow パネルで Compound Library をクリックします。
Compound Library ダイアログが開きます。追加した代謝物が Compound name リストに追
加されます。
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生体内変換セット 4
生体内変換セットは、一般的な変換のリストです。

生体内変換の概要
ユーザーは、ソフトウェアにインストールされている事前に定義された生体内変換セットを使用して
予測される代謝物を探索したり、新しい生体内変換セットを作成したりできます。たとえば、分析する
化合物ごとに異なるセットを作成することもできます。インストールされた生体内変換には、配列や
構造の自動提案の際に使用する埋め込み情報が含まれています。

メソッド固有の生体内変換セットは、各メソッドタイプのデフォルトとして使用されます。たとえば、ペ
プチドメソッドでは、バイオ医薬品生体内変換セットをデフォルトとして使用します。この生体内変換
セットは、ペプチドの生体内代謝反応に最も関連性の高い生体内変換を含んでいます。

オリゴヌクレオチドの場合は、事前に定義された 3 つの変換セットから 1 つを選択します。

• Oligonucleotide Basic: 修飾点の簡潔なリストを提供し、塩基または骨格に影響を与えるもの
のみに限定されます。

• Oligonucleotide Comprehensive: 合成、 代謝、保存の過程で起こりうるすべての転換を広
範囲にカバー。

• Oligonucleotide Metabolites: 包括的なセットのうち、 転換のみに焦点を当てたサブセットを
含んでいます。

サンプルの由来を考慮し、最も代表的なセットを選択してください。デフォルトのエントリから、または
新たなエントリを追加して、ユーザー独自の生体内変換セットを構築することができます。生体内変
換セットの作成および生体内変換セットの編集を参照してください。

化学式の変化を特定したり、既存の 2 つの生体内変換を組み合わせたりして、カスタム生体内変
換を作成します。

新規に作成する生体内変換セットには、カスタム生体内変換や既存セットの生体内変換を含めるこ
とができます。

ヒント! 生物製剤データを評価する場合は、可能性の高い生体内変換を選択して小規模なセットを
作成し、データの解析を迅速に行うことができます。

生体内変換セットの作成
1. Workflow パネルで Biotransformations をクリックします。

Biotransformations ダイアログが開きます。

2. New をクリックします。
New Biotransformation Set ダイアログが開きます。

3. Working biotransformation set フィールドにセットの名前を入力します。

4. New Biotransformation をクリックします。
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New Biotransformation ダイアログが開きます。

5. Name フィールドに生体内変換の名前を入力します。

6. （オプション）Description フィールドと Comments フィールドに、生体内変換に関連する適切
な詳細を入力します。

7. 次のいずれかの操作を行います。

表 4-1 : 生体内変換セットの作成

単一の生体内変換を作成する 複合的な生体内変換を作成する

Single biotransformation をクリックします。 Combined biotransformation をクリックしま
す。

Formula from フィールドで失われる構造の部
分を同定します。

Biotransformation 1 フィールドと
Biotransformation 2 フィールドのそれぞれ
から生体内変換を選択します。

Formula to フィールドに生体内変換の式を入
力します。

—

注: 利用可能な生体内変換は、ワーキングセット内に存在するものです。

注: ソフトウェアは、生体内変換による変化を自動的に計算し、Mass shift フィールドにこの値
を入力します。

8. OK をクリックします。
新しい生体組織変換は、生体組織変換のワーキングセットと生体組織変換のソースセットの両
方の表に表示されます。

9. OK をクリックして、新しい生体内変換セットを保存します。
New Biotransformation Set ダイアログが閉じます。

10. OK をクリックします。
Biotransformations ダイアログが閉じます。

生体内変換セットの編集
1. Workflow パネルで Biotransformations をクリックします。

Biotransformations ダイアログが開きます。

2. 表示されたリストから適切な Set を選択します。

3. Edit をクリックします。
Edit Biotransformation Set ダイアログが開き、選択したセットの名前が Working
biotransformation set フィールドに表示されます。

4. Working biotransformation set フィールドに適切なセットの名前を入力します。

5. 生体内変換のワーキングセット表で行を選択します。

6. Edit Biotransformation をクリックします。
Edit Biotransformation ダイアログが開きます。
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7. （オプション）Name、Description、Comments の各フィールドに必要な変更を加えます。

8. （オプション）次のいずれかの操作を行います。

表 4-2 : 生体内変換セットの編集

単一の生体内変換を作成する 複合的な生体内変換を作成する

Single biotransformation をクリックします。 Combined biotransformation をクリックしま
す。

Formula from フィールドで失われる構造の部
分を同定します。

Biotransformation 1 フィールドと
Biotransformation 2 フィールドのそれぞれ
から生体内変換を選択します。

Formula to フィールドに生体内変換の式を入
力します。

—

注: 利用可能な生体内変換は、ワーキングセット内に存在するものです。

9. OK をクリックします。
更新された生体組織変換は、生体組織変換のワーキングセットと生体組織変換のソースセット
の両方に表示されます。

10. OK をクリックすると、変更を保存できます。
Edit Biotransformation Set ダイアログが閉じます。

11. OK をクリックします。
Biotransformations ダイアログが閉じます。

生体内変換セットの削除
1. Workflow パネルで Biotransformations をクリックします。

Biotransformations ダイアログが開きます。

2. 表示されたリストから適切な Set を選択します。

3. Delete をクリックします。
確認メッセージが開きます。

4. Yes をクリックします。

5. OK をクリックします。
Biotransformations ダイアログが閉じます。
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処理メソッドの作成 5
ソフトウェアは、低分子、ペプチド、オリゴヌクレオチド、抗体薬物複合体という 4 つのワークフローを
サポートしています。

目的のサンプルに含まれる代謝物の候補を見つけるには、調査対象のサンプルファイルに固有の
処理パラメータを含むメソッドを作成する必要があります。

メソッドタイプの選択

パラメータ値の選択

一般的な処理パラメータの設定

化合物固有の処理パラメータの設定

処理パラメータ
Molecule Profiler ソフトウェアの処理パラメータには、wiff ファイルを処理するための属性と値がす
べて含まれています。処理機能は、代謝物の探索と特性解析に使用します。処理機能には、代謝
物に対する信頼度スコアの割り当ても含まれています。

以下の処理パラメータテンプレートを使用します。

• 低分子

• ペプチド

• オリゴヌクレオチド

• 抗体薬物複合体

テンプレートは、さまざまな種類の分析で考慮される化合物やワークフローの種類を表しています。

注: 化合物の配列を追加する場合は、配列名が正しくフォーマットされていることを確認してくださ
い。ペプチド配列の命名規則またはオリゴヌクレオチド配列の命名規則を参照してください。

メソッドタイプの選択
1. Workflow パネルで Processing Parameters をクリックします。

Processing Parameters ワークスペースが開きます。

2. New をクリックし、表示されたリストからメソッドのタイプを選択します。
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3. パラメータ値の選択のステップ 2 に進みます。

パラメータ値の選択
1. Workflow パネルで Processing Parameters をクリックします。

Processing Parameters ワークスペースが開きます。

2. Processing Parameters ワークスペースに化合物情報を入力します。

• 低分子ワークフローと抗体薬物複合体ワークフローでは、Structure グループの Open
Structure をクリックし、対象となる mol ファイルを選択した後、構造をインポートします。

• ペプチドワークフローとオリゴヌクレオチドワークフローでは、Sequence グループに適切な
配列を入力します。

ヒント! または、Select From Library をクリックして化合物ライブラリからエントリを選択し、構
造または配列を入力することもできます。ワークフローに一致するエントリのみがリストで利用
できます。ライブラリから化合物を選択するを参照してください。

3. Polarity、Charge state、および Adduct または Ion type がデータセットに適していることを
確認します。

オリゴヌクレオチドは、通常、負極性または負イオンモードで取得されます。質量が 10,000 Da
以下のオリゴヌクレオチドの推奨電荷範囲は、-2 ～ -20 です。10,000　Da　を超えるオリゴヌ
クレオチドの処理は推奨しません。

4. 代謝物の候補を見つける際に使用するピーク検出戦略を選択します。ピーク検出戦略の概要
を参照してください。

5. 処理中の化合物に依存しないパラメータを設定します。一般的な処理パラメータを参照してくだ
さい。

6. 化合物に依存するパラメータを設定します。化合物固有の処理パラメータを参照してください。

7. Save and Close をクリックします。

8. Save Processing Parameters As ダイアログの Folder フィールドで、メソッドの保存場所を選
択します。

9. Name フィールドにメソッドの名前を入力し、OK をクリックします。
メソッドが保存され、Processing Parameters ワークスペースが閉じます。

ライブラリから化合物を選択する

1. Workflow パネルで Processing Parameters をクリックします。
Processing Parameters ワークスペースが開きます。

2. Select From Library をクリックします。
Select From Library ダイアログが開きます。

3. Compound name フィールドのリストから化合物を選択します。

注: 低分子および抗体薬物複合体の処理パラメータでは、化合物ライブラリ内で構造として同
定されたエントリのみがリストに表示されます。ペプチドおよびオリゴヌクレオチドの処理パラメ
ータでは、化合物ライブラリ内で配列として同定されたエントリのみがリストに表示されます。
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4. OK をクリックします。
選択した化合物の情報で、処理パラメータのワークスペースが更新されます。

5. 基準 MS/MS スペクトルを確認または編集するには、Compound-Specific Parameters >
Product Ions and Neutral Losses をクリックします。

注: Reference MS/MS Spectrum ペインには、選択した化合物の MS/MS スペクトルが入力
されます。

6. （オプション）複数の基準スペクトルが利用できる場合は、必要に応じて、リスト内を移動して別
のスペクトルを選択します。

注: 異なる基準スペクトルを選択した場合は、Reference MS/MS Spectrum ペインが更新さ
れ、プロダクトイオンとニュートラルロスの表から情報がクリアされます。

7. フラグメント表を設定するには、Assign Fragments をクリックします。

8. パラメータ値の選択のステップ 5 に進みます。

ピーク検出戦略の概要

ピーク検出戦略とは、対象サンプル中の代謝物候補を見つけるためにソフトウェアが使用するアル
ゴリズムのことです。ユーザーは、Peak Finding Strategy グループで特定のアルゴリズムを選択し
てデータを処理することができます。

アルゴリズム 説明

TOF MS

Predicted metabolites • Small molecule: このアルゴリズムでは、選択した生体内変換セ
ット、予測される開裂代謝物、およびその組み合わせに基づいて
代謝物を探索できます。

• Peptides: このアルゴリズムでは、生体内変換セット、予測される
異性体、およびその組み合わせに基づいて代謝物を探索できま
す。

• Oligonucleotides: このアルゴリズムでは、生体内変換セット、予
測される異性体（加水分解開裂、末端 n+1、内部 n-1 生成物を含
む）、およびその組み合わせに基づいて代謝物を探索できます。

• ADC: このアルゴリズムでは、生体内変換、開裂、抗体フラグメン
ト、およびその 3 つの組み合わせに基づいて代謝物を探索できま
す。

一般的な処理パラメータを参照してください。どのメソッドでも、MS
Parameters タブで選択した Available Adducts は、組み合わせを
使用する際にも含まれます。

注: オリゴヌクレオチドデータの処理には、 Predicted metabolites
オプションを推奨します。
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アルゴリズム 説明

Generic peak finding このアルゴリズムでは、想定外の代謝物を探索できます。Apply
mass defect filter または Apply charge state filter を選択すれ
ば、さらに絞り込むことができます。

このアルゴリズムを制御するパラメータは、Chromatographic Data
と MS Parameters のタブにあります。一般的な処理パラメータを参
照してください。

注: このオプションは、Predicted metabolites オプションと併せて、
オリゴヌクレオチドデータの処理に推奨されます。

Apply mass defect
filter

Compound-Specific Parameters で指定した Mass Defect の範囲
で選択したフィルターを示すピークに探索を限定するフィルターです。
このフィルターを選択すると、一般的なピークファインダーで検出され
た代謝物のうち、指定した条件を満たすものだけが結果に含まれま
す。

Apply charge state
filter

Compound Information グループの Charge state タブに含まれる
電荷を持つピークに探索を限定するフィルターです。このフィルターを
選択すると、一般的なピークファインダーで検出された代謝物のうち、
指定した条件を満たすものだけが結果に含まれます。

注: このオプションは、オリゴヌクレオチドデータの処理には推奨され
ません。

Mass defect このアルゴリズムは、低分子メソッドにのみ適用可能です。

このアルゴリズムでは、分数質量を用いてデータをフィルタリングしま
す。化合物、選択した生体内変換、および開裂される可能性のある
代謝物のすべてが、質量範囲内で特定の代謝物を探索できる利用
可能なフィルターに寄与します。

このアルゴリズムを制御するパラメータは、Mass Defect タブにあり
ます。化合物固有の処理パラメータを参照してください。

Isotope pattern このアルゴリズムでは、親化合物と類似した同位体パターンを持つ代
謝物を探索します。

ヒント! 化合物が放射標識されている場合は、Processing
Parameters ダイアログで Compound-Specific Parameters >
Isotope Pattern を選択して、同位体濃縮度を定義できます。

このアルゴリズムを制御するパラメータは、Isotope Pattern タブにあ
ります。化合物固有の処理パラメータを参照してください。

処理メソッドの作成

Molecule Profiler ソフトウェア
32/136

ソフトウェアユーザーガイド
RUO-IDV-05-12707-JA-A



アルゴリズム 説明

TOF MSMS

注: このアルゴリズムは、パラメータの処理メソッドが基準 MS/MS スペクトルを含んでいる場合に
のみ機能します。基準 MS/MS スペクトルは、化合物ライブラリのエントリから、または Product
Ions and Neutral Losses タブで手動で追加できます。化合物固有の処理パラメータを参照してく
ださい。

Find characteristic
product ions

ソフトウェアはこのアルゴリズムを用いて、親化合物内に特徴的なプ
ロダクトイオンを持つ代謝物を IDA データおよび SWATH 測定デー
タから探索します。

このアルゴリズムでは、特定されたイオンのすべて、または限られた
数のイオンを探索できます。

このアルゴリズムを制御するパラメータは、Product Ions and
Neutral Losses タブにあります。化合物固有の処理パラメータを参
照してください。

All specified ions このオプションを選択すると、特定されたすべてのイオンが探索され
ます。たとえば、4 つのプロダクトイオンを特定し、これらのイオンをす
べて持つピークの探索を行った場合、完全に一致するものだけが代
謝物の候補として特定されます。

At least __ ions このオプションを選択すると、Product Ions and Neutral Losses タブ
で選択したイオンのみが探索されます。たとえば、少なくとも 2 つのイ
オンを持つピークを探索する場合、選択したイオンのうち少なくとも 2
つが代謝物の MS/MS スペクトルに存在しなければ、ピークを代謝物
と見なすことはできません。

Find characteristic
neutral losses

ソフトウェアはこのアルゴリズムを用いて、親化合物にニュートラルロ
スを持つ代謝物を IDA データおよび SWATH 測定データから探索し
ます。このアルゴリズムは、ペプチドやオリゴヌクレオチドのワークフ
ローには適用されません。

このアルゴリズムでは、すべて、または限られた数の損失を探索でき
ます。たとえば、4 つのニュートラルロスを特定し、これらの損失がす
べてあるピークの探索を行った場合、完全に一致するものだけが代
謝物の候補として特定されます。少なくとも 2 つの損失があるピーク
を探索する場合、選択した損失のうち少なくとも 2 つが代謝物の
MS/MS スペクトルに存在しなければ、ピークを代謝物と見なすことは
できません。

このアルゴリズムを制御するパラメータは、Product Ions and
Neutral Losses タブにあります。化合物固有の処理パラメータを参
照してください。

All specified losses このオプションを選択した場合、すべての代謝物が探索され、すべて
のニュートラルロスが報告されます。
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アルゴリズム 説明

At least __ losses このオプションを選択すると、Product Ions and Neutral Losses タブ
で選択した損失のみが探索されます。たとえば、4 つのニュートラル
ロスを特定し、これらの損失がすべてあるピークの探索を行った場
合、完全に一致するものだけが代謝物の候補として特定されます。
少なくとも 2 つの損失があるピークを探索する場合、選択した損失の
うち少なくとも 2 つが代謝物の MS/MS スペクトルに存在しなけれ
ば、ピークを代謝物と見なすことはできません。

Consider internal
neutral losses

このアルゴリズムは SWATH の測定データに特化したものです。

この戦略は、少なくとも 2 つのニュートラルロスを選択している場合に
のみ機能します。内部のニュートラルロスは、2 つのニュートラルロス
式の差分です。なお、"Find by Internal Neutral Loss" を有効にする
には、一方のニュートラルロス式が他方のニュートラルロス式のサブ
セットである必要があります。

Isotope pattern
(SWATH Only)

このアルゴリズムは SWATH の測定データに特化したものです。

Compound-Specific Parameters の Product Ions and Neutral
Losses タブの表で選択したフラグメント同位体パターンと一致するフ
ラグメント同位体パターンを持つプレカーサ―には、代謝物としてのフ
ラグが付きます。ユーザーは、Isotope Pattern 列のフラグメント同
位体式のチェックボックスを 1 つ以上オンにする必要があります。ピ
ークを代謝物とみなすには、MS/MS Parameters タブで指定した
MS/MS m/z 許容値と強度許容度の範囲内で、実験的フラグメント同
位体パターンが理論的フラグメント同位体パターンに一致している必
要があります。

一般的な処理パラメータ

一般的なパラメータは、処理する化合物に依存しない設定です。一般的なパラメータは以下の各タ
ブで管理します。

一般的なパラメータ

低分子 ペプチド オリゴヌクレオチド 抗体薬物複合体

Biotransformations タ
ブ

Biotransformations タ
ブ

Biotransformations タ
ブ

Biotransformations タ
ブ

Chromatographic
Data タブ

Chromatographic
Data タブ

Chromatographic
Data タブ

Chromatographic
Data タブ

MS Parameters タブ MS Parameters タブ MS Parameters タブ MS Parameters タブ

MS/MS Parameters
タブ

MS/MS Parameters
タブ

MS/MS Parameters
タブ

MS/MS Parameters
タブ
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Formula Prediction タ
ブ（低分子メソッドと抗
体薬物複合体メソッド）

Confirmation Scoring
タブ

Confirmation Scoring
タブ

Formula Prediction タ
ブ（低分子メソッドと抗
体薬物複合体メソッド）

Confirmation Scoring
タブ

Confirmation Scoring
タブ

Biotransformations タブ

予想される生体内変換を含む生体内変換セットを同定します。このソフトウェアには、事前に定義さ
れた生体内変換セットが含まれています。カスタム生体内変換セットを作成する場合は、生体内変
換セットの作成を参照してください。

パラメータ 説明

Select Set 処理に使用する別の生体内変換セットをデータベースから選択します。

このオプションを選択すると、次のような警告が表示される場合があります:
"The selected biotransformation set might no longer
exist in the biostransformations database." これは、選択さ

れた生体内変換セットが処理パラメータファイルに保存されているためです。
Biotransformations ワークスペース内の生体内変換に後から変更を加えて
も、処理パラメータファイルには保存されません。

保存した生体組織変換セットを用いて再処理を行うには、Biotransformations
ダイアログで OK をクリックし、Cancel をクリックします。新しい生体内変換セ
ットで処理パラメータファイルを更新するには、次のようにします。

1. OK をクリックします。

2. 生物変換セットを選択します。

メッセージが表示されます: "If you select this new
biotransformation set, you might not be able to
re-select the existing set. Do you want to
continue?

3. OK をクリックします。

Chromatographic Data タブ

パラメータ 説明

Chromatographic Peak
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パラメータ 説明

Retention time
window

代謝物の候補を探索する保持時間の範囲を指定します。保持時間（RT）ウィ
ンドウの大きさは、処理時間に正比例します。

カラムのボイドボリュームを除くため、0.00 分より大きい値を指定します。

to 値は from 値より大きい値にする必要があります。

RT の範囲が広いと処理時間が非常に長くなるため、すべてのワークフローで
RT ウィンドウを設定することをお勧めします。範囲は、分析する実験に大きく
依存します。各実験の RT ウィンドウを調べてください。開始時間は 0.00 分よ
り少し大きい値に、終了時間は目的のピークの少し後、またはメソッドが勾配
（グラジェント）の高溶出段階または洗浄段階に入ったときとすることをお勧め
します。

MS data XIC の幅の設定方法を指定します。
• XIC width: 抽出イオンクロマトグラムのうち、処理の対象として考慮する

幅を指定します。

• Automatic: ソフトウェアは、選択したデータをもとに最適な幅を算出しま
す。

オリゴヌクレオチドワークフローでは、Automatic 設定を推奨します。

注: SWATH 測定データの処理中にこのオプションを選択していた場合は、
XIC width オプションが適用されます。

LC peak
separation

溶出ピークの積分精度を判定します。このパラメータは、テーリングが顕著な
クロマトグラムのピークにも対応します。

溶出ピークが近い場合は、このパラメータを低く設定します。低く設定すると、
ピークを 1 つのピークとしてではなく、別々に考慮することができます。

TOF MS

Minimum peak
width

この値を下回る幅を持つクロマトグラムのピークを除外します。

狭いピークを含める場合は、値を低く設定します。
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パラメータ 説明

Minimum peak
intensity

指定した TOF MS 強度レベルを下回るクロマトグラムのピークを考慮から除
外します。

クロマトグラムのデータにノイズがある場合に使用します。ノイズレベルぎりぎ
りのしきい値を設定することで、ノイズの影響と思われるピークを排除できま
す。

Molecule Profiler ソフトウェアまたは SCIEX OS の Explorer ワークスペース
などのビューアソフトウェアでデータを処理する前に、ピーク幅を調べます。調
べたすべてのピークの一般的な平均を使用して、最小ピーク幅を計算します。

TOF MS または IDA 実験を含むオリゴヌクレオチドメソッドでは、50 cps の設
定を推奨します。

Use smoothing ノイズの中の強度のばらつきをなくし、ピークをノイズから区別します。

クロマトグラムのデータにノイズがある場合に選択します。

オリゴヌクレオチドワークフローでは、このオプションを推奨します。

Sample-control
offset

MS サンプルと対照クロマトグラムをアライメントします。処理中、ソフトウェア
はすべての対照をシフトしてから、サンプルと比較します。

Sample/control
ratio

代謝物とみなすには対照と比較してサンプルのピークが何倍大きい必要があ
るかを指定します。

TOF MS/MS

Minimum peak
intensity

このパラメータは、MS/MS ピーク検出アルゴリズムで SWATH 測定データを
処理するときのみ使用されます。IDA データを処理する場合、このパラメータ
は使用しません。

指定した TOF MS/MS 強度レベルを下回るクロマトグラムのピークを考慮か
ら除外します。

クロマトグラムのデータにノイズがある場合に使用します。ノイズレベルぎりぎ
りのしきい値を設定することで、ノイズの影響と思われるピークを排除できま
す。

Analog data

Wavelength (UV
only)

代謝物の候補を確認する際に使用する波長を選択します。

Time offset
from MS

MS とアナログのクロマトグラムデータをアライメントします。処理中、ソフトウェ
アはアナログデータをシフトしてから MS データと比較します。

注: また、MS とアナログのクロマトグラムデータは、後処理として Analog
Interpretation ワークスペースでアライメントできます。R.T. Offset の変更を参
照してください。
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パラメータ 説明

LC peak
separation

溶出ピークの積分精度を判定します。このパラメータは、テーリングが顕著な
クロマトグラムのピークにも対応します。

溶出ピークが近い場合は、このパラメータを低く設定します。低く設定すると、
ピークを 1 つのピークとしてではなく、別々に考慮することができます。

Minimum peak
width

この値を下回る幅を持つクロマトグラムのピークを除外します。

狭いピークを含める場合は、値を低く設定します。

Minimum peak
intensity

指定した強度レベルを下回るクロマトグラムのピークを考慮から除外します。

クロマトグラムのデータにノイズがある場合に使用します。ノイズレベルぎりぎ
りのしきい値を設定することで、ノイズの影響と思われるピークを排除できま
す。

Use smoothing ノイズの中の強度のばらつきをなくし、ピークをノイズから区別します。

クロマトグラムのデータにノイズがある場合に選択します。

Sample-control
offset

MS サンプルと対照クロマトグラムをアライメントします。処理中、ソフトウェア
はすべての対照をシフトしてから、サンプルと比較します。

MS Parameters タブ

パラメータ 説明

m/z Tolerance

MS m/z
tolerance

MS　スペクトルのピークを判定する範囲を指定します。この範囲内の質量は
すべて、1 つの一意なピークとみなされます。実験式が割り当てられたピーク
を代謝物の候補とみなすには、そのピークの質量精度が指定した許容範囲内
である必要があります。

このパラメータは、機器のキャリブレーション状態に大きく依存します。3 ppm
以内にキャリブレーションされた機器の場合、TOF MS または IDA 実験を含
むオリゴヌクレオチドメソッドでは 10 ppm の値を推奨します。

Minimum MS
peak intensity

MS ピーク強度の最小スペクトルしきい値を指定します。指定したスペクトルし
きい値を下回る強度の MS ピークを考慮から除外します。

スペクトルに含まれるノイズのレベルに応じて値を設定します。

Isotope Pattern Tolerances

MS m/z
tolerance

代謝物の同位体パターンに適用する許容範囲を指定します。同位体 m/z の
オフセット値がこの許容範囲内にあるピークのみが一致とみなされます。

TOF MS または IDA 実験を含むオリゴヌクレオチドメソッドでは、10 mDa の
値を推奨します。
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パラメータ 説明

Intensity
tolerance

Compound-Specific Parameters の Isotope Pattern タブで定義された同位
体強度の相対許容範囲を指定します。一致と見なされるには、2 つのピーク
の強度比が、この許容値内で予測比と等しくなければなりません。

TOF MS 実験を含むオリゴヌクレオチドメソッドでは、20% の値を推奨しま
す。

Minimum Score （オリゴヌクレオチドメソッド）代謝物の同位体パターンを予測同位体パターン
と比較して、観測同位体パターンの最小一致許容値（％）を指定します。確認
済みの偽陽性の検出を除去するために、まずは 0% から始め、必要に応じて
値を増やすことをお勧めします。

Limits

Maximum
number of
unexpected
metabolites

代謝物の候補として同定できる想定外のピークの最大数を選択します。

この設定は、一般的なピークファインダーで識別可能なピークの最大数に影
響します。一般的なピークファインダーは、予測代謝物ピークファインダーと交
信します。たとえば、複雑なサンプルに対してより小さい生体内変換セットを選
択した場合、想定外の代謝物の最大数が多くなるため、この設定を大きくする
必要があります。通常、プロセス不純物のオリゴヌクレオチドサンプルには、
100 の設定が推奨されます。より複雑なサンプルでは、この数を増やす必要
があります。

Mass range
window (m/z)

代謝物の候補を見つけるための質量範囲を制限します。

Generic LC/MS Peak Finding

Perform
background
subtraction

背景減算を行うかどうかを指定します。LC/MS　クロマトグラムのバックグラウ
ンドレベルが高い場合は、このオプションを選択してバックグラウンドイオンを
除去します。

TOF MS および TOF MS/MS 実験を含むオリゴヌクレオチドメソッドでは、こ
のオプションは推奨されません。

Available Adducts（低分子メソッド）

Compound Information グループで定義された電荷範囲に基づいてサポートされているすべての
付加体のリストです。

Use 付加体を探索対象に含めるか否かを示します。

__ adduct(s)
selected

（読み取り専用）Available Adducts 表の Use 列で選択した付加体の数を示
します。

Advanced Ion Types（抗体薬物複合体メソッド、ペプチドメソッド、オリゴヌクレオチドメソッド）

Use イオンを探索対象に含めるか否かを示します。
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パラメータ 説明

__ adduct(s)
selected

（読み取り専用）Advanced Ion Types 表の Use 列で選択したイオンの数を
示します。

MS/MS Parameters タブ

パラメータ 説明

MS/MS Finding

MS/MS m/z
tolerance

MS/MS　スペクトルのピークを判定する範囲を指定します。MS/MS m/z 許容
値は、対応する前駆体のピークを代謝物の候補と見なされるために、MS/MS
スペクトルで見つかったフラグメントピークが Compound-Specific
Parameters の Product Ions and Neutral Losses タブで選択したフラグメン
トまたはニュートラルロスの値と一致していると判定されるための許容範囲を
指します。

TOF MS/MS または IDA 実験を含むオリゴヌクレオチドメソッドでは、10 mDa
の値を推奨します。

Minimum
MS/MS peak
intensity

指定したスペクトルしきい値を下回る強度の MS/MS ピークを考慮から除外し
ます。

スペクトルに含まれるノイズのレベルに応じて値を設定します。

MS/MS Isotope Finding

MS/MS m/z
tolerance

MS/MS　スペクトルのピークを判定する範囲を指定します。MS/MS　スペクト
ルのピークが一致したと見なされるには、2　つの同位体ピークの質量差がこ
の許容範囲内で予測される差に等しい必要があります。

MS/MS m/z 許容値は、同位体パターン（SWATH のみ）ピーク検出戦略を選
択した状態で SWATH 測定データを処理する際に使用されます。

TOF MS/MS または IDA 実験を含むオリゴヌクレオチドメソッドでは、10 mDa
の値を推奨します。
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パラメータ 説明

Intensity
tolerance

Compound-Specific Parameters の Product Ions and Neutral Losses タブ
の選択した IP セルで定義されている、選択したフラグメント式の同位体強度
に関する相対許容範囲を指定します。一致と見なされるには、2 つのピークの
強度比が、この許容値内で予測比と等しくなければなりません。このパラメー
タは、パターンの一部と見なされる最小の同位体を定義するものでもありま
す。たとえば、強度の許容範囲が　10％　であれば、質量パターンに寄与でき
る最小の同位体は、100％ 定義されたピークの 10％ 以上である必要があり
ます。

Intensity tolerance は、同位体パターン（SWATH のみ）ピーク検出戦略を
選択した状態で SWATH 測定データを処理する際に使用されます。

TOF MS/MS または IDA 実験を含むオリゴヌクレオチドメソッドでは、20% の
値を推奨します。

Source of Reference MS/MS Spectrum

Control 対象となる化合物の基準スペクトルを選択します。スペクトルはさまざまな場
所から選択できます。

選択した基準スペクトルがデフォルトで選択されます。

構造または配列の自動生成機能を使用する場合は、Selected reference
spectrum オプションの選択をお勧めします。

Sample

Selected
reference
spectrum

MS/MS Spectrum

Use advanced
MS/MS filter

このフィルターは、SWATH 測定データ専用です。このフィルターで使用される
アルゴリズムには、SWATH 測定データの MS/MS スペクトルから特定の前
駆体にフラグメントを割り当てるために使用される PCVG があります。スライ
ダー（Comprehensive または Confident）の位置に応じて、前駆体に確実
に割り当てられるフラグメントのみが MS/MS スペクトルに表示されます。

Similarity and Fragment Interpretation

MS/MS m/z
tolerance

基準 MS/MS スペクトルと代謝物の MS/MS スペクトルを比較するための質
量精度の許容値を選択します。このパラメータは、Interpretation 表でフラグメ
ントを割り当てる際にも使用されます。割り当てるフラグメントの質量精度は、
指定した MS/MS m/z 許容値内である必要があります。

TOF MS/MS または IDA 実験を含むオリゴヌクレオチドメソッドでは、10 ppm
の値を推奨します。

Minimum
signal-to-noise
ratio

基準 MS/MS スペクトルと代謝物の MS/MS スペクトルを比較するために、最
小の S/N 比（シグナルと不要なノイズの比率）を選択します。このパラメータ
は、Interpretation 表でフラグメントを割り当てる際にも使用されます。割り当
てるフラグメントの S/N 比は、規定された S/N 比の最小値を上回っている必
要があります。

Fragment Interpretation Options（低分子メソッドとペプチドメソッド）

処理メソッドの作成
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パラメータ 説明

Number of
fragment peaks
selected for
assignment

（低分子メソッド）割り当てのために選択される MS/MS フラグメントの数を指
定します。ピークはその強度に基づいて選択されます（強度の高いピークが最
初に選択されます）。

Break aromatic
rings

（低分子メソッド）芳香環の一部を構成する結合を切断します。

Maximum
number of
bonds to break

（低分子メソッド）MS/MS フラグメントを解釈のために割り当てる際に、切断す
る結合の最大数を指定します。

Maximum
number of C-C
bonds to break

（低分子メソッド）MS/MS フラグメントを解釈のために割り当てる際に、切断す
る C-C 結合の最大数を指定します。

Fragment
Types

（ペプチドメソッド）フラグメントの種類を同定します。複数の種類を選択できま
す。

Maximum
bonds to break

（ペプチドメソッド）切断する結合の最大数を指定します。

Break linkages （ペプチドメソッド）ペプチドまたはオリゴヌクレオチド配列の結合を切断しま
す。

Formula Prediction タブ（低分子メソッドと抗体薬物複合体メソッド）

パラメータ 説明

Search Constraints

Elements from

Elements to

代謝物の候補となる式を提案するためにソフトウェアが使用する開始要素を
指定します。

Isotope Pattern Tolerances

MS m/z
tolerance

提案された処方の理論的な予測同位体パターンをソフトウェアが同定した後、
このパラメータは、代謝物の同位体パターンと比較したときの同位体間の許
容質量差を制限します。

Intensity
tolerance

提案された処方の理論的な予測同位体パターンをソフトウェアが同定した後、
この値は、代謝物の同位体パターンと比較したときの同位体ピーク強度の許
容差を制限します。

Ranking

Contribution MS　スペクトルに基づく式と　MS/MS　スペクトルに基づく式のどちらを結果
に表示するかを指定します。

Automatically
weight MS/MS

MS/MS の重み付けに対数目盛を適用する場合に選択します。
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パラメータ 説明

Rings and Double Bonds

RDB from

RDB to

代謝物候補の提案式に含まれる環や二重結合の範囲を同定します。

提案式の環や二重結合の数が指定された範囲に入らない場合、その式は代
謝物の対象とはなりません。

最小値は最大値より小さくする必要があります。

Element Ratios

Oxygen/
phosphorus
count

提案式に存在しなければならない酸素とリンの分子の範囲を指定します。

このパラメータは、MS と MS/MS の両方の数式に適用されます。

Oxygen/sulphur
count

提案式に存在しなければならない酸素と硫黄の分子の範囲を指定します。

このパラメータは、MS と MS/MS の両方の数式に適用されます。

Confirmation Scoring タブ

目的のサンプルに代謝物の候補が見つかった場合、ソフトウェアは見つかったピークが代謝物であ
る可能性を示す確認スコアを割り当てます。このスコアは、代謝物を見つけるためのアルゴリズム
に依存せず、さまざまなプロパティに基づいて決定されます。

注: オリゴヌクレオチドメソッドでは、Isotope pattern は 100、その他のパラメータは 0 を推奨しま
す。

パラメータ 説明

Mass defect （低分子メソッド）代謝物の質量不一致・誤差が、親化合物、開裂代謝物の候
補、または第 II 相代謝物の質量不一致・誤差にどれだけ近いかを示します。

注: この属性は、抗体薬物複合体、ペプチド、オリゴヌクレオチドデータの合計
確認スコアの計算には使用されません。

Isotope pattern （低分子メソッドと抗体薬物複合体メソッド）代謝物が親化合物と類似の同位
体パターンを持つか否かを示します。このプロパティは 0 から 100 のスコアで
評価されます。

（オリゴヌクレオチドメソッド）代謝物が予想される同位体パターンと類似した同
位体パターンを持つかどうかを示します。このパラメータは、偽陽性のフィルタ
リングに非常に有用です。値は 100 を推奨します。
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パラメータ 説明

MS/MS MS/MS スペクトルが基準スペクトルにどれだけ近いかを示します。このプロ
パティは、基準スペクトルが利用可能な場合にのみ適用されます。

MS/MS スコアには次の 2 つの要素があります。

• 品質: スペクトルピークをバックグラウンドノイズから識別する能力を示す
指標。

• 類似性: ソフトウェアは、既知の生体内変換に基づいてシフトしたプロダクト
イオンを含め、MS/MS スペクトルが基準スペクトルにどれだけ近いかを計
算します。

注: TOF MS データのみを処理する場合は、このパラメータを 0 に設定しま

す。

Mass accuracy 検出された m/z 値が予想される m/z 値にどの程度近いかを示します。このプ
ロパティは、予測される代謝物のみに適用されます。

Total
confirmation
score

（読み取り専用）4 つのプロパティ値の合計。

ヒント! Scoring 表に 0 を入力すると、スコアリング時に特定のプロパティを無視できます。

化合物固有の処理パラメータ

化合物固有の処理パラメータは、処理する化合物に依存する設定です。化合物固有のパラメータ
は以下の各タブで管理します。

化合物固有のパラメータ

低分子 ペプチド オリゴヌクレオチド 抗体薬物複合体

Cleavage Metabolites
タブ（低分子メソッドと
抗体薬物複合体メソッ

ド）

Catabolites タブ（ペプ
チドメソッド）

Catabolites タブ（オリ
ゴヌクレオチドメソッド）

Cleavage Metabolites
タブ（低分子メソッドと
抗体薬物複合体メソッ

ド）

Mass Defect タブ（低
分子メソッド）

Isotope Pattern タブ Isotope Pattern タブ Isotope Pattern タブ

Isotope Pattern タブ Product Ions and
Neutral Losses タブ

Product Ions and
Neutral Losses タブ

Product Ions and
Neutral Losses タブ

Product Ions and
Neutral Losses タブ

抗体の詳細
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Cleavage Metabolites タブ（低分子メソッドと抗体薬物複合体メソッド）

親化合物の開裂代謝物候補を同定します。このメソッドは、ソフトウェアが開裂代謝物候補のリスト
を生成する前に、構造を含んでいる必要があります。

パラメータ 説明

Potential Compound Cleavages

Maximum
bonds to break

切断する結合の最大数を指定します。

Break ring
bonds

環の一部を構成する結合を切断します。

Only break C-N
bonds

C-N 結合のみを切断します。

Cleavages
selected

化合物開裂の候補表で選択した開裂の数を示します。ソフトウェアによって自
動的に生成されます。

Catabolites タブ（ペプチドメソッド）

親化合物の加水分解開裂候補を同定します。このメソッドは、ソフトウェアが加水分解性異性体の
候補リストを生成する前に、ペプチド配列を含んでいる必要があります。

パラメータ 説明

Potential Hydrolytic Cleavages

Max. peptide
bonds to break

切断するペプチド結合の最大数を指定します。

Max. cross-
links to break

切断する架橋の最大数を指定します。

Min. AA count 異化産物のアミノ酸の最小数を指定します。

Catabolites
selected

（読み取り専用）加水分解開裂の候補表で選択した異性体の数を示します。

Catabolites タブ（オリゴヌクレオチドメソッド）

親化合物の加水分解開裂候補を同定します。このメソッドは、ソフトウェアが加水分解性異性体の
候補リストを生成する前に、ペプチド配列を含んでいる必要があります。

パラメータ 説明

Potential Hydrolytic Cleavages

Max. bonds to
break

オリゴヌクレオチド骨格に沿ってのみ切断可能な結合の最大数を指定します
（H2PO3 の損失を含む）。核酸塩基と糖の損失については、
Biotransformations タブを参照してください。
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パラメータ 説明

Min.
Nucleotides

異性体および加水分解開裂の候補を生成するために使用する最小のヌクレ
オチド数を指定します。

Include
terminus n+1
sequences

末端 n+1 個の不純物を探索するかどうかを指定します。

Include internal
n-1 sequences

内部の n-1 個の不純物を探索するかどうかを指定します。

Catabolites
selected

（読み取り専用）加水分解開裂の候補表で選択した異性体の数を示します。

Mass Defect タブ（低分子メソッド）

複雑な生体試料を分析する場合は、このフィルターを使用することでバックグラウンドの干渉を除去
できます。

パラメータ 説明

Mass Defect Filters

Filters selected 質量不一致・誤差フィルター表で選択した質量不一致・誤差フィルタ
ーの数を示します。ソフトウェアによって自動的に生成されます。

Filters

Parent デフォルトで選択されています。

Glucuronidation デフォルトで選択されています。

Bis-Glucuronidation デフォルトで選択されています。

Glutathione デフォルトで選択されています。

Sulphate デフォルトで選択されています。

Isotope Pattern タブ

パラメータ 説明

Isotope Pattern Isotopes 表に記載されている情報をグラフで表示します。

（オリゴヌクレオチドメソッド）オリゴヌクレオチドの指定電荷状態における同位
体分布のグラフを表示します。電荷状態を変更するには、Compound
Information で別の Ion type を選択します。
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パラメータ 説明

Isotopic
Enrichment

親化合物の式に使用される原子の同位体濃縮度を指定します。

注: 抗体薬物複合体や低分子メソッドに同位体元素を追加するには、同位体
を含む mol ファイルをインポートします。

注: 原子が濃縮されたペプチドやオリゴヌクレオチド式の同位体濃縮度を変更
するには、ペプチドおよびオリゴヌクレオチド式の同位体濃縮度を編集するを
参照してください。

Isotopes 親化合物の式と同位体濃縮度（該当する場合）に基づいて、最大強度の同位
体を表示します。

Isotope Pattern
Intensity Cufoff
for Metabolite
XICs (%)

（オリゴヌクレオチドメソッド）XIC 抽出の対象となる個々の同位体に対して、ピ
ーク領域計算時に適用されるカットオフ値をパーセント強度で指定します。強
度がカットオフ値を下回る同位体は、表中、赤色で表示されます。

Product Ions and Neutral Losses タブ

パラメータ 説明

Reference
MS/MS
Spectrum

代謝物候補の MS/MS と照合するプロダクトイオンとニュートラルロスを選択
する際に使用するスペクトルを特定します。対象サンプルと同様の条件で取
得したサンプルのデータファイルが最適です。

スペクトルは次の 2 箇所のいずれかから選択できます。

• wiff ファイル

• 化合物ライブラリ

Filters

m/z From __ to
__

プロダクトイオンとニュートラルロスの表に入力する際に考慮する質量範囲を
定義します。選択した範囲内のフラグメントのみが、プロダクトイオンとニュート
ラルロスの表に表示されます。

Charge state
From __ to __

プロダクトイオンとニュートラルロスの表に入力する際に考慮する電荷状態の
範囲を定義します。選択した範囲内の電荷を持つフラグメントのみが、プロダ
クトイオンとニュートラルロスの表に表示されます。

Only show
product ions
above (%)

プロダクトイオンとニュートラルロスの表に含めるプロダクトイオンの最小しき
い値を定義します。指定した強度を下回るプロダクトイオンを考慮から除外し
ます。

Mass accuracy
within (mDa)

プロダクトイオンとニュートラルロスの表には、質量精度が指定値内にあるフ
ラグメントのみが表示されます。
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パラメータ 説明

Add product
ions, neutral
losses from
Phase II
metabolites

（低分子メソッドと抗体薬物複合体メソッド）第 II 相代謝物からのプロダクトイ
オンとニュートラルロスをプロダクトイオンとニュートラルロスの表に含めます。

注: フィルターに必要な変更をすべて行った後、Assign Fragments をクリックして、プロダクトイオ
ンとニュートラルロスの表を更新します。

抗体の詳細

注: これらの化合物固有のパラメータは、抗体薬物複合体メソッドのみに適用されます。

パラメータ 説明

Protein
Sequence

抗体のタンパク質配列。

Enzyme タンパク質の消化に使用する酵素。

Break disulfide
bonds

このチェックボックスをオンにすると、ジスルフィド結合が切断されます。

Site of
conjugation

薬物分子が結合できる抗体中のアミノ酸。

Type of
conjugation

薬物分子と抗体との結合に関わる化学反応。

Max. AA count 消化後、フラグメントの候補とみなされるアミノ酸の最大数。

Selected
fragments

ソフトウェアによって自動的に生成されます。表で選択されているフラグメント
の数を示します。

ペプチドおよびオリゴヌクレオチド式の同位体濃縮度を
編集する

前提条件

カスタムアミノ酸（修飾の有無は問わない）を作成する必要があります。カスタムアミノ酸の作成お
よびカスタムアミノ酸修飾の作成を参照してください。カスタムアミノ酸またはカスタムアミノ酸修飾
は、少なくとも 1 つの濃縮同位体を含んでいる必要があります。

1. Workflow パネルで Processing Parameters. をクリックします。
Processing Parameters ワークスペースが開きます。

2. New > Peptides または New > Oligonucleotide をクリックします。
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注: または、化合物ライブラリからエントリを選択し、配列を埋めます。

3. カスタムアミノ酸またはオリゴヌクレオチドの Compound name をフィールドに入力します。

4. カスタムアミノ酸またはオリゴヌクレオチドの Sequence 情報を入力します。配列は少なくとも
1 つの濃縮同位体を含んでいる必要があります。

5. Chemical formula フィールドをクリックします。

Chemical formula フィールドと m/z 値には、カスタムアミノ酸に関連する情報が入力されま
す。

ヒント! 配列の上に  アイコンが表示されます。アイコンにカーソルを合わせると、使用してい
るカスタムアミノ酸の Symbol と Residue Formula が表示されます。

6. Compound-Specific Parameters > Isotope Pattern をクリックします。
Isotopic Enrichment 表では、Element 列にカスタムアミノ酸の残基式、Enrichment % 列に
100 が表示されます。

7. 必要に応じて Enrichment % 値を変更します。

8. Save and Close をクリックします。

処理メソッドの作成

ソフトウェアユーザーガイド
RUO-IDV-05-12707-JA-A

Molecule Profiler ソフトウェア
49/136



分子候補の探索 6
Batch ワークスペースは、複数のサンプルファイルを同時に処理するために使用します。バッチ表
は、手動で入力することも、既存のバッチをインポートして表に入力することもできます。

1. 手動でバッチを調製するには、バッチの作成に進みます。

2. 既存のバッチを開くには、バッチを開くに進みます。

3. 既存のバッチをインポートするには、バッチのインポートに進みます。

Batch ワークスペースの概要
Batch ワークスペースは、処理するサンプルのバッチを作成するために使用します。

図 6-1 : Batch ワークスペース
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項目 説明

1 メニューバー。以下のボタンがあります。
• Options: Batch Processing Options ダイアログを開き、バッチに関連す

るオプションを指定することができます。バッチ処理オプションを参照してく
ださい。

• New: クリックすると、バッチを保存できます。Sample/Controls フィールド
にサンプルを追加した後にのみ利用可能です。

• Open: Open Processing Batch ダイアログを開き、既存のバッチを選択し
て開くことができます。バッチを開くを参照してください。

• Import: Batch Importer ダイアログを開き、インポートする Excel ファイル
を選択することができます。バッチのインポートを参照してください。

• Save: 現在開いているバッチファイルを保存します。自動的に既存のバー
ジョンを置き換えます。バッチ情報を変更した後にのみ利用可能です。

• Save As: 現在開いているバッチファイルを保存します。バッチファイルに
は新しい名前を割り当てることができます。

2 Find Metabolites ボタン。バッチの処理を開始します。

3 Sample/Controls 列。Sample ボタンを押すと Select Data ダイアログが開
き、目的のサンプルを選択できます。Controls ボタンを押すと Select Data
ダイアログが開き、対応する対照サンプルを選択できます。1 サンプルにつき
最大 5 つの対照サンプルが選択可能です。

4 Folder 列。処理パラメータや処理結果を保存するフォルダーの場所のリスト
を示します。

5 Processing Parameters 列。目的のサンプルを処理するために使用できる
処理パラメータのリストを示します。選択した Folder に保存されている処理
パラメータのみ選択可能です。

6 Apply Options 列。デフォルトで選択されています。選択すると、Batch
Processing Options ダイアログで選択した Auto Assign と Report オプショ
ンのすべてが、バッチ内のサンプルと対照サンプルに適用されます。オプショ
ンは次のとおりです。

• Apply Options チェックボックスをオフにすると、選択したすべてのチェッ
クボックスがオフになります。

• 特定のサンプルのチェックボックスをオフにします。

• 特定のサンプルのチェックボックスをオンにします。

バッチ処理オプションを参照してください。

注: Auto Assign のオプションは、オリゴヌクレオチドワークフローには適用さ
れません。

7 Results File 列。Results ファイルのユーザー指定名。
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バッチオプションを指定する
バッチ処理オプションを参照してください。

1. Workspace パネルで Batch をクリックします。
Batch ワークスペースが開きます。

2. Options をクリックします。
Batch Processing Options ダイアログが開きます。

3. （低分子、ペプチド、抗体薬物複合体のワークフロー）Auto Assign タブで次の手順を実行しま
す。

• 該当するオプションのチェックボックスをオンにします。

• 選択した各オプションに適切な値を入力します。

4. Report タブで次の手順を実行します。

• 該当するオプションのチェックボックスをオンにします。

• 選択した各オプションに適切な値を入力します。

5. OK をクリックします。
バッチオプションはバッチと一緒に保存されます。

バッチ処理オプション

オプション 説明

Auto Assign

注: 自動割り当てオプションは、互いに独立しています。これらは OR 条件とみなされます。選択し
たオプションのうち 1 つ以上が、指定した条件を満たしている必要があります。

注: 自動割り当てオプションは、オリゴヌクレオチドサンプルには適用されません。

Assign Structures or
Sequences

選択したオプションの条件を満たす代謝物の構造または配列の候
補を提案します。使用するデータの種類および処理パラメータに依
存します（すなわち、低分子かペプチドか）。

注: 複数のオプションを選択できます。

Metabolites with peak
areas above (%)

XIC ピーク領域が指定値を上回る代謝物について、構造または配
列の候補を提案します。

Metabolites with analog
peak areas above (%)

アナログピーク領域が指定値を上回る代謝物について、構造または
配列の候補を提案します。

Metabolites with MS/MS
quality above

MS/MS 品質が指定値を超える代謝物について、構造または配列
の候補を提案します。

このオプションは、オリゴヌクレオチドワークフローには適用されませ
ん。
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オプション 説明

Report

注: レポートオプションは互いに依存しています。これらは AND 条件とみなされます。選択したオ
プションのすべてが、指定した条件を満たしている必要があります。

Report metabolites with
assigned structures or
sequences

Potential Metabolites 表の Report 列で、構造または配列が割り
当てられている代謝物にチェックマークを表示します。

Report metabolites with
peak areas above (%)

Potential Metabolites 表の Report 列で、構造または配列が割り
当てられている代謝物にチェックマークを表示します。

Report metabolites with
analog peak areas
above (%)

Potential Metabolites 表の Report 列で、指定値を上回るアナロ
グピーク領域を持つ代謝物にチェックマークを表示します。

Report metabolites with
scores above (%)

Potential Metabolites 表の Report 列で、指定値を上回るスコアを
持つ代謝物にチェックマークを表示します。

バッチの作成

注: 各行 1 サンプルずつのみ処理可能で、各サンプルにつき最大 5 つの対照サンプルが選択可
能です。ただし、処理に対照サンプルは不要です。

1. Workspace パネルで Batch をクリックします。
Batch ワークスペースが開きます。

ヒント! Open オプションを選択すると、以前に保存したバッチファイルを取り出すことができま
す。バッチを開くを参照してください。

2. 次のようにして MS サンプルを追加します。

a. バッチ表の最初の利用可能な行で、Sample をクリックします。
Select Data ダイアログが開きます。

b. Browse をクリックし、適切なソースフォルダーに移動します。

c. Available フィールドで wiff ファイルと、目的のサンプルを含む注入を選択した後、>> を
クリックします。
Selected フィールドにサンプル情報が表示されます。

3. （オプション）次のようにして、アナログサンプルを追加します。

ヒント! アナログデータを取得した場合、Use analog data チェックボックスをオンにすると、MS
サンプルの追加時にアナログデータが自動的に追加されます。

a. バッチ表の最初の利用可能な行で、Use analog data をクリックします。

b. Analog Sample タブを開きます。
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c. Browse をクリックし、適切なソースフォルダーに移動します。

d. Available フィールドでアナログサンプルを選択した後、>> をクリックします。
Selected フィールドにサンプル情報が表示されます。

4. OK をクリックします。
バッチ表の選択した行の Sample/Controls フィールドにサンプル情報が入力されます。

5. （オプション）次のようにして MS 対照を追加します。

a. バッチ表の最初の利用可能な行で、Control をクリックします。
Select Data ダイアログが開きます。

b. Browse をクリックし、適切なソースフォルダーに移動します。

c. Available フィールドで wiff ファイルと、対照を含む 注入を選択した後、>> をクリックしま
す。
Selected フィールドにサンプル情報が表示されます。

d. 次のステップに進んでアナログ対照を追加するか、OK をクリックしてこのダイアログを閉
じます。

6. （オプション）次のようにしてアナログ対照を追加します。

a. バッチ表の最初の利用可能な行で、Use analog data をクリックします。

b. Analog Sample タブを開きます。

c. Browse をクリックし、適切なソースフォルダーに移動します。

d. Available フィールドでアナログサンプルを選択した後、>> をクリックします。
Selected フィールドにサンプル情報が表示されます。

e. OK をクリックします。
バッチ表の選択した行の Sample/Controls フィールドにサンプル情報が入力されます。

7. Folder 列で、処理パラメータと Results ファイルを保存するフォルダーを選択します。

8. Processing Parameters 列で、処理パラメータファイルを選択します。

ヒント! 処理パラメータファイルを表示するには、P をクリックします。必要に応じてパラメータを
変更し、Save and Close をクリックして保存します。

9. Results File 列には、結果を保存するファイル名を入力します。

10. バッチ内の各行に対して、ステップ 2 からステップ 9 を繰り返します。

注: 1 バッチで処理できる最大行数は 200 です。

ヒント! バッチを簡単に作成するために、行のコピー & ペーストや削除が可能になっています。
バッチ行のコピー & ペーストまたはバッチ行のクリアを参照してください。

バッチ行のコピー & ペースト

バッチを編集するには、コピー & ペーストのオプションを使用します。

1. バッチ表で、コピーする行を選択します。
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2. 右クリックして、次に Copy Batch Row を選択します。

3. 貼り付け先の行を選択します。

4. 右クリックして、次に Paste Batch Row を選択します。

注: 貼り付け先の行にある既存の情報はすべて上書きされます。

バッチ行のクリア

バッチ作成時に、サンプル情報の行をクリアできます。

1. バッチ表で、クリアする行を選択します。

2. 右クリックして、次に Clear Batch Row を選択します。
選択した行のデータがすべて削除されます。

バッチを開く
1. Workspace パネルで Batch をクリックします。

Batch ワークスペースが開きます。

2. Open をクリックします。
Open Processing Batch ダイアログが開きます。

3. バッチファイルを選択し、OK をクリックします。

4. 次のいずれかの操作を行います。

• バッチが完成している場合は、バッチの送信に進みます。

• バッチが未完成の場合は、バッチの作成に進みます。

バッチのインポート
1. Workspace パネルで Batch をクリックします。

2. Import をクリックします。
Batch Importer ダイアログが開きます。

3. Browse をクリックします。
Open excel file ダイアログが開きます。

4. 適切な Excel ファイルに移動し、選択します。

注: Excel ファイルは、ソフトウェアに付属のテンプレート（BatchImportTemplate.xlsx）を用い
て作成してください。インストール時、テンプレートは
C:\ProgramData\SCIEX\Molecule Profiler\Batch Import Templates にイ

ンストールされます。

5. Open をクリックします。
Target batch file フィールドには、インポートした Excel ファイルの名前が入力されます。この
情報は、必要に応じて変更できます。

6. 次のいずれかの操作を行います。
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• 選択した Excel ファイルを Molecule Profiler ソフトウェアのバッチに変換し、Batch ワーク
スペースでバッチを開くには、Convert and Open をクリックし、ステップ 7 に進みます。

• 選択した Excel ファイルを Molecule Profiler ソフトウェアのバッチに変換し、後で Batch ワ
ークスペースで開くことができるようにするには、Convert をクリックしてステップ 7 に進み
ます。

• インポートをキャンセルする場合は、Close をクリックします。

7. 次のいずれかの操作を行います。

• Convert and Open オプションを選択し、Excel ファイルで参照されている処理パラメータ
（メソッドファイル）およびフォルダーがすべて正しい場所に格納されている場合は、バッチの
送信に進みます。

• Convert オプションを選択し、Excel ファイルで参照されている処理パラメータ（メソッドファ
イル）およびフォルダーがすべて正しい場所に格納されている場合は、バッチの保存に進み
ます。

• Convert and Open オプションまたは Convert オプションが選択され、確認ダイアログが
表示された場合は、手順 8 に進みます。

図 6-2 : 確認ダイアログ

8. 次のいずれかの操作を行います。

• （低分子ワークフロー）必要なメソッドファイルを自動的に作成する場合は、ステップ 9 に進
みます。

注: Method Generator は、ペプチド、オリゴヌクレオチド、抗体薬物複合体のワークフロー
では使用できません。

• 必要なメソッドファイルを手動で作成する場合は、No をクリックしてからインポートをキャン
セルします。処理メソッドの作成に進みます。

9. Yes をクリックします。
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図 6-3 : Method Generator ダイアログ

10. Source data folder リストから適切なフォルダーを選択します。

11. Parameters to copy リストから適切なメソッドファイルを選択します。

12. Compound structure folder フィールドの右側にあるフォルダーアイコンをクリックし、処理
パラメータの前駆体構造を含むフォルダーに移動して選択します。

13. 次のいずれかの操作を行います。

• サンプル wiff ファイルに基準 MS/MS が含まれている場合は Sample をクリックします。

• 対照 wiff ファイルに基準 MS/MS が含まれている場合は Control をクリックします。

14. Create をクリックします。
処理パラメータと不足しているフォルダーが作成され、Excel スプレッドシートで指定した場所に
格納されます。

15. 次のいずれかの操作を行います。

• Convert and Open オプションを選択した場合は、バッチの送信に進みます。

• Convert オプションを選択した場合は、バッチの保存に進みます。

バッチの保存
バッチワークスペースの表に追加された情報は、後で使用するために保存できます。

1. バッチを同じファイル名で保存する場合は、Save をクリックします。

2. バッチを別の名前で作成する場合は、Save As をクリックします。
Save Processing Batch As ダイアログが開きます。

3. 一意の Name を入力し、OK をクリックします。

バッチの送信
バッチを調製し、バッチオプションを指定した後、バッチをデータ処理のために送信します。
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注: 必要に応じて、バッチを送信する前に、対象サンプルの処理パラメータを変更することができま
す。

1. （オプション）サンプルの処理パラメータを表示するには、次のようにします。

a. 対象のサンプルを含む行を選択し、Processing Parameters フィールドの右側にある P
をクリックします。
選択したサンプルに関連する処理パラメータが表示されます。

b. 必要な変更を加えた後、Save and Close をクリックします。
Batch ワークスペースが表示されます。

2. Save As をクリックします。
Save Processing Batch As ダイアログが開きます。

3. 一意の Name を入力し、OK をクリックします。

4. Find Metabolites をクリックします。
バッチ処理が開始します。処理の状況が進行状況バーに表示されます。処理中は P が無効に
なり、パラメータの改変を防止します。行の処理が完了すると、Processing Parameters フィ
ールドの右側にある P と Results File フィールドの右側にある R が利用可能になります。

5. R をクリックすると、Results ワークスペースに Results ファイルが開きます。

注: Batch Processing Options ダイアログで選択した Auto Assign オプションと Report オプ
ションは、ソフトウェアによって完了します。

6. （オプション）ステップ 1 を完了すると、更新された処理パラメータが保存されます。

7. Save をクリックします。

ヒント! Save As をクリックすると、バッチを別名で保存できます。
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結果の閲覧 7
Results ワークスペースを使用して、対象サンプルに含まれる代謝物の候補を探索した結果を表示
します。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

Results ワークスペースの概要
ソフトウェアがデータを処理した後、Results ワークスペースを使用して、代謝物の候補のリストを表
示します。

図 7-1 : Results ワークスペース
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項目 説明

1 メニューバー。以下のボタンがあります。
• View

• Processing Parameters: 結果の処理パラメータを表示します。

• Batch Options: 結果のバッチ処理オプションを表示します。

• Sample Details: サンプルの詳細情報を表示します。

• Open: Open Results ダイアログを開き、適切な Results ファイルに移動
できます。

• Save: 現在開いている Results ファイルを保存します。自動的に既存のバ
ージョンを置き換えます。

• Save As: 現在開いている Results ファイルを保存します。ユーザーは、保
存先フォルダーを選択し、Results ファイルに新しい名前を割り当てること
ができます。

2 Potential Metabolites ペイン。選択したアルゴリズムで検出された目的のサ
ンプルのピークをすべてリストアップします。ピーク検出戦略の概要を参照して
ください。

代謝物の候補を含まない行の削除、名称や式の変更、MS/MS スペクトルの
追加、ピーク ID の割り当てなど、結果の編集を行います。結果の編集を参照
してください。

Potential Metabolites 表の列の説明については、表 7-1 を参照してください。

注: 事前に定義されたフィルターが、リストに表示される代謝物の候補に影響
を与える場合があります。結果フィルターの概要を参照してください。
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項目 説明

3 Details ペイン。代謝物の候補がどのようにスコア化されたかについての情報
を提供します。処理メソッドのプロパティごとに、個々の代謝物のスコアと、全
代謝物のスコアの合計が Scoring リストに表示されます。Confirmation
Scoring タブを参照してください。スコアは、Mass Defect（オリゴヌクレオチド
では無効）、Isotope Pattern、MS/MS、Mass Accuracy、および Total
confirmation score について表示されます。

低分子の結果については、Structure リストには利用可能な構造が表示され
ます。

抗体薬物複合体の結果については、Structure リストには、利用可能な構造
と利用可能な配列の両方が表示されます。

ペプチドの結果については、Sequence リストには利用可能な配列が表示さ
れます。

オリゴヌクレオチドの結果については、Sequence リストには、Interpretation
ビューで MS/MS の割り当てによって決定された、選択した代謝物のオリゴヌ
クレオチド配列が表示されます。割り当てを行わなかった場合、このフィールド
は空白になります。
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項目 説明

4 Chromatograms ペイン。検出された代謝物の候補について、異なるクロマト
グラムを表示することが可能です。

• Metabolites: 現在検出されているすべての代謝物ピークの合計を表示し
ます。すべての主要なクロマトグラムのピークが、その RT とピーク ID とと
もに表示されます。選択した代謝物ピークおよび同じ保持時間に溶出する
ピークは黄色で表示されます。

• XIC: 選択した代謝物の抽出イオンクロマトグラム（XIC）を表示します。XIC
抽出のために選択した同位体は、グラフの上部にラベルが付けられていま
す。

• Mass Defect: 選択した代謝物の同定に使用した質量不一致・誤差クロマ
トグラムを表示します。これは低分子データのみに特化したものです。

• Isotope Pattern: 同位体パターンが親化合物と一致するすべてのピーク
のクロマトグラムを表示します。

• Product Ions: Product Ion and Neutral Losses タブで選択したフラグメ
ントと一致するフラグメントイオンを持つすべてのピークのクロマトグラムを
表示します。

• Neutral Losses: Product Ion and Neutral Losses タブで選択したニュー
トラルロスと一致するニュートラルロスを持つすべてのピークのクロマトグラ
ムを表示します。

• Isotope Pattern（SWATH 測定データ）。Product Ion and Neutral
Losses タブで選択したフラグメント同位体パターンと一致するすべてのピ
ークのクロマトグラムを表示します。

• Analog Data: すべてのピークのアナログクロマトグラムを表示します。ピ
ークラベルは、アナログピークと対応する MS ピークの両方の一致するピ
ーク ID を示します。

注: Mass Defect、Isotope Pattern、Product Ions、Neutral Losses、お
よび Isotope Pattern（SWATH 測定データ）クロマトグラムは、これらのアル
ゴリズムを処理用に選択していた場合にのみ利用可能です。また、処理メソッ
ドの定義に従ってアナログデータの処理が行われた場合、Chromatograms
のリストで Analog Data のクロマトグラムが利用可能です。

注: オリゴヌクレオチドワークフローでは、Metabolites、XIC、および Analog
Data のビューのみ利用可能です。

注: Show Controls チェックボックスがオンの場合、XIC と Analog Data の
両方のクロマトグラム（該当する場合）に対照トレースが表示されます。
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項目 説明

5 MS ペイン。MS スペクトルを表示します。Show リストのオプションでは、強調
表示するピークを選択します。

• Default: 選択した代謝物の m/z 値を中心とするサンプル MS の一部を表
示します。

• Mass Defect: 処理メソッドで選択したいずれかの質量不一致・誤差フィル
ターに一致する m/z 値をすべて強調表示します。これは低分子データの
みに特化したものです。

• Isotope Pattern: 親化合物と同じ同位体パターンを持つ m/z 値をすべて
強調表示します。

オリゴヌクレオチドワークフローの場合、デフォルトで Predicted Isotope
Pattern と Charge Series のトレースがオーバーレイ表示されます。デフォ
ルトのビューでは、選択した代謝物の重心 TOF MS スペクトルが表示されま
す。モノアイソトピックピークは予測電荷でラベル付けされ、青い矢印がその位
置を示します。m/z 軸の赤い矢印は、XIC 抽出と領域決定のために選択した
個々の同位体を示します。理論的な同位体エンベロープは重心のピークに重
なり、観測データに対する適合度評価を示します。スペクトルをフルレンジに
設定するには、m/z 軸の下をダブルクリックします。選択した代謝物の追加電
荷状態の予測位置を表示するには、m/z 軸上で左クリックしてドラッグし、パン
とズームを行います。

6 MS/MS ペイン。選択した代謝物の MS/MS スペクトルを表示します。このデ
ータのソースは、以下のいずれかです。

• サンプル IDA wiff ファイル。

• サンプル SWATH 測定 wiff ファイル。

• Results ファイルに追加した専用の MS/MS wiff ファイル。Add MS/MS ボ
タンで複数のスペクトルを追加するを参照してください。

オリゴヌクレオチドについては、処理パラメータで選択した基準 MS/MS スペク
トルと一致した共通のプロダクトイオンピークは黄色で表示されます。一致しな
かったプロダクトイオンピークは青色で表示されます。

表 7-1 : Potential Metabolites 表の列

列 説明

Report 選択すると、最終レポートにその代謝物が含まれます。

Peak ID 代謝物のピーク ID を表示します。ID は、保持時間と代謝物の質量に基づい
て決まります。どの Parent 代謝物でも、Peak ID は空白です。

質量と保持時間が同じで電荷が異なるピークには、-# が付きます。たとえ

ば、M1-1、M1-2、M1-3 のようになります。
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表 7-1 : Potential Metabolites 表の列 (続き)

列 説明

Name 代謝物の名前を表示します。

抗体薬物複合体の結果については、名前の前に Parent という単語が付き

ます。Parent は、低分子薬剤（ペイロード）成分とリンカー成分が結合している
ことを示します。

オリゴヌクレオチドの結果については、主成分名を Parent および Ion
charge という語句で表しています。予測ピークファインダーで同定された生

体内変換・開裂生成物には、特徴的な 5' または 3' (n-#) の表記があります。
一般的なピークファインダーの結果は、Gain または Loss のいずれかの接

頭辞で示されます。

Formula 代謝物のニュートラルフォーミュラを表示します。

Assigned 選択すると、Interpretation ワークスペースに情報が存在することを示します。
たとえば、構造または配列が存在する場合や、Fragments 表にデータが入力
されている場合があります。

Neutral Mass 代謝物のニュートラルマスを表示します。

m/z 代謝物のモノアイソトピック質量電荷比を表示します。

オリゴヌクレオチドの結果では、モノアイソトープが観測されない場合、ソフトウ
ェアがその位置を計算し、m/z 値に（n）のフラグを付けます（n は最初に観測
されたピークからモノアイソトープが離れているピークの数です）。

Charge 代謝物の電荷を表示します。

Peak Index 代謝物について示される XIC ピーク領域の同位体を反映します。

• Blank cell: モノアイソトープ

• 1: モノアイソトピックピーク後の最初の同位体

• 2: モノアイソトピックピーク後の 2 番目のアイソトープ、以下同様

表に列が含まれていない場合、XIC ピーク領域は代謝物のモノアイソトープに
関連付けられます。予測代謝物検出戦略によって同定された代謝物について
は、推定による仮想ベースピークインデックスを表示します。他のピーク検出
戦略で同定された代謝物については、実験的アイソトピックピークを表示しま
す。通常は、実験的アイソトピックピークをベースピークとします。ただし、IDA
データの場合、実験的アイソトピックピークはプレカーサーイオンのインデック
スである可能性があります。

ppm 代謝物の質量真度（ppm）を表示します。

R.T. (min) 代謝物の保持時間を表示します。

Peak Area Peak Index 列にピークインデックスを示す同位体の XIC ピーク領域を表示
します。
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表 7-1 : Potential Metabolites 表の列 (続き)

列 説明

% Area 表中の代謝物の総数を基準とする XIC の % 領域を表示します。

% Score 代謝物の % スコアを表示します。

Analog - Peak
Area

アナログピークのピーク領域を表示します。アナログデータ処理時のみ利用
可能です。

Analog - %
Area

アナログピークの % 領域を表示します。アナログデータ処理時のみ利用可能
です。

Analog - R.T.
(min)

アナログピークの保持時間を表示します。アナログデータ処理時のみ利用可
能です。

フィルタリングされたスペクトルのみを表示

注: この機能は、オリゴヌクレオチドワークフローには適用されません。

Processing Parameters ワークスペース内にある Generic Parameters グループの MS/MS
Parameters タブで SWATH 測定データファイルの処理に Use advanced MS/MS filter パラメー
タを選択した場合、このチェックボックスをオンにすると、高度なフィルターでフィルタリングした
MS/MS スペクトルだけが表示されます。チェックボックスをオフにすると、背景差分スペクトルが表
示されます。

注: Use advanced MS/MS filter パラメータを選択したにもかかわらず、MS/MS スペクトルに背
景差分スペクトルしか表示されない場合は、以下の可能性があります。

• フィルタリングされたスペクトルが空白だった。

• 約 10 倍以上の強度を持つ共溶出ピークによる干渉のため、高度なフィルターが有効でなかっ
た。

• 前駆体ピークのデータポイントが 5 点未満のため、高度なフィルターが有効でなかった。

結果フィルターの概要
フィルターを適用して、Potential Metabolites 表に表示される結果を絞り込むことができます。

ヒント! フィルターアイコン  をクリックすると Results Filters ダイアログが開きます。

表 7-2 : フィルター

選択するフィルター 表示される内容

Metabolites

Top __ metabolites by
peak area

ピーク領域の ％ に基づいて最多となる指定ピーク数のみ。
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表 7-2 : フィルター (続き)

選択するフィルター 表示される内容

Reported metabolites Report 列で選択済みの代謝物のみ。

Metabolites by adduct 一次付加体によって検出された代謝物のみ。一次付加体とは、
Generic Parameters > MS Parameters タブの Advanced Ion
Types 表で最初に表示される付加体のことです。オプションは次のと
おりです。

• 一次

• 最大強度

Assigned Metabolites

Metabolites with
structures or
sequences assigned

Potential Metabolites 表の Assigned 列にチェックマークが表示さ
れている、構造（低分子）または配列（ペプチドおよびオリゴヌクレオ
チド）が割り当てられた代謝物のみ。

Retention Time Window

Retention time from __
to __

指定した範囲内のピークのみ。

Peak Area

Peak area from __ % to
__ %

指定したパーセンテージの範囲内にある % Area を持つピークの
み。

Analog peak area from
__ % to __ %

指定したパーセンテージの範囲内にある % Analog Area を持つピ
ークのみ。処理用にアナログファイルが提供されていない場合、この
フィルターには何の効果もありません。

Charge

Charge from __ to __ 電荷値が指定範囲内にある代謝物のみ。

Score

Overall score above __
%

総合スコアが指定値を上回るピークのみ。Confirmation Scoring タ
ブを参照してください。

オリゴヌクレオチドワークフローでは、同位体エンベロープを確認スコ
アリングの唯一のパラメータとして使用することをお勧めします。ま
た、理論的な同位体重複スコアが低い代謝物を除去するために、
Overall Score を 20% よりも上に設定することを推奨しています。

Mass Accuracy

Accuracy within __
ppm

質量真度が指定範囲内にあるピークのみ。

Mass Range

m/z from __ to __ 指定範囲内の m/z 値のみ。
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表 7-2 : フィルター (続き)

選択するフィルター 表示される内容

Product Ions and Neutral Losses

MS/MS similarity above
__

MS/MS の類似性スコアが指定値を上回るピークのみ。基準スペクト
ルが提供されていない場合、このフィルターには何の効果もありませ
ん。

Minimum number of
common product ions
__

親化合物と指定数以上のプロダクトイオンを共通に持つピークのみ。
基準スペクトルが提供されていない場合、このフィルターには何の効
果もありません。

Minimum number of
common neutral losses
__

親化合物と指定数以上のニュートラルロスを共通に持つピークのみ。
基準スペクトルが提供されていない場合、このフィルターには何の効
果もありません。

注: 表の行を削除したり追加したりすると、各代謝物の % Area と % Analog Area が自動的に更
新され、残りの行に対するピーク領域、アナログピーク領域、ピーク領域による上位代謝物のフィル
ターの適用方法に影響を与えます。

結果の編集
Potential Metabolites 表のエントリは、編集または削除して、結果をさらに絞り込むことができま
す。

以下のことができます。

• 行の削除

• 代謝物候補の名前と式を編集

• ピーク ID の割り当て

行の削除

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Potential Metabolites 表の行を選択します。

ヒント! クリックしたまま Ctrl または Shift キーを押して、複数の行を選択します。

6. Edit > Delete Selected Rows. をクリックします。
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ヒント! 直近の削除を元に戻すには、Edit > Undo Delete をクリックします。

7. Save をクリックします。

代謝物候補の名前と式を編集

ソフトウェアによる代謝物の命名方法を参照してください。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Potential Metabolites 表の行を右クリックし、Edit Name and Formula を選択します。
Edit Name and Formula ダイアログが開きます。

6. Name を変更するには、次のいずれかを行います。

• 該当する場合は、表示されるオプションのリストから名前を選択します。

• 新しい名前を入力します。

7. 該当する場合は、表示されるオプションのリストから付加体を選択します。

注: 付加体が変更された場合、代謝物の Mass accuracy は自動的に更新されます。

8. Formula を変更するには、次のいずれかを行います。

• 式を決定するのに十分な情報がない場合は、Unknown を選択します。

• 代謝物の候補に式を手動で追加するには、Use を選択した後、表示されるフィールドに式を
入力します。

• 式の候補がソフトウェアによって予測された場合は、Automatic を選択し、リストからエント
リを選択します。

注: 式の候補がソフトウェアによって予測されなかった場合、Automatic は選択できませ
ん。

注: Mass accuracy フィールドと RDB フィールドの値は、新しい式を追加すると自動的に更
新されます。

9. 選択した行の代謝物を親化合物として同定するには、Assign as Parent をクリックします。

10. OK をクリックします。

11. Save をクリックします。
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注: ペプチドの場合は、提案された名前の質量精度と、たとえば結合を切断するなどの必要な
操作の数に基づいて、名前の順番を決定します。つまり、質量精度が高く、操作の少ないペプ
チドの提案名がリストの一番上に表示されます。

ピーク別にグループ化

Group by Peaks ボタンを使用して、たとえば分子の複数の電荷状態のように、中性質量が等しい
ピークをグループ化し、同定されたすべての電荷状態を集計した Peak Area、%Area などのサマ
リー表を表示することができます。ピークは中性質量と保持時間の許容範囲に基づいてグループ化
されます。

注: グループ機能は、オリゴヌクレオチドワークフローにのみ適用されます。

ピーク ID の割り当て

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Potential Metabolites 表で現在の ピーク ID を確認します。

6. 行の削除や代謝物の名前の変更など、表の変更を行います。

7. Assign ID をクリックします。

同じニュートラルフォーミュラと保持時間に関連する行はグループ化されています。グループ内
の 1 つの行に一次ピーク ID が割り当てられ、残りの行には一次ピーク ID の 1 つ下のレベル
の配列 ID が割り当てられます。たとえば、割り当てられた一次ピーク ID が M2 の場合、残り
の各行には M2 から始まる配列 ID が割り当てられます。たとえば、M2-1、M2-2 のようになり
ます。

非一次ピーク ID は、非一次付加体を持つピークに割り当てられます。非一次付加体とは、
Advanced Ion Types 表で選択されているものの、イオンタイプリストには表示されていない付
加体のことです。イオンタイプリストには、一次ピーク ID のみが表示されます。

MS/MS スペクトル

MS/MS スペクトルは、任意の代謝物について追加、削除、置換ができます。MS/MS スペクトル
は、手動の場合は Explorer ワークスペースで重心を設定した単一の MS/MS スペクトルをコピー
し、Results ワークスペースに貼り付けることで、自動の場合は Results ワークスペースの Add
MS/MS ボタンで追加できます。

貼り付けによるスペクトルの追加

注: この機能はベータ版です。
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注: この機能は、オリゴヌクレオチドワークフローにおいて、TOF-MS/MS および IDA データに対し
てのみ利用可能です。IDA Explorer からの MS/MS スペクトルの貼り付けは、現在非対応です。デ
ータファイルは、標準的な TIC として開き、Explorer ワークスペースで重心を設定してから
Molecule Profiler にペーストする必要があります。

注: Results ファイル内の既存の MS/MS スペクトルは、Results ファイルが保存されるまで上書き
されません。Results ファイルに保存されている選択した代謝物質の元のスペクトルに戻すには、
Results ファイルを保存する前に Remove MS/MS をクリックします。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動して選択し、OK をクリックします。
Results ビューが表示されます。

4. Potential Metabolites 表の行を選択します。

5. SCIEX OS ホームページから Explorer ワークスペースを開きます。

6. File > Open Sample を選択します。
Select Sample ダイアログが開きます。

7. サンプルを含むデータファイルに移動し、+ をクリックして展開し、開くサンプルを選択して OK
をクリックします。

データファイルは、TOF-MS/MS または IDA のデータを含む wiff または wiff2 データファイル
である必要があります。

8. データファイルに IDA データが含まれている場合は、Open IDA Sample ダイアログで As a
standard TIC を選択し、OK をクリックします。

9. MS および MS/MS スペクトルを開きます。

ヒント! スペクトルを開くには、選択ウィンドウを設定するか、TIC ペインで保持時間をダブルク
リックします。

10. MS/MS スペクトルのヘッダーを右クリックし、Remove All Traces Except Active を選択しま
す。

11. Process > Centroid Spectrum を選択します。
Centroid ダイアログが開きます。

12. Intensity、Height、Area、Intensity sum above 50% のいずれに重心を置くかを選択しま
す。

13. Edit > Copy を選択します。

14. Molecule Profiler ワークスペースに移動します。

15. Paste MS/MS をクリックします。
MS/MS スペクトルが追加されます。

16. Save をクリックします。
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Add MS/MS ボタンで複数のスペクトルを追加する

注: Results ファイル内の既存の MS/MS スペクトルは、Results ファイルが保存されるまで上書き
されません。Results ファイルに保存されている選択した代謝物質の元のスペクトルに戻すには、
Results ファイルを保存する前に Remove MS/MS をクリックします。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動して選択し、OK をクリックします。
Results ビューが表示されます。

4. Potential Metabolites 表の行を選択します。

5. Add MS/MS をクリックします。
Add MS/MS ダイアログが開きます。

6. Select MS/MS をクリックします。
Select Data ダイアログが開きます。

7. 適切な Source フォルダーに移動し、選択します。

8. OK をクリックします。

9. Select Data ダイアログの Available ペインで、MS/MS スペクトルを含む wiff ファイルと注入

を選択し、アイコン（ ）をクリックして Selected ペインにファイルを移動します。

ヒント! 最大 10 本の注入が選択できます。

10. Add MS/MS ダイアログに必要なファイルがすべて表示されたら、OK をクリックします。
ソフトウェアは、各代謝物の一致するスペクトルを見つけようとします。

11. 各代謝物のスコアを確認します。
MS/MS のスペクトルが変更された場合、ソフトウェアが % Score を再計算する可能性があり
ます。

12. Save をクリックします。

1 つの MS/MS スペクトル内で特定のフラグメントの種類を編集するには、オリゴヌクレオチド
ワークフローを参照してください。

スペクトルの削除

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。
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5. Potential Metabolites 表の行を選択します。

6. MS/MS ペインで Remove MS/MS をクリックします。

注: 代謝物候補の IDA スペクトルが存在する場合は、MS/MS ペインに表示されます。

7. Save をクリックします。

MS/MS スペクトルファイルの削除

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Add MS/MS をクリックします。

6. MS/MS Samples フィールドで適切な wiff ファイルを選択します。

7. Remove をクリックし、OK をクリックします。
wiff ファイル内の専用 MS/MS スペクトルはすべて結果から削除されます。

8. Save をクリックします。
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MS/MS データの特性評価 8
対象サンプルのピークを特定した後、フラグメント解釈を使用すると、各代謝物候補の構造を特定
するのに役立ちます。

Interpretation ビューの概要
Results ワークスペースの Interpretation ビューには、Results ファイルに含まれる各代謝物質の
構造候補を明らかにするために必要なデータとツールが表示されます。

Interpretation ビュー

Small Molecule
Interpretation ビュー

ペプチドの
Interpretation ビュー

オリゴヌクレオチドの
Interpretation ビュー

抗体薬物複合体の
Interpretation ビュー

Small Molecule Interpretation ビュー

図 8-1 : Small Molecule Interpretation ビュー
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項目 インターフェース
コンポーネント

説明

1 MS/MS ペイン 選択した代謝物の MS/MS スペクトルを表示します。ま
た、基準 MS/MS スペクトルがある場合は、その鏡像も表
示されます。アスタリスクは、割り当てのために選択したピ
ークを示します。このスペクトルのソースは、サンプルの
IDA wiff ファイル、サンプルの SWATH 測定 wiff ファイ
ル、または Results ファイルに追加した専用の MS/MS
wiff ファイルです。ボタンを押して実行する機能の説明に
ついては、表 8-1 を参照してください。

2 Fragments 表 選択した代謝物に割り当てられたフラグメントの m/z 値、
提案された構造の数、スコアをすべて表示します。特定の
m/z 値に異なる式が割り当てられる可能性がある場合、
表には各式の行が含まれます。デフォルトでは、各式と
m/z 値の組み合わせで最も高いスコアを持つ行は、Use
チェックボックスがオンになっています。

ヒント! Use チェックボックスをオンにしていない行は、非
表示になります。すべての行を表示するには、表を右クリ
ックし、Show Hidden Rows をクリックします。

アイコンを押して実行する機能の説明については、表 8-3
を参照してください。

2a Structure Details
表

選択したフラグメントを生成する可能性のある構造部分
を、結合の切断数、デルタ H の値、およびスコアとともに
リストアップします。この表で行を選択すると、構造の関連
部分が強調表示されます。

デフォルトでは、スコアが最も高いフラグメント構造で Use
チェックボックスがオンになっています。

2b Contained
Neutral Losses
表

2　つのフラグメント質量からのニュートラルロスを含みま
す。

3 Structure charts
ペイン

以下の 2 つタブが含まれています。

• Parent Structure タブ。選択した代謝物の親構造を示
します。

• Structure Candidates タブ。提案された構造の全リス
トをスコアの降順に並べた表を含むインタラクティブな
ヒストグラムです。この表の行を選択すると、Structure
ペイン（項目 2 ）に表示される構造が変化します。特定
の構造を結果に含めるには、その構造の Apply to
Results チェックボックスをクリックします。Structure
Candidates タブの概要を参照してください。
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項目 インターフェース
コンポーネント

説明

4 Structure ペイン 代謝物候補の構造候補を読み込み、基本的な描画ツー
ルで構造を編集できます。ボタンを押して実行する機能の
説明については、表 8-2 を参照してください。

表 8-1 : MS/MS ペインのボタン

ボタン 説明

Deisotope MS/MS ペインのすべての同位体を非表示にします。もう一度クリックす
ると同位体が表示されます。

Prepare Interpret Data ダイアログを開き、選択した代謝物を解釈するために必
要な詳細（式、アクティブなピーク、MS/MS スペクトルの再キャリブレー
ション）を編集できます。

Options MS/MS フラグメントを割り当てるための Options ダイアログを開きます。
オプションの設定で表 8-15 を参照してください。

Generate 選択した代謝物の構造候補を自動生成し、Structure Candidate タブに
入力します。Structure Candidates タブの概要を参照してください。

Apply 選択したピークに解釈の変更を適用します。

Remove 選択したピークから、割り当てられたフラグメントと代謝物構造を削除しま
す。

表 8-2 : Structure ペインのボタン

ボタン 説明

Load • 親を読み込む: 選択した代謝物の親構造を開きます。

• 構造を読み込む: 選択したピークの構造ファイルを開きます。

Delete 表示されている構造を Structure ペインから削除します。

Save As 表示されている構造を別のファイル名で保存できるようにします。

Assign 構造候補のフラグメントとニュートラルロスを計算し、MS/MS スペクトル
にイオンを割り当てます。

表 8-3 : Fragments 表のアイコン

アイコン 説明

選択したフラグメントのラベルを追加します。

MS/MS スペクトルからすべてのラベルを削除します。
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表 8-3 : Fragments 表のアイコン (続き)

アイコン 説明

Interpretation Filters ダイアログを開きます。低分子用 Interpretation
Filters の概要を参照してください。

ペプチドの Interpretation ビュー

図 8-2 : ペプチドの Interpretation ビュー

項目 インターフェース
コンポーネント

説明

1 MS/MS ペイン 選択した代謝物の MS/MS スペクトルを表示します。ま
た、基準 MS/MS スペクトルがある場合は、その鏡像も表
示されます。このスペクトルのソースは、サンプルの IDA
wiff ファイル、サンプルの SWATH 測定 wiff ファイル、ま
たは Results ファイルに追加した専用の MS/MS wiff ファ
イルです。ボタンを押して実行する機能の説明について
は、表 8-4 を参照してください。

2 Sequence ペイン 配列の入力を可能にします。ボタンを押して実行する機能
の説明については、表 8-5 を参照してください。

3 Fragments 表 選択した代謝物候補の提案式のリストが含まれていま
す。リストには、m/z 値、配列、フラグメントイオンの種類
（たとえば y や b）、電荷、エラー、強度が含まれます。ア
イコンを押して実行する機能の説明については、表 8-6 を
参照してください。
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項目 インターフェース
コンポーネント

説明

4 Sequence charts
ペイン

以下の 2 つタブが含まれています。

• 親薬品の配列が含まれている Parent Sequence タ
ブ。

• Sequence Candidates タブは、ソフトウェアが提案す
る配列のリストを示す表を含むインタラクティブなヒスト
グラムです。各配列案には、ピーク領域の割合に基づ
いたスコアが割り当てられます。特定の配列を結果に
適用するには、その配列の Apply to Results チェッ
クボックスをオンにします。適用された配列は、Results
ファイルを閉じてから再び開くと、デフォルトの配列とし
て表示されます。Sequence Candidates タブの概要を
参照してください。

表 8-4 : MS/MS ペインのボタン

ボタン 説明

Deisotope MS/MS スペクトルからすべての同位体を削除します。

Options Options ダイアログを開きます。オプションの設定で表 8-16 を参照してく
ださい。

Generate 選択した代謝物の構造候補を自動生成し、Structure Candidate タブに
入力します。Structure Candidates タブの概要を参照してください。

Apply 選択したピークに解釈の変更を適用します。

Remove 選択したピークから、割り当てられたフラグメントと代謝物構造を削除しま
す。

表 8-5 : Sequence ペインのボタン

ボタン 説明

Enter Sequence Sequence ペインに新しい配列を入力できるようになります。ペプチド配
列の命名規則を参照してください。

Load Parent 選択した代謝物の親配列を開きます。

Delete 表示されている配列を Sequence ペインから削除します。

Assign 構造候補のフラグメントとニュートラルロスを計算し、MS/MS スペクトル
にイオンを割り当てます。
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表 8-6 : Fragments 表のアイコン

アイコン 説明

すべてのピークにラベルを追加します。

選択したフラグメントのラベルを追加します。

MS/MS スペクトルからすべてのラベルを削除します。

Interpretation Filters ダイアログを開きます。ペプチド用の
Interpretation フィルターの概要を参照してください。

オリゴヌクレオチドの Interpretation ビュー

図 8-3 : オリゴヌクレオチドの Interpretation ビュー

項目 インターフェース
コンポーネント

説明

1 MS/MS ペイン 選択した代謝物の MS/MS スペクトルを表示します。ま
た、基準 MS/MS スペクトルがある場合は、その鏡像も表
示されます。このスペクトルのソースは、サンプルの IDA
wiff ファイル、サンプルの SWATH 測定 wiff ファイル、ま
たは Results ファイルに追加した専用の MS/MS wiff ファ
イルです。ボタンを押して実行する機能の説明について
は、表 8-7 を参照してください。

2 Fragments 表 選択した代謝物候補の提案式のリストが含まれていま
す。リストには、m/z 値、配列、フラグメントイオンの種類
（たとえば y や b）、電荷、エラー、強度が含まれます。ア
イコンを押して実行する機能の説明については、表 8-6 を
参照してください。
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項目 インターフェース
コンポーネント

説明

3 Sequence charts
ペイン

親薬品の配列を含みます。

4 Sequence ペイン 配列の入力を可能にします。ボタンを押して実行する機能
の説明については、表 8-5 を参照してください。

表 8-7 : MS/MS ペインのボタン

ボタン 説明

Deisotope MS/MS スペクトルからすべての同位体を削除します。

Options Options ダイアログを開きます。オプションの設定で表 8-18 を参照してく
ださい。

Apply 選択したピークに解釈の変更を適用します。

Remove 選択したピークから、割り当てられたフラグメントと代謝物構造を削除しま
す。

表 8-8 : Sequence ペインのボタン

ボタン 説明

Load Parent 選択した代謝物の親配列を開きます。

Delete 表示されている配列を Sequence ペインから削除します。

Assign 構造候補のフラグメントとニュートラルロスを計算し、MS/MS スペクトル
にイオンを割り当てます。

表 8-9 : Fragments 表のアイコン

アイコン 説明

すべてのピークにラベルを追加します。

選択したフラグメントのラベルを追加します。

MS/MS スペクトルからすべてのラベルを削除します。

Interpretation Filters ダイアログを開きます。オリゴヌクレオチド用の
Interpretation フィルターの概要を参照してください。
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抗体薬物複合体の Interpretation ビュー

図 8-4 : 抗体薬物複合体の Interpretation ビュー

項目 インターフェース
コンポーネント

説明

1 MS/MS ペイン 選択した代謝物の MS/MS スペクトルを表示します。ま
た、基準 MS/MS スペクトルがある場合は、その鏡像も表
示されます。このスペクトルのソースは、サンプルの IDA
wiff ファイル、サンプルの SWATH 測定 wiff ファイル、ま
たは Results ファイルに追加した専用の MS/MS wiff ファ
イルです。ボタンを押して実行する機能の説明について
は、表 8-10 を参照してください。

2 Fragments 表 以下のタブが含まれています。

• Structure タブ。選択した代謝物に割り当てられたフラ
グメントの m/z 値、提案された構造の数、スコアをすべ
て表示します。特定の m/z 値に異なる式が割り当てら
れる可能性がある場合、表には各式の行が含まれま
す。デフォルトでは、各式と m/z 値の組み合わせで最
も高いスコアを持つ行は、Use チェックボックスがオン
になっています。

• Sequence タブ。選択した代謝物候補の提案式をすべ
てリストアップします。リストには、m/z 値、配列、フラグ
メントイオンの種類（たとえば y や b）、電荷、エラー、
強度が含まれます。

アイコンを押して実行する機能の説明については、表
8-13 を参照してください。
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項目 インターフェース
コンポーネント

説明

3 Sequence ペイン ペイロードまたはリンカー部分と結合している配列の部分
を表示します。ペイロードやリンカー部分と結合している残
基を示すには、残基を選択して右クリックし、Mark
Residue to Conjugate を選択します。

4 Structure ペイン 代謝物候補の構造候補を読み込み、基本的な描画ツー
ルで構造を編集できます。ボタンを押して実行する機能の
説明については、表 8-11 を参照してください。

表 8-10 : MS/MS ペインのボタン

ボタン 説明

Deisotope MS/MS スペクトルからすべての同位体を削除します。

Options Options ダイアログを開きます。オプションの設定で表 8-21 を参照してく
ださい。

Apply 選択したピークに解釈の変更を適用します。

Remove 選択したピークから、割り当てられたフラグメントと代謝物構造を削除しま
す。

表 8-11 : Structure ペインのボタン

ボタン 説明

Load • Load Parent Structure: 選択した代謝物の親構造を開きます。

• Load Sequence: 選択した代謝物の配列を開きます。

Delete Structure ペインから読み込んだ構造、Sequence ペインから読み込ん
だ配列情報、Fragments 表から割り当てた構造と配列情報を削除しま
す。

Save Structure As 構造を別のファイル名で保存できるようにします。

Assign 構造候補のフラグメントとニュートラルロスを計算し、MS/MS スペクトル
にイオンを割り当てます。

表 8-12 : Fragments 表のボタン

ボタン 説明

Structure 選択した代謝物に割り当てられたフラグメントの m/z 値、提案された構
造の数、スコアをすべて表示します。特定の m/z 値に異なる式が割り当
てられる可能性がある場合、表には各式の行が含まれます。デフォルト
では、各式と m/z 値の組み合わせで最も高いスコアを持つ行は、Use チ
ェックボックスがオンになっています。
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表 8-12 : Fragments 表のボタン (続き)

ボタン 説明

Sequence 選択した代謝物候補の提案式をすべてリストアップします。リストには、
m/z 値、配列、フラグメントイオンの種類（たとえば y や b）、電荷、エラ
ー、強度が含まれます。

表 8-13 : Fragments 表のアイコン

アイコン 説明

すべてのピークにラベルを追加します。

選択したフラグメントのラベルを追加します。

MS/MS スペクトルからすべてのラベルを削除します。

Interpretation Filters ダイアログを開きます。抗体薬物複合体用の
Interpretation フィルターの概要を参照してください。

手作業による解釈

手作業による解釈

低分子ワークフロー ペプチドワークフロー オリゴヌクレオチドワー
クフロー

抗体薬物複合体ワーク
フロー

低分子ワークフロー

構造の読み込み

構造の編集

構造割り当てを準備する 代謝物候補の名前と式を編集

MS/MS スペクトルの再キャリブレーション

MS/MS スペクトルの脱同位体化

アクティブピークの選択

割り当てるフラグメントピークを選択する

オプションの設定

フラグメント構造の割り当て 提案式と構造の割り当て

各フラグメントに対応する式構造を選択す
る
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マルクーシュ構造の装着

ピークラベルの概要 MS/MS スペクトルにピークラベルを追加す
る

低分子用 Interpretation Filters の概要

構造の読み込み

代謝物の構造解析を開始する前に、ソフトウェアがフラグメント構造の候補を決定するための構造
ファイルを読み込んでください。

注: 構造が読み込まれていない場合でも、式の候補をフラグメントに割り当てることができます。

1. Workspace パネルで Results をクリックします。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. Results ファイルに移動し、選択します。

4. OK をクリックします。

5. Show フィールドで Interpretation を選択します。

6. Potential Metabolites 表の行を選択します。

7. Structure ペインで Load をクリックし、Load Structure オプションを選択します。
Open Structure File ダイアログが開きます。

8. 構造ファイルに移動し、選択します。

注: ソフトウェアは、sdf または mol フォーマットの構造ファイルを受け入れます。

9. 細かい変更が必要な場合は、構造を編集します。構造の編集を参照してください。

構造の編集

特定の代謝物の構造を読み込んだ後、編集ツールで細かい変更を加えます。

ヒント! 編集ツールを使って代謝変換の付着点を変えるなど、構造に細かい変更を加えることができ
ます。編集ツールは、新しい構造を作成したり、既存の構造に大きな変更を加えたりするために使
用しないでください。

表 8-14 : 構造の編集

目的の作業 実行する操作

構造に原子を追加する パレット上の特定の記号を新しい位置にドラッグします。
追加した原子は、最も近い既存の原子と単結合を形成し
ます。
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表 8-14 : 構造の編集 (続き)

目的の作業 実行する操作

パレット上に新しい原子を作成する 空白の四角をクリックし、Specify Symbol ダイアログに記
号を入力し、OK をクリックします。

ヒント! 追加した四角をクリックし、新しい記号を入力する
と、異なる原子を作成できます。

構造の一部を強調表示する 必要な原子と結合の周りをドラッグして円を描きます。

1 つ以上の原子を移動する 構造のハイライト部分を新しい位置までドラッグします。そ
の部分が他の 1 つの原子に結合していれば、結合は新し
い位置に移動します。その部分が 2 つ以上の原子に結合
している場合、その部分は移動しますが、既存の結合は
変わりません。

既存の構造に構造を挿入する 構造を右クリックし、次のいずれかをクリックします。

• 別の構造を追加するには Insert .mol File をクリック
します。

• 特定の結合構造を追加するには Insert Conjugate
をクリックします。

1 つ以上の原子を削除する 構造のハイライト部分を右クリックし、Remove Selected
Atoms をクリックします。

結合の作成 結合していない 2 つの原子を選択し、選択したものを右ク
リックして New Bond をクリックし、結合の種類を選択し
ます。

結合の編集 結合を右クリックし、Set Bond Type をクリックして、結合
の種類を選択します。

結合の削除 結合を右クリックし、Remove Bond をクリックします。

既存の原子の電荷状態を変更する 原子を右クリックし、Atom Charge State をクリックして、
状態を選択します。

ヒント! 編集した構造を別ファイルとして保存する場合は、Save As をクリックします。

ヒント! 構造は mol ファイルまたは sdf ファイルとして保存できます。Save As ダイアログに適切な
拡張子を入力します。

構造割り当てを準備する

ユーザーが構造割り当てを準備する際に、4 つのタスクがあります。

• 代謝物候補の名前または式を編集する。

• MS/MS スペクトルを再キャリブレーションする。
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• MS/MS スペクトルの特定のピークを選択する。

• 解釈するフラグメントピークを選択する。

注: これらの作業が不要な場合は、上記の手順を無視して、すぐにフラグメント構造を割り当てるこ
とができます。

代謝物候補の名前と式を編集

ソフトウェアによる代謝物の命名方法を参照してください。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Potential Metabolites 表の行を右クリックし、Edit Name and Formula を選択します。
Edit Name and Formula ダイアログが開きます。

6. Name を変更するには、次のいずれかを行います。

• 該当する場合は、表示されるオプションのリストから名前を選択します。

• 新しい名前を入力します。

7. 該当する場合は、表示されるオプションのリストから付加体を選択します。

注: 付加体が変更された場合、代謝物の Mass accuracy は自動的に更新されます。

8. Formula を変更するには、次のいずれかを行います。

• 式を決定するのに十分な情報がない場合は、Unknown を選択します。

• 代謝物の候補に式を手動で追加するには、Use を選択した後、表示されるフィールドに式を
入力します。

• 式の候補がソフトウェアによって予測された場合は、Automatic を選択し、リストからエント
リを選択します。

注: 式の候補がソフトウェアによって予測されなかった場合、Automatic は選択できませ
ん。

注: Mass accuracy フィールドと RDB フィールドの値は、新しい式を追加すると自動的に更
新されます。

9. 選択した行の代謝物を親化合物として同定するには、Assign as Parent をクリックします。

10. OK をクリックします。

11. Save をクリックします。
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注: ペプチドの場合は、提案された名前の質量精度と、たとえば結合を切断するなどの必要な
操作の数に基づいて、名前の順番を決定します。つまり、質量精度が高く、操作の少ないペプ
チドの提案名がリストの一番上に表示されます。

MS/MS スペクトルの再キャリブレーション

1. Interpretation ビューで Prepare をクリックします。
Interpret Data ダイアログが開きます。

2. MS/MS Details タブをクリックします。

3. キャリブレーションポイントとして使用するフラグメントを選択します。

4. 選択したフラグメントを右クリックし、Set calibration points をクリックします。
フラグメントサークルの色が青に変わります。

5. ステップ 3 と 4 を繰り返して、キャリブレーションポイントをさらに選択します。

6. 設定したキャリブレーションポイントを削除するには、該当するキャリブレーションポイントを選
択した後、右クリックして Clear calibration points を選択します。
フラグメントサークルの色が緑に戻ります。

7. フラグメントの詳細を表示するには、キャリブレーションポイントを選択した後、右クリックして
Composition details を選択します。
Fragment ダイアログが開き、m/z 値、質量エラー（ppm と mDa の両方）、提案式が偶数電子
を指すかどうか、および提案式の RDB 値（環と二重結合）が表示されます。

8. キャリブレーションポイントをフラグメントの組成またはキャリブレーションポイント候補として選
択するには、キャリブレーションポイントを選択した後、右クリックして Select composition を
選択します。

9. MS/MS スペクトルを右クリックして、Recalibrate をクリックします。

注: 再キャリブレーションしたスペクトルを破棄するには、スペクトルを右クリックして Revert
Calibration をクリックします。

MS/MS スペクトルの脱同位体化

Interpretation ビューで、Deisotope をクリックすると、MS/MS スペクトルからすべての同位体が削
除されます。これにより、モノアイソトピックピークを素早く表示でき、SWATH 測定データを閲覧する
際に便利です。

注: このオプションを選択したかどうかにかかわらず、モノアイソトープのみが Results Table に表
示されます。

アクティブピークの選択

アクティブピークは、MS/MS スペクトルの中で、フラグメント解釈に利用できる唯一のピークです。

1. Interpretation ビューで Prepare をクリックします。
Interpret Data ダイアログが開きます。

2. MS/MS スペクトルをレビューします。
青い矢印は、現在アクティブなピークを示します。
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3. ピークを選択するには、ピークを横切るように四角形をドラッグします。

4. 選択したピークをダブルクリックします。
選択したピークの下に青い矢印が表示されます。

5. 単一ピークを削除するには、Interpret Data ダイアログの境界線の下にある青い矢印をドラッ
グします。
選択したピークの下から青い矢印が削除されます。

ヒント! アクティブなピークをすべてクリアするには、スペクトルを右クリックし、Clear All
Markers をクリックします。

6. アクティブなピークをすべて選択した後、Find をクリックします。

7. MS および MS/MS スペクトルに最も良く一致する式の行を選択します。

8. Select をクリックします。

割り当てるフラグメントピークを選択する

複数のピークがアクティブとして同定される可能性がありますが、ユーザーは最も強度の高いピー
クのみを選択して作業することができます。

1. Interpretation ビューで Options をクリックします。
Options ダイアログが開きます。

2. Number of fragment peaks selected for assignment フィールドに適切な数を入力しま
す。

3. OK をクリックします。
MS/MS スペクトル内のアスタリスクは、割り当てのために選択したピークを示します。

オプションの設定

1. Interpretation ビューで Options をクリックします。
Options ダイアログが開きます。

2. フラグメンテーションとラベリングのパラメータを表 8-15 のように変更します。

表 8-15 : Options ダイアログ

オプション 説明

Number of fragment
peaks selected for
assignment

このフィールドを使用して、割り当てるフラグメントピークの数を指定しま
す。この数には、Prepare ダイアログで選択したピークの総数のサブセ
ットが使用できます。全ピーク数のサブセットであれば、ピークは強度の
高い順に選択されます。

Minimum signal-to-
noise ratio

このフィールドを使用して、フラグメントピークを割り当てるために使用す
るしきい値を指定します。このしきい値未満のピークは割り当てられませ
ん。ノイズは、MS/MS スペクトルにおいて最も強度の小さいピークと定
義されます。

MS/MS m/z
tolerance (ppm or
mDa)

フラグメントピークに式や構造を割り当てるには、その質量精度が指定
した MS/MS m/z 許容値内である必要があります。
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表 8-15 : Options ダイアログ (続き)

オプション 説明

Fragmentation Settings

Break aromatic
rings

芳香環を切断する場合は、このチェックボックスをオンにします。

Maximum number
of bonds to break

このフィールドを使用して、切断する結合の最大数を指定します。オプシ
ョンは次のとおりです。

• 1

• 2

• 3

• 4

Maximum number
of C-C bonds to
break

このフィールドを使用して、切断する C-C 結合の最大数を指定します。
オプションは次のとおりです。

• 0

• 1

• 2

• 3

• 4

Label Settings

Label peaks with このフィールドを使用して、ピークラベルに表示する情報を指定します。
オプションは次のとおりです。

• Ion

• Ion with ppm Error

• Ion with mDa Error

Apply options to all
potential
metabolites

このチェックボックスをオンにすると、現在のオプションが未割り当ての
すべての代謝物に適用されます。

フラグメント構造の割り当て

構造を割り当てるために、ソフトウェアは MS/MS スペクトル中のフラグメントピークを構造候補の可
能性のある部分にリンクさせます。ユーザーは、各フラグメントの m/z 値に最も良く一致する式と構
造を選択できます。割り当ての実行後、割り当てのために選択したピークを示すアスタリスクは、割
り当てが行われた場合はチェックマークに、割り当てができなかった場合は x に置き換えられます。

注: フラグメンテーションルールはソフトウェアに組み込まれており、編集できません。
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提案式と構造の割り当て

各代謝物には、フラグメント構造を割り当てる前に MS/MS スペクトルが必要です。スペクトルを追
加するには、Add MS/MS ボタンで複数のスペクトルを追加するを参照してください。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Show フィールドで Interpretation を選択します。

6. 構造候補を読み込んで編集します。構造の読み込みおよび構造の編集を参照してください。

7. 必要に応じて、構造を割り当てる準備をします。構造割り当てを準備するを参照してください。

8. Interpretation ビューの Structure ペインで、Assign をクリックします。
MS/MS ペインの下には、同定されたフラグメントを示す Fragments 表、構造候補を示す
Structure Details 表、含有されるニュートラルロスを示す Contained Neutral Losses 表という
3 つの表が表示されます。

注: 構造が読み込まれていない場合、ソフトウェアはフラグメントに候補式のみを割り当てま
す。

各フラグメントに対応する式構造を選択する

1. 必要に応じて、Interpretation ビューで Fragments、Structure Details、Contained Neutral
Losses の各表を右クリックし、Show Hidden Rows をクリックします。

注: Fragments 表では、m/z 値のスコアが最も高い行の Use チェックボックスがオンになって
います。Structure Details 表では、スコアが最も高い行の Use チェックボックスがオンになっ
ています。Contained Neutral Losses 表では、すべての行で Use チェックボックスがオンにな
っています。

2. Fragments 表で、Use チェックボックスをオンにすると、各 m/z 値に対して最も正確な式を含
む行を特定できます。

ヒント! Fragments 表で複数行の Use チェックボックスをオンにすると、各フラグメントに対して
複数の候補式を選択できます。

3. Structure Details 表で Use チェックボックスをオンにすると、選択した式に最も正確に一致す
る部分を特定できます。

4. Contained Neutral Losses 表で Use チェックボックスをオンにすると、含まれているニュートラ
ルロスを最も正確に反映する行を特定できます。

ヒント! Structure Details 表と Contained Neutral Losses 表で、特定のフラグメントに対して
複数の行で Use チェックボックスをオンにします。
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5. Apply をクリックします。
選択した代謝物の解釈データが保存されます。

6. すべての変更が完了したら、Save をクリックします。

ヒント! 特定の代謝物の解釈データをすべて削除する場合は、Remove をクリックします。

Structure Candidates タブの概要

構造の自動生成機能を使用すると、Structure charts ペインの Structure Candidates タブに、
Options ダイアログで設定した条件を満たす、選択した代謝物の構造リストが表示されます。バッチ
処理オプションを参照してください。ソフトウェアは、以下の種類の代謝物の構造を生成します。

• 1 つまたは 2 つの開裂がある代謝物

• 単一の生体内変換代謝物

• 1 つの開裂と 1 回の生体内変換がある代謝物

より複雑な代謝の場合は、カスタム代謝物構造を提供または編集し、その構造案を評価することが
できます。

構造のリスト（ヒストグラムと呼ばれる）には、次のような列の情報が含まれています。

列 説明

Rank 構造の位置やランキングを示します。

Relative
Evidence

親構造の MS/MS スペクトルと代謝物の MS/MS スペクトルの比較により、順
位付けまたはスコアリングを行います。その後、代謝物のフラグメントを親のフ
ラグメントと比較し、シフトしたフラグメントとそうでないフラグメントを同定しま
す。さらに、フラグメント強度や提案の独自性といった他の属性も、全体的なラ
ンキング戦略において考慮されます。最終的なランキングは、特定の原子番
号で生体内変換や開裂が起こる確率を示します。

また、この欄で構造の切り替えが可能です。構造の切り換えを参照してくださ
い。

Apply to
Results

チェックボックスがオンの場合は、対応する構造が Results ファイルに保存さ
れます。

ヒストグラム表の上、Apply to Results 列の真上に候補の総数が表示されます。

自動生成された構造は編集できません。構造を読み込み、必要な修飾を加えた後、Apply to
Results チェックボックスをオンにすると、その構造が Results ファイルに含まれます。構造の読み
込みおよび構造の編集のステップ 7 および 8 を参照してください。

構造の切り換え

ヒストグラムの青いバーをクリックします。
対応する構造が Structure ペインに表示されます。
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空のペインを選択する

ヒストグラムの 1 行目をクリックします。
ヒストグラムの 1 行目には、No structure の語句が含まれています。Structure ペインが更新さ

れ、No structure の語句が表示されます。

構造の追加

注: 自動生成される構造のリストに追加できる配列は 1 つだけです。構造を追加した場合、ユーザ
ーが追加した前の構造は上書きされます。

1. Structure ペインで Load をクリックし、Load Structure オプションを選択します。
Open Structure File ダイアログが開きます。

2. 有効な mol または sdf ファイルに移動し、選択します。

3. Open をクリックします。

選択した構造が Structure ペインに表示され、ヒストグラム表には、最初に自動生成された構
造のすぐ上に行が追加されます。読み込まれた構造の行の青の濃淡は、自動生成された構造
を含む行の青とは僅かに異なります。ランキングは　0 となります。

ユーザーが追加した構造は編集が可能です。構造に加えられた変更は、ユーザーが
Structure ペインからタブアウトしたときにメモリに保持されます。

表示する構造を選択する

1. ヒストグラムの青いバーをクリックします。
対応する構造が Structure ペインに表示されます。デフォルトでは，ヒストグラムの最初の構造
だけが Fragments 表に割り当てられています。

2. 異なる構造の Fragments 表を割り当てるには、ヒストグラムの青いバーをクリックし、Assign
をクリックします。

構造の削除

1. ヒストグラムの青いバーをクリックします。
対応する構造が Structure ペインに表示されます。

2. Structure ペインで Delete をクリックします。
Structure ペインから構造が削除され、選択した青い線がヒストグラムから削除され、
Fragments 表が削除されます。ヒストグラムの次の行の構造は、Structure ペインに表示され
ます。

マルクーシュ構造の装着

フラグメント構造を割り当てた後、化学修飾の概位を示すためにマルクーシュ構造を使用します。

注: マルクーシュ構造を含む代謝物にはフラグメント構造を割り当てることができません。

1. 構造の一部を強調表示します。

2. 構造の上または下を右クリックして、Attach Markush をクリックします。

3. Single Bond または Double Bond のいずれかを選択します。
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4. Select Symbol ダイアログで、必要な記号または式を入力します。

5. OK をクリックします。

マルクーシュ構造は、構造の選択した部分と破線で結んで表示しています。

注: マルクーシュ構造が添付されている場合は、解釈データを割り当てた後に構造を変更する
ことができます。マルクーシュ構造を削除すると、いかなる変更を行っても、代謝物の解釈デー
タがすべて削除されます。

ピークラベルの概要

ピークには次のようなラベルを付けることができます。

• イオン式またはイオンタイプ（ペプチドの場合）

• イオン式またはイオンタイプ（ペプチドの場合）と ppm の誤差

• イオン式またはイオンタイプ（ペプチドの場合）と mDa の誤差

MS/MS スペクトルにピークラベルを追加する

1. Interpretation ビューで Options をクリックします。
Options ダイアログが開きます。

2. Label peaks with フィールドでラベルの種類を選択します。

3. OK をクリックします。

4. Fragments 表で、ラベル付けするピークを含む行を選択します。

5.  をクリックします。

ヒント! MS/MS スペクトルからすべてのラベルを削除するには、  をクリックします。

低分子用 Interpretation Filters の概要

フィルターを適用して、Fragments 表に表示されるデータを絞り込みます。Interpretation Filters ダ

イアログを開くには、Fragments 表の  アイコンをクリックします。

フィルター 説明

Rings and Double Bonds

RDB • Integer value (even-electron): 環と二重結合の値が整数であ
るフラグメントのみを表示します。

• Non-integer value (odd-electron): 環と二重結合の値が非整
数であるフラグメントのみを表示します。

Mass Range

m/z from __ to __ m/z 値が指定範囲内にあるフラグメントのみを表示します。

Mass Accuracy
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フィルター 説明

Accuracy within 質量真度が指定範囲内にあるフラグメントのみを表示します。

注: 質量真度を mDa と　ppm のどちらで測定するかは、Options
ダイアログで選択したものに依存します。

Intensity

Intensity above __ cps 指定した値を超える強度値があるフラグメントのみを表示します。

Score

Score above 指定した値を超えるスコアのフラグメントのみを表示します。

Structures

Fragments with
assigned structures

構造に関連付けられているフラグメントのみを表示します。

ペプチドワークフロー

配列の読み込み

配列の編集

オプションの設定

フラグメント配列の割り当て

ピークラベルの概要 MS/MS スペクトルにピークラベルを追加す
る

ペプチド用の Interpretation フィルターの
概要

配列の読み込み

1. Workspace パネルで Results をクリックします。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. Results ファイルに移動し、選択します。

4. OK をクリックします。

5. Show フィールドで Interpretation を選択します。

6. Potential Metabolites 表の行を選択します。

7. 次のいずれかの操作を行います。

• Sequence ペインが空白の場合は、Load Parent をクリックします。

• Sequence ペインに既に配列が存在し、新たに配列を追加する必要がある場合は、Enter
Sequence をクリックしてペインをクリアし、Load Parent をクリックします。
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親配列が Sequence ペインに表示されます。ペインの上に AA Index: [ ], Mono. Mass: [ ],
m/z: [ ], Composition: [ ] というラベルが追加されます。ここで

• AA Index: （アミノ酸インデックス）アミノ酸インデックスは、親配列におけるその配列の最初
と最後の残基の位置を示します。異性体配列が親配列のサブセットでない場合、AA Index
は表示されません。

• Mono. Mass: 中性成分のモノアイソトピック質量。

• m/z: 質量電荷比の値。電荷は括弧内に表示されます。

• Composition: 配列の非荷電元素組成。

8. 変更が必要な場合は、配列を編集します。配列の編集を参照してください。

配列の編集

特定の代謝物の配列を作成した後、または読み込んだ後、その配列を編集できます。

1. 変更が必要な配列をクリックします。

2. 必要な変更を加えます。ペプチド配列の命名規則を参照してください。

オプションの設定

1. Interpretation ビューで Options をクリックします。
Options ダイアログが開きます。

2. フラグメンテーションとラベリングのパラメータを変更します。表 8-16 を参照してください。

表 8-16 : Options ダイアログ

オプション 説明

Minimum signal-to-
noise ratio

このフィールドを使用して、フラグメントピークを割り当てるために使用す
るしきい値を指定します。このしきい値未満のピークは割り当てられませ
ん。ノイズは、MS/MS スペクトルにおいて最も強度の小さいピークと定
義されます。

MS/MS m/z
tolerance (ppm or
mDa)

このフィールドを使用して、MS/MS m/z 許容値を指定します。フラグメン
トピークにイオンタイプや配列を割り当てるには、質量精度が指定した
MS/MS m/z 許容値内である必要があります。

Fragmentation Settings

Fragment Types 適切なフラグメントの種類を選択します。複数の種類を選択できます。オ
プションは次のとおりです。

• a

• b

• y
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表 8-16 : Options ダイアログ (続き)

オプション 説明

Maximum number
of bonds to break

このフィールドを使用して、切断する結合の最大数を指定します。オプシ
ョンは次のとおりです。

• 1

• 2

• 3

ヒント! より複雑なペプチドの場合、切断する結合の最大数に 3 を選択
した場合、必要な処理時間が増加します。

Break linkages ペプチド配列に結合がある場合、このチェックボックスをオンにすると、
個々のアミノ酸間の結合を切断できます。

Label Settings

Label peaks with このフィールドを使用して、ピークラベルに表示する情報を指定します。
オプションは次のとおりです。

• Ion

• Ion with ppm Error

• Ion with mDa Error

• Ion with Charge

Apply options to all
potential
metabolites

このチェックボックスをオンにすると、現在のオプションが未割り当ての
すべての代謝物に適用されます。

フラグメント配列の割り当て

注: フラグメンテーションルールはソフトウェアに組み込まれており、編集できません。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Show フィールドで Interpretation を選択します。

6. 配列を読み込みます。配列の読み込みを参照してください。

7. Sequence ペインで Assign をクリックします。
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Fragments 表には、選択したオプションを使用して、読み込んだ配列の解釈結果が入力されま
す。オプションの設定を参照してください。Fragments 表で一致したイオンを示す緑色の縦線
が、MS/MS ペインに追加されます。表の上のラベルは、更新されて以下のことを示します。

• Assigned: x of y peaks。割り当てられているピークの数を示します。

• MSMS Peak Area Assigned: x%。MS/MS ピーク領域のうち、割り当てられている割合
を示します。

• Sequence Coverage: x of y consecutive amino acids。配列がカバーする連続したア
ミノ酸の数を示します。

Sequence Candidates タブの概要

配列の自動生成機能を使用すると、Sequence charts ペインの Sequence Candidates タブに、
Options ダイアログで設定した条件を満たす、選択した異性体または代謝物の配列リストが表示さ
れます。バッチ処理オプションを参照してください。ソフトウェアは、以下の種類の代謝物または異性
体の配列を生成します。

• n 箇所の開裂: 開裂に最大 4 つの修飾が可能

• 親: ここで n は任意の数の開裂を指します

配列のリスト（ヒストグラムと呼ばれる）には、次のような列の情報が含まれています。

列 説明

Rank 指定した代謝物について見つかったすべての異性体配列の相対的ランキン
グを示します。ランクは、割り当てられた MS/MS ピーク領域に基づいていま
す。

View sequence
fragments

パーセンテージの値は、提案された配列のスコアリングを示します。

また、この欄で配列の切り替えが可能です。配列の切り換えを参照してくださ
い。

AA Index アミノ酸配列の始点と終点を示します。

Apply to
Results

チェックボックスがオンの場合は、対応する配列が Results ファイルに保存さ
れます。

ヒストグラム表の上、Apply to Results 列の真上に候補の総数が表示されます。

自動生成された配列は編集できません。配列を読み込み、必要な修飾を加えた後、Apply to
Results チェックボックスをオンにすると、その配列が Results ファイルに含まれます。配列の読み
込みおよび配列の編集のステップ 7 を参照してください。

ピークラベルの概要

ピークには次のようなラベルを付けることができます。

• イオン式またはイオンタイプ（ペプチドの場合）

• イオン式またはイオンタイプ（ペプチドの場合）と ppm の誤差
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• イオン式またはイオンタイプ（ペプチドの場合）と mDa の誤差

• イオン式またはイオンタイプ（ペプチドの場合）と電荷

MS/MS スペクトルにピークラベルを追加する

1. Interpretation ビューで Options をクリックします。
Options ダイアログが開きます。

2. Label peaks with フィールドでラベルの種類を選択します。

3. OK をクリックします。

4. 次のいずれかの操作を行います。

表 8-17 : ピークラベルの追加

1 つのピークにラベルを付ける場合 すべてのピークにラベルを付ける場合

Fragments 表で、ラベル付けするピークを含む
行を選択します。

 をクリックします。

 をクリックします。 —

ヒント! MS/MS スペクトルからすべてのラベルを削除するには、  をクリックします。

ペプチド用の Interpretation フィルターの概要

フィルターを適用して、Fragments 表に表示されるデータを絞り込みます。Interpretation Filters ダ

イアログを開くには、Fragments 表の  アイコンをクリックします。

フィルター 説明

Mass Range

m/z from __ to __ m/z 値が指定範囲内にあるフラグメントのみを表示します。

Charge Range

Charge from __ to __ 選択した範囲内に電荷があるフラグメントのみを表示します。オプシ
ョンは次のとおりです。

• From range: 1 ～ 10（10 を含む）

• To range: 1 ～ 10（10 を含む）

注: 範囲の上限値は下限値以上である必要があります。

Ion Type
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フィルター 説明

Fragment type 適切なフラグメントの種類を選択します。複数の種類を選択できま
す。これらのオプションが利用できます。

• a

• b

• y

Mass Accuracy

Accuracy within 質量真度が指定範囲内にあるフラグメントのみを表示します。

注: 質量真度を mDa と　ppm のどちらで測定するかは、Options
ダイアログで選択したものに依存します。

Intensity

Intensity above __ cps 指定した値を超える強度値があるフラグメントのみを表示します。

オリゴヌクレオチドワークフロー

配列の読み込み

配列の編集

オプションの設定

フラグメント配列の割り当て

ピークラベルの概要 MS/MS スペクトルにピークラベルを追加す
る

オリゴヌクレオチド用の Interpretation フィ
ルターの概要

配列の読み込み

1. Workspace パネルで Results をクリックします。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. Results ファイルに移動し、選択します。

4. OK をクリックします。

5. Show フィールドで Interpretation を選択します。

6. Potential Metabolites 表の行を選択します。

7. Sequence ペインが空白の場合は、次のいずれかを行います。

• Load Parent をクリックします。

• 配列をペインに入力または貼り付けます。
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ペインの上に Mono. Mass: [ ], m/z: [ ], Composition: [ ] というラベルが追加されます。こ
こで

• Mono. Mass: 中性成分のモノアイソトピック質量。

• m/z: 質量電荷比の値。電荷は括弧内に表示されます。

• Composition: 配列の非荷電元素組成。

8. 変更が必要な場合は、配列を編集します。配列の編集を参照してください。

配列の編集

特定の代謝物の配列を作成した後、または読み込んだ後、その配列を編集できます。

1. 変更が必要な配列をクリックします。

2. 必要な変更を加えます。オリゴヌクレオチド配列の命名規則を参照してください。

オプションの設定

1. Interpretation ビューで Options をクリックします。
Options ダイアログが開きます。

2. フラグメンテーションとラベリングのパラメータを変更します。表 8-18 を参照してください。

表 8-18 : Options ダイアログ

オプション 説明

Minimum signal-to-
noise ratio

このフィールドを使用して、フラグメントピークを割り当てるために使用す
るしきい値を指定します。このしきい値未満のピークは割り当てられませ
ん。ノイズは、MS/MS スペクトルにおいて最も強度の小さいピークと定
義されます。

MS/MS m/z
tolerance (ppm or
mDa)

このフィールドを使用して、MS/MS m/z 許容値を指定します。フラグメン
トピークにイオンタイプや配列を割り当てるには、質量精度が指定した
MS/MS m/z 許容値内である必要があります。

Fragmentation Settings

MS/MS データの特性評価

ソフトウェアユーザーガイド
RUO-IDV-05-12707-JA-A

Molecule Profiler ソフトウェア
99/136



表 8-18 : Options ダイアログ (続き)

オプション 説明

Fragment Types 適切なフラグメントの種類を選択します。複数の種類を選択できます。オ
プションは次のとおりです。

• a

• b

• c

• d

• y

• Other

• wb-H20

• x

• y

カスタムオリゴヌクレオチドの例を参照してください。

Maximum number
of bonds to break

このフィールドを使用して、切断する結合の最大数を指定します。オプシ
ョンは次のとおりです。

• 1

• 2

値は 2 を推奨します。

ヒント! より複雑なオリゴヌクレオチドの場合、切断する結合の最大数に
3 を選択した場合、必要な処理時間が増加します。

Maximum water and
Base losses

フラグメンテーション時に発生しうる最大の水分損失を指定します。値は
1 を推奨します。

Label Settings

Label peaks with このフィールドを使用して、ピークラベルに表示する情報を指定します。
オプションは次のとおりです。

• Ion

• Ion with ppm Error

• Ion with mDa Error

• Ion with Charge

Apply options to all
potential
metabolites

このチェックボックスをオンにすると、現在のオプションが未割り当ての
すべての代謝物に適用されます。
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フラグメント配列の割り当て

注: フラグメンテーションルールはソフトウェアに組み込まれており、編集できません。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Show フィールドで Interpretation を選択します。

6. 配列を読み込みます。配列の読み込みを参照してください。

7. Sequence ペインで Assign をクリックします。
Fragments 表には、選択したオプションを使用して、読み込んだ配列の解釈結果が入力されま
す。オプションの設定を参照してください。Fragments 表で一致したイオンを示すシアンの縦線
が、MS/MS ペインに追加されます。表の上のラベルは、更新されて以下のことを示します。

• Assigned: x of y peaks。割り当てられているピークの数を示します。

• MSMS Peak Area Assigned: x%。MS/MS ピーク領域のうち、割り当てられている割合
を示します。

• Sequence Coverage: x of y consecutive nucleotides。配列がカバーする連続したヌ
クレオチドの数を示します。

ピークラベルの概要

ピークには次のようなラベルを付けることができます。

• イオン式またはイオンタイプ（オリゴヌクレオチドの場合）

• イオン式またはイオンタイプ（オリゴヌクレオチド場合）と ppm の誤差

• イオン式またはイオンタイプ（オリゴヌクレオチド場合）と mDa の誤差

• イオン式またはイオンタイプ（オリゴヌクレオチドの場合）と電荷

MS/MS スペクトルにピークラベルを追加する

1. Interpretation ビューで Options をクリックします。
Options ダイアログが開きます。

2. Label peaks with フィールドでラベルの種類を選択します。

3. OK をクリックします。

4. 次のいずれかの操作を行います。
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表 8-19 : ピークラベルの追加

1 つのピークにラベルを付ける場合 すべてのピークにラベルを付ける場合

Fragments 表で、ラベル付けするピークを含む
行を選択します。

 をクリックします。

 をクリックします。 —

ヒント! MS/MS スペクトルからすべてのラベルを削除するには、  をクリックします。

オリゴヌクレオチド用の Interpretation フィルターの概要

フィルターを適用して、Fragments 表に表示されるデータを絞り込みます。Interpretation Filters ダ

イアログを開くには、Fragments 表の  アイコンをクリックします。

フィルター 説明

Mass Range

m/z from __ to __ m/z 値が指定範囲内にあるフラグメントのみを表示します。

Charge Range

Charge from __ to __ 選択した値を超える電荷があるフラグメントのみを表示します。有効
な値は 1 から 10 までです。

Ion Type

Fragment type 適切なフラグメントの種類を選択します。複数の種類を選択できま
す。これらのオプションが利用できます。

• a

• b

• c

• d

• w

• wb-H20

• x

• y

• Other

• Base loss

• Water loss

• Internals
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フィルター 説明

Mass Accuracy

Accuracy within 質量真度が指定範囲内にあるフラグメントのみを表示します。

注: 質量真度を mDa と　ppm のどちらで測定するかは、Options
ダイアログで選択したものに依存します。

Intensity

Intensity above __ cps 指定した値を超える強度値があるフラグメントのみを表示します。

抗体薬物複合体ワークフロー

構造の読み込み

構造の編集

配列の読み込み

配列の編集

オプションの設定

構造と配列の両方に対応したフラグメントイ
オンの割り当て

ピークラベルの概要 MS/MS スペクトルにピークラベルを追加す
る

抗体薬物複合体用の Interpretation フィル
ターの概要

構造の読み込み

代謝物の構造解析を開始する前に、構造を読み込むことで、ソフトウェアはフラグメント構造の候補
を決定できます。

注: 構造が読み込まれていない場合でも、式の候補をフラグメントに割り当てることができます。

1. Workspace パネルで Results をクリックします。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. Results ファイルに移動し、選択します。

4. OK をクリックします。

5. Show フィールドで Interpretation を選択します。

6. Potential Metabolites 表の行を選択します。

7. Structure ペインで Load をクリックし、Load Parent Structure オプションを選択します。
選択した代謝物の親配列がペインに表示されます。添付ファイルのマークされた部位（埋め込
み処理パラメータファイルで見た場合）または原子が紫色で表示されます。
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8. 細かい変更が必要な場合は、構造を編集します。構造の編集を参照してください。

構造の編集

特定の代謝物の構造を読み込んだ後、編集ツールで細かい変更を加えます。

ヒント! 編集ツールを使って代謝変換の付着点を変えるなど、構造に細かい変更を加えることができ
ます。編集ツールは、新しい構造を作成したり、既存の構造に大きな変更を加えたりするために使
用しないでください。

表 8-20 : 構造の編集

目的の作業 実行する操作

構造に原子を追加する パレット上の特定の記号を新しい位置にドラッグします。
追加した原子は、最も近い既存の原子と単結合を形成し
ます。

パレット上に新しい原子を作成する 空白の四角をクリックし、Specify Symbol ダイアログに記
号を入力し、OK をクリックします。

ヒント! 追加した四角をクリックし、新しい記号を入力する
と、異なる原子を作成できます。

構造の一部を強調表示する 必要な原子と結合の周りをドラッグして円を描きます。

1 つ以上の原子を移動する 構造のハイライト部分を新しい位置までドラッグします。そ
の部分が他の 1 つの原子に結合していれば、結合は新し
い位置に移動します。その部分が 2 つ以上の原子に結合
している場合、その部分は移動しますが、既存の結合は
変わりません。

既存の構造に構造を挿入する 構造を右クリックし、次のいずれかをクリックします。

• 別の構造を追加するには Insert .mol File をクリック
します。

• 特定の結合構造を追加するには Insert Conjugate
をクリックします。

1 つ以上の原子を削除する 構造のハイライト部分を右クリックし、Remove Selected
Atoms をクリックします。

結合の作成 結合していない 2 つの原子を選択し、選択したものを右ク
リックして New Bond をクリックし、結合の種類を選択し
ます。

結合の編集 結合を右クリックし、Set Bond Type をクリックして、結合
の種類を選択します。

結合の削除 結合を右クリックし、Remove Bond をクリックします。
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表 8-20 : 構造の編集 (続き)

目的の作業 実行する操作

既存の原子の電荷状態を変更する 原子を右クリックし、Atom Charge State をクリックして、
状態を選択します。

ヒント! 編集した構造を別ファイルとして保存する場合は、Save As をクリックします。

ヒント! 構造は mol ファイルまたは sdf ファイルとして保存できます。Save As ダイアログに適切な
拡張子を入力します。

配列の読み込み

1. Workspace パネルで Results をクリックします。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. ペプチドの Results ファイルに移動し、選択します。

4. OK をクリックします。

5. Show フィールドで Interpretation を選択します。

6. Potential Metabolites 表の行を選択します。

7. Structure ペインで Load をクリックし、Load Sequence オプションを選択します。
選択した代謝物の親配列が Sequence ペインに表示されます。

8. 結合する残基を選択し、右クリックし、Mark Residue to Conjugate を選択します。
選択した残基は紫色で表示されます。

9. 変更が必要な場合は、配列を編集します。配列の編集を参照してください。

配列の編集

特定の代謝物の配列を作成した後、または読み込んだ後、その配列を編集できます。

1. 変更が必要な配列をクリックします。

2. 必要な変更を加えます。ペプチド配列の命名規則を参照してください。

オプションの設定

1. Interpretation ビューで Options をクリックします。
Options ダイアログが開きます。

2. フラグメンテーションとラベリングのパラメータを表 8-21 のように変更します。
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表 8-21 : Options ダイアログ

オプション 説明

Number of fragment
peaks selected for
structure
assignment

このフィールドを使用して、抗体薬物複合体の構造部分に割り当てるフ
ラグメントピークの数を指定します。全ピーク数のサブセットであれば、ピ
ークは強度の高い順に選択されます。

Minimum signal-to-
noise ratio

このフィールドを使用して、フラグメントピークを割り当てるために使用す
るしきい値を指定します。このしきい値未満のピークは割り当てられませ
ん。

MS/MS m/z
tolerance (ppm or
mDa)

このフィールドを使用して、MS/MS m/z 許容値を ppm または mDa で
指定します。フラグメントピークに式や構造を割り当てるには、その質量
精度が指定した MS/MS m/z 許容値内である必要があります。

Structure Fragmentation Settings

Break aromatic
rings

芳香環を切断する場合は、このチェックボックスをオンにします。

Maximum number
of bonds to break

このフィールドを使用して、切断する結合の最大数を指定します。オプシ
ョンは次のとおりです。

• 1

• 2

• 3

• 4

Maximum number
of C-C bonds to
break

このフィールドを使用して、切断する C-C 結合の最大数を指定します。
オプションは次のとおりです。

• 0

• 1

• 2

• 3

• 4

Sequence Fragmentation Settings

Fragment Types 適切なフラグメントの種類を選択します。複数の種類を選択できます。オ
プションは次のとおりです。

• a

• b

• y
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表 8-21 : Options ダイアログ (続き)

オプション 説明

Maximum number
of bonds to break

このフィールドを使用して、切断する結合の最大数を指定します。オプシ
ョンは次のとおりです。

• 1

• 2

• 3

注: より複雑なペプチドの場合、切断する結合の最大数に 3 を選択した
場合、必要な処理時間が増加します。

Break linkages ペプチド配列に結合がある場合、このチェックボックスをオンにすると、
個々のアミノ酸間の結合を切断できます。

Label Settings

Label peaks with このフィールドを使用して、ピークラベルに表示する情報を指定します。
オプションは次のとおりです。

• Ion

• Ion with ppm Error

• Ion with mDa Error

• Ion with Charge

Apply options to all
potential
metabolites

このチェックボックスをオンにすると、現在のオプションが未割り当ての
すべての代謝物に適用されます。

構造と配列の両方に対応したフラグメントイオンの割り当て

注: フラグメンテーションルールはソフトウェアに組み込まれており、編集できません。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Show フィールドで Interpretation を選択します。

6. 構造、配列を読み込みます。構造の読み込みおよび配列の読み込みを参照してください。
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注: 構造または配列のどちらか一方のみを読み込む必要があります。この手順は、両方が読
み込み済みであることを前提に書かれています。

7. Structure ペインで Assign をクリックします。

TOF MS/MS スペクトルの下の Structure ビューと Sequence ビューの両方が入力され、デフ
ォルトで Structure ビューが表示されます。

注: 親構造のみが読み込まれた場合は、Fragments 表の Structures ビューが表示されます。
親配列のみが読み込まれた場合は、Fragments 表の Sequences ビューが表示されます。

Structure ビューでは、Fragments 表には識別されたフラグメントが、Structure Details 表には
構造候補が、Contained Neutral Losses 表には含有ニュートラル損失が入力されます。結果
は、選択したオプションに基づいています。オプションの設定を参照してください。Fragments
表で一致したイオンを示す水色の縦線が、MS/MS ペインに追加されます。

注: 構造に解釈結果がない場合は、Fragments 表に No structures assigned と表示

されます。

Fragments 表の上のラベルは、以下のことを示します。

• b ピークの Assigned: a（Structure: x、Sequence: y）。ここで a は x と y の和で、割り当
てられたピークの数、b はピークの総数、x は Structures ビューの行数、y は Sequences
ビューの行数を示します。

• MSMS Peak Area Assigned: w%。ここで w は、スペクトルデータから割り当てられたピ
ーク領域のパーセンテージを示します。

Fragments 表には Use as Conjugate 列があります。この列には、表の各行に対応するチェ
ックマークが含あります。チェックボックスをオンにできる場合は、フラグメントの提案された構
造上に付着部位が存在します。チェックボックスをオンにできない場合は、付着部位が存在し
ません。チェックボックスをオンにした場合、そのフラグメントは配列との結合に使用されます。
チェックボックスをオンにしていない場合、そのフラグメントは使用されません。デフォルトでは、
真度と量に基づいて、付着部位を含むフラグメントが最大 3 つまで選択されるようにしました。
デフォルトでは、表の最初の行が選択されます。

8. Structures ビューが選択されていることを確認します。

9. 必要に応じて、Fragments、Structure Details、Contained Neutral Losses の各表を右クリッ
クし、Show Hidden Rows をクリックします。

注: Fragments 表では、m/z 値のスコアが最も高い行の Use チェックボックスがオンになって
います。Structure Details 表では、スコアが最も高い行の Use チェックボックスがオンになっ
ています。Contained Neutral Losses 表では、すべての行で Use チェックボックスがオンにな
っています。

10. Fragments 表で、Use チェックボックスをオンにすると、各 m/z 値に対して最も正確な式を含
む行を特定できます。

ヒント! 複数の行で Use チェックボックスをオンにすると、各フラグメントに対して複数の候補式
を選択できます。
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割り当てられた m/z 値は、太字の斜体で表示されます。

11. Structure Details 表で Use チェックボックスをオンにすると、選択した式に最も正確に一致す
る部分を特定できます。

12. Contained Neutral Losses 表で Use チェックボックスをオンにすると、含まれているニュートラ
ルロスを最も正確に反映する行を特定できます。

ヒント! Structure Details 表と Contained Neutral Losses 表で、特定のフラグメントに対して
複数の行で Use チェックボックスをオンにします。

13. Sequences ビューを選択します。

Sequence ビューでは、選択したオプション（オプションの設定を参照）、Structures ビューで選
択した結合、Compound-Specific Parameters の Product Ions and Neutral Losses タブ
（Product Ions and Neutral Losses タブを参照）で選択した内容、および配列に基づいて、解
釈の結果が Fragments 表に入力されます。Fragments 表で一致したイオンを示す緑色の縦
線が、MS/MS ペインに追加されます。

注: 配列に解釈結果がない場合は、Fragments 表に No sequences assigned と表示さ

れます。

表の上のラベルは、以下のことを示します。

• Assigned: b ピークの a（Structure: x、Sequence: y）。ここで a は x と y の和で、割り当て
られたピークの数、b はピークの総数、x は Structures タブの行数、y は Sequences タ
ブの行数を示します。

• MSMS Peak Area Assigned: w%。ここで w は、スペクトルデータから割り当てられたピ
ーク領域のパーセンテージを示します。

14. 必要に応じて、Fragments 表を右クリックし、Show Hidden Rows をクリックします。

注: Fragments 表では、m/z 値のスコアが最も高い行の Use チェックボックスがオンになって
います。

15. Fragments 表で、Use チェックボックスをオンにすると、各 m/z 値に対して最も正確な式を含
む行を特定できます。

ヒント! 複数の行で Use チェックボックスをオンにすると、各フラグメントに対して複数の候補式
を選択できます。

割り当てられた m/z 値は、太字の斜体で表示されます。

16. すべての変更が完了したら、Apply をクリックします。
選択した代謝物の解釈データが保存されます。

17. Save をクリックします。

ヒント! 特定の代謝物の解釈データをすべて削除する場合は、Remove をクリックします。

ピークラベルの概要

ピークには次のようなラベルを付けることができます。
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• イオン式またはイオンタイプ（ペプチドの場合）

• イオン式またはイオンタイプ（ペプチドの場合）と ppm の誤差

• イオン式またはイオンタイプ（ペプチドの場合）と mDa の誤差

• イオン式またはイオンタイプ（ペプチドの場合）と電荷

MS/MS スペクトルにピークラベルを追加する

1. Interpretation ビューで Options をクリックします。
Options ダイアログが開きます。

2. Label peaks with フィールドでラベルの種類を選択します。

3. OK をクリックします。

4. 次のいずれかの操作を行います。

表 8-22 : ピークラベルの追加

1 つのピークにラベルを付ける場合 すべてのピークにラベルを付ける場合

Fragments 表で、ラベル付けするピークを含む
行を選択します。

 をクリックします。

 をクリックします。 —

ヒント! MS/MS スペクトルからすべてのラベルを削除するには、  をクリックします。

抗体薬物複合体用の Interpretation フィルターの概要

フィルターを適用して、Fragments 表に表示されるデータを絞り込みます。Interpretation Filters ダ

イアログを開くには、Fragments 表の  アイコンをクリックします。

フィルター 説明

Rings and Double Bonds

RDB • Integer value (even-electron): 環と二重結合の値が整数であ
るフラグメントのみを表示します。

• Non-integer value (odd-electron): 環と二重結合の値が非整
数であるフラグメントのみを表示します。

Mass Range

m/z from __ to __ m/z 値が指定範囲内にあるフラグメントのみを表示します。

Charge Range
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フィルター 説明

Charge from __ to __ 選択した範囲内に電荷があるフラグメントのみを表示します。オプシ
ョンは次のとおりです。

• From range: 1 ～ 10（10 を含む）

• To range: 1 ～ 10（10 を含む）

注: 範囲の上限値は下限値以上である必要があります。

Ion Type

Fragment type 適切なフラグメントの種類を選択します。複数の種類を選択できま
す。オプションは次のとおりです。

• a

• b

• y

Mass Accuracy

Accuracy within 質量真度が指定範囲内にあるフラグメントのみを表示します。

注: 質量真度を mDa と　ppm のどちらで測定するかは、Options
ダイアログで選択したものに依存します。

Intensity

Intensity above __ cps 指定した値を超える強度値があるフラグメントのみを表示します。

Score

Score above 指定した値を超えるスコアのフラグメントのみを表示します。

Structures

Fragments with
assigned structures

構造に関連付けられているフラグメントのみを表示します。

自動解釈

自動解釈

低分子ワークフロー ペプチドワークフロー

低分子ワークフロー

構造の自動生成は、以下の方法で開始できます。
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• Batch ワークスペースで Apply Options チェックボックスをオンにすると、Batch Processing
Options ダイアログで選択した Auto Assign オプションがすべてバッチ内のサンプルと対照サン
プルに適用されます。最低でも、Assign Structures または Sequences オプションを選択する必
要があります。バッチ処理オプションを参照してください。

• Results ワークスペースの Interpretation ビューで、MS/MS ペインの Generate をクリックしま
す。

ペプチドワークフロー

配列の自動生成は、以下の方法で開始できます。

• Batch ワークスペースで Options チェックボックスをオンにすると、Batch Processing Options
ダイアログで選択した Auto Assign オプションがすべてバッチ内のサンプルと対照サンプルに
適用されます。最低でも、Assign Structures or Sequences オプションを選択する必要があり
ます。バッチ処理オプションを参照してください。

• Results ワークスペースの Interpretation ビューで、MS/MS ペインの Generate をクリックしま
す。

配列の切り換え

ヒストグラムの青いバーをクリックします。
対応する配列が Sequence ペインに表示され、Fragments 表が、選択した配列に関連する情報で
更新されます。Sequence ペインの上にあるラベルが更新され、配列番号と割り当てランクが表示
されます。例: y の配列 x、ランク ＝ z。

空のペインを選択する

ヒストグラムの 1 行目をクリックします。
ヒストグラムの 1 行目には、No sequence の語句が含まれています。Sequence ペインがクリア

され、Fragments 表が更新されて、No sequences assigned の語句が表示されます。

配列の追加

注: 自動生成される配列のリストに追加できる配列は 1 つだけです。配列を追加した場合、ユーザ
ーが追加した前の配列は上書きされます。

1. Sequence ペインで Enter Sequence をクリックします。
Sequence ペインがクリアされ、Fragments 表が更新されて、No sequence assigned の
語句が表示されます。

2. Load Parent をクリックします。
親配列は、Sequence ペインに、および Sequence charts ペインの Parent Sequence タブ
に表示されます。

3. Tab を押して親配列を検証します。

配列には有効であることを示すアンダーラインが追加されます。Sequence Candidates タブに
新しいヒストグラムが作成され、最初に自動生成された配列のすぐ上の行に、ユーザーが追加
した配列が表示されます。ユーザーが追加した配列のランキングは 0 となります。青いバーが
表の幅全体に広がります。ただし、バーにパーセンテージは表示されません。読み込まれた配
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列の行の青の濃淡は、自動生成された配列を含む行の青とは僅かに異なります。提案される
配列の数が 1 つ増えます。

ユーザーが追加した配列は編集が可能です。配列に加えられた変更は、ユーザーが
Sequence ペインからタブアウトしたときにメモリに保持されます。

表示する配列を選択する

ヒストグラムの青いバーをクリックします。
対応する配列が Sequence ペインに表示されます。選択した配列に関連する情報で Fragments
表が更新されます。Sequence ペインの上にあるラベルが更新され、配列番号と割り当てランクが
表示されます。例: y の配列 x、ランク ＝ z。

配列の削除

1. ヒストグラムの青いバーをクリックします。
対応する配列が Sequence ペインに表示されます。

2. Sequence ペインで Delete をクリックします。
配列が Sequence ペインから、行がヒストグラムから削除されます。ヒストグラムの次の行の
配列が Sequence ペインに表示され、Fragments 表が、選択した配列に関連する情報で更新
されます。
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結果の相関性 9
対象となる複数のサンプルから代謝物の候補が検出されると、各サンプルの結果を比較できます。
これにより、複数の Results ファイルから生成された代謝物候補の相違点や類似点を確認できま
す。異なる Results ファイルからの代謝物は、Correlate Results ダイアログで設定した質量電荷比
と保持時間の許容値に一致すれば、同一であるとみなされます。

オリゴヌクレオチドワークフローでは、同じ中性質量で保持時間の許容範囲内にある多価の代謝物
を、Correlation ワークスペースの 1 つのエントリでグループ化することができます。この機能を「グ
ループ化」と言います。この機能を有効にするには、結果の相関をとる際に Group results by
analyte を選択します。この機能を有効にすると、多価荷電種がマージされ、Results ファイル間の
比較が容易になります。

注: Results ファイルを関連付ける前に、グループ機能を有効にします。

相関の準備
1. File > New > Correlation をクリックします。

Correlate Results ダイアログが開きます。

2. Add Results をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

注: 選択したファイルには、異なる化合物が含まれている場合があります。相関をとるためにア
ナログデータは必要ありません。

4. X-axis title と X-axis units のフィールドを完成させます。
これにより、Correlation ワークスペースのグラフの X 軸にラベルが割り当てられます。

5. X　軸のラベルに対応するフィールドで、各　Results　ファイルの横に一意の値を入力します。
たとえば、ステップ 4 で割り当てたラベルが Time の場合は、Time フィールドに各 Result ファ
イルの時間を入力します。

6. 必要に応じて、Include RRF in % area determination を選択します。

注: Include RRF in % area determination と Group results by analyte の両方を選択し
ないでください。

このオプションを選択した場合、MS 領域に 相対感度係数 が乗算されます。領域の変化は、
Correlations Details ペインの折れ線グラフ、棒グラフ、表に表示されます。この変化は、
Potential Metabolites 表には表示されません。

7. （オリゴヌクレオチドワークフロー）必要に応じて、中性質量に基づいてピークをグループ化する
Group results by analyte を選択します。

8. 相関をカスタマイズします。相関のカスタマイズを参照してください。

9. Correlation file name フィールドにファイル名を入力します。
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注: ファイル名にはスペースを含めないでください。

10. 相関ファイルを保存する場所を選択するには、Browse をクリックし、適切なフォルダーを選択
します。

11. OK をクリックします。
ソフトウェアは、選択したファイルに見つかった代謝物を比較し、Correlation ワークスペースに
結果を表示します。

ヒント! 同じ相関に異なる設定を使用して処理することも可能です。Correlation ワークスペース
で、Correlate Results をクリックします。

相関のカスタマイズ
相関させるファイルを選択した後、Correlation Results ダイアログでパラメータの値を編集して、結
果を改善することができます。

ピークアライメントの改善

個々の Result ファイルの保持時間をシフトすることで、選択したファイルの相関を改善できます。

1. 結果の相関をとる前に、次のようにします。

a. Results ワークスペースで該当する各 Results ファイルを開きます。

b. すべてのファイルに表示されている特定の代謝物の保持時間を確認します。

2. Results ファイルに表示されているシフトに基づいて、Correlate Results ダイアログで、特定の
ファイルの横の R.T. Shift (min) フィールドに値を入力します。

注: R.T. Shift (min) フィールドには、-2.00 分から 2.00 分までの値を指定できます。

ピークマージングの定義

特定の許容値を設定すれば、近い値を持つピークを同じピークとみなすことができます。

1. Results ワークスペースの各 Results ファイルを開きます。

2. すべてのファイルに表示されている特定の代謝物の保持時間と質量公差を同定します。

3. Correlate Results ダイアログの Tolerances グループで、Retention time フィールドに値を
入力します。

注: Retention time フィールドには、0.01 分から 0.25 分までの値を指定できます。

4. MS m/z フィールドに値を入力し、単位は ppm または mDa のいずれかを選択します。

注: オリゴヌクレオチドワークフローでは、Group results by analyte オプションを選択した場
合、ppm のみ利用可能です。

注: MS m/z フィールドには、0.1 から 250.0 までの値を指定できます。
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Correlation ワークスペースの概要
Correlation ワークスペースには、選択した Results ファイルで検出された代謝物候補の比較が表
示されます。

図 9-1 : Correlation ワークスペース

項目 説明

1 メニューバー。メニューバーには以下のボタンがあります。
• Correlate Results: Correlate Results ダイアログを開きます。相関の準

備を参照してください。

• Open: Open Correlation ダイアログを開き、適切な相関ファイルに移動で
きます。

• Save: 現在開いている相関ファイルを保存します。自動的に既存のバージ
ョンを置き換えます。

• Save As : 現在開いている相関ファイルを保存します。オプションで、保存
先フォルダーを選択し、相関ファイルに新しい名前を割り当てることができ
ます。
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項目 説明

2 Potential Metabolites ペイン。設定済みの許容値に基づき、相関のあるすべ
てのピークをリストアップします。各行には、Results ファイルから相関のある
代謝物の候補、MS Area および Analog Area（該当する場合）をリストアッ
プしています。空の MS Area セルは、特定の Results ファイルにその代謝物
が見つからなかったことを示します。空の Analog Area セルは、Results ファ
イルで代謝物が見つからなかったか、アナログ応答がゼロであったことを示し
ます。

このペインには以下のボタンがあります。

• Select values to filter peaks from the results. （ ）: Correlation
Filters ダイアログを開き、条件に合わない情報を結果から除外するための
値を設定できます。相関フィルターの概要を参照してください。

• Assign ID: Potential Metabolites 表の各ピークに、保持時間と m/z 値に
基づいて一意の識別子を割り当てます。

3 Correlation Details ペイン。相関代謝物を比較できます。相関代謝物の比較
を参照してください。異なる代謝物や Results ファイルを選択できます。MS お
よびアナログデータは、以下のフォーマットで表示できます。

• Linear Graph または Bar Graph: 各代謝物が検出された各 Results フ
ァイルで強度を比較します。

• Table: 各代謝物が検出された Results ファイルを特定します。また、表中
にオカレンス、ピーク ID、ピーク領域を表示するかどうかをユーザーが選
択できます。

注: 相関を準備する際に相対感度係数を適用した場合、定量 MS データは折
れ線グラフと棒グラフに表示されます。

4 Chromatograms ペイン: 選択した代謝物の抽出イオンクロマトグラム（XIC）
またはアナログクロマトグラムが表示されます。クロマトグラムには、代謝物を
含む 1 つまたはすべての Results ファイルからのデータを含めることができ
ます。

5 MS ペイン: 選択した代謝物を含む 1 つまたはすべての Results ファイルか
ら、目的のサンプルの MS スペクトルを表示します。

6 MS/MS ペイン: 選択した代謝物の MS/MS スペクトルを、その代謝物を含む
1 つまたはすべての Results ファイルから表示します。

注: 相関結果がグループ化されている場合、クロマトグラム、MS、および MS/MS のスペクトルは表
示されません。

相関代謝物の名前を編集する
1. Workspace パネルで Correlation をクリックします。
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Correlation ワークスペースが開きます。

2. Open をクリックします。
Open Correlation ダイアログが開きます。

3. 適切な相関ファイルに移動し、選択します。

4. Potential Metabolites 表の行を選択します。

5. Edit > Edit Name をクリックします。
Edit Name ダイアログが開きます。

6. 新しい代謝物の名前を入力します。

7. OK をクリックします。
代謝物の名前が新しい値に変わります。

相関代謝物の比較
複数の Results ファイルに含まれる代謝物を相関させた後、選択した特定の代謝物をより詳細に
比較することができます。

1. Workspace パネルで Correlation をクリックします。
Correlation ワークスペースが開きます。

2. Open をクリックします。
Open Correlation ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. Potential Metabolites 表で、比較する代謝物候補の横にある Plot チェックボックスをオンにし
ます。
代謝物は Correlation Details ペインに表示されます。

5. 特定の代謝物の相対感度係数を変更するには、RRF フィールドに値を入力します。

折れ線グラフと棒グラフでは、MS 領域とアナログ領域（該当する場合）に RRF 値が乗算され
ます。

注: このフィールドは、相関を準備する際に相対感度係数を使用した場合のみ表示されます。

6. Correlation Details ペインにアナログデータを表示するには、Analog data をクリックします。

7. 選択した代謝物を含むファイルを特定するには、Correlation Details ペインで Table を選択し
ます。

8. 正規化されたデータを表示する場合は、  をクリックします。

ヒント! 正規化したデータは、折れ線グラフ、棒グラフ、XIC、アナログクロマトグラム、MS スペ
クトル、MS/MS スペクトルで表示することが可能です。

9. 相関ファイル中の Potential Metabolites のピーク ID をリテンションタイムと m/z 値に基づい
て再割り当てする場合は、Assign ID をクリックします。
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相関フィルターの概要

フィルターを適用して、相関表に表示されるデータをさらに絞り込みます。  アイコンをクリックして
Correlation Filters ダイアログを表示するか、Setup > Filters > Correlation をクリックします。

フィルター 説明

Mass Range

m/z from __ to __ m/z 値が指定範囲内にあるピークのみを表示します。

Retention Time

R.T. from __ to __ 保持時間が指定範囲内にあるピークのみを表示します。

Occurrence

Peaks in __ or more
results files

指定した数の Results ファイルに表示されているピークのみを表示
します。

注: 最大値は、相関をとるために選択したファイル数に依存します。
たとえば、5 つの Results ファイルを選択して相関をとる場合、最大
5 つのピークを選択できます。

結果の相関性
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レポート 10
ソフトウェアでレポートを作成するには、Microsoft Word 2010 以降がコンピュータにインストールさ
れている必要があります。

Adobe PDF、Microsoft Word、HTML でのレポート作成が可能です。また、レポートを直接プリンタ
ーに送ることも可能です。

以下のレポートテンプレートが、ソフトウェアと一緒に C:\ProgramData\SCIEX\Molecule
Profiler\Report Templates フォルダーにインストールされています。

• Correlation フォルダー

• Correlation Detailed Report

• Correlation Summary Report

• Correlation Group Report

• ResultsAndInterpret フォルダー

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

• ResultsAndInterpret_ADC フォルダー

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

• ResultsAndInterpret_Peptides フォルダー

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

• ResultsAndInterpret_Oligo フォルダー

• Interpretation Detailed Report

• Interpretation Summary Report

• Results Detailed Report

• Results Summary Report

レポート
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各レポートには多くの情報を含めることができますが、レポートには、レポートが生成された時点で
報告されている Results ファイルの内容のみが表示されます。Results ファイルに特定の情報（たと
えば同位体濃縮度）が含まれていない場合、生成されるレポートにはその内容が含まれず、ほとん
どの場合、その内容のフィールドラベルや見出しも含まれません。Potential Metabolites 表または
Fragments 表に適用されたフィルターは、レポートに反映されます。たとえば、Potential
Metabolites　表をフィルタリングして 23 ピークのうち上位 5 ピークのみを表示するようにした場合、
その 5 ピークのみがレポートに含まれます。

レポートに含まれるすべてのグラフまたはスペクトルは、ユーザーインターフェースで選択したズー
ムレベルに関係なく、デフォルトのズームレベルで表示されます。すべての相関グラフは非正規化
データでレポートされています。

注: グループ化されたデータで使用するためのカスタム相関レポートのテンプレートを作成する場合
は、ファイル名に "grouped" を必ず含めてください。

Results ワークスペースでレポートを作成する
低分子、ペプチド、抗体薬物複合体の各結果についてレポートを作成できます。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. OK をクリックします。
Results ビューが表示されます。

5. Report 列で、レポートに含める各代謝物に対応したチェックボックスをオンにします。
選択しなかった代謝物は、生成されるレポートに含まれません。

6. Workflow パネルで Create Report をクリックします。
Create Report ダイアログが開きます。

7. Available templates フィールドからレポートのテンプレートを選択します。

テンプレートのリストについては、レポートを参照してください。

8. 必要なバージョンのレポートファイルを作成したり、レポートを印刷したりするには、該当する
Formats チェックボックスをオンにします。

注: 複数のフォーマットを選択できます。

9. 選択した各フォーマットバージョンについて、Browse をクリックし、Browse For Folder ダイア
ログで、レポートファイルの特定の保存場所に移動し、選択します。

10. OK をクリックします。
Browse For Folder ダイアログが閉じます。

11. 選択した各フォーマットバージョンについて、表示されるフィールドにレポートの名前を入力しま
す。
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12. （オリゴヌクレオチドワークフロー）必要に応じて、Report grouping table for Results チェッ
クボックスをオンまたはオフにします。

13. Generate Report をクリックします。

14. Print report オプションを選択していた場合は、Print ダイアログで必要な印刷オプションを選
択し、OK をクリックします。
ソフトウェアがレポートを生成します。

Correlation ワークスペースでレポートを作成する
低分子、ペプチド、抗体薬物複合体の各結果について相関レポートを作成できます。

1. Workspace パネルで Correlation をクリックします。
Correlation ワークスペースが開きます。

2. Open をクリックします。
Open Correlation ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

4. Open をクリックします。
Correlation Results ビューが表示されます。

5. 目的とする代謝物の相関の詳細をレポートに含めるには、Plot チェックボックスをオンにしま
す。

6. Workflow パネルで Create Report をクリックします。
Create Report ダイアログが開きます。

7. Available templates フィールドからレポートのテンプレートを選択します。

テンプレートのリストについては、レポートを参照してください。

注: 相関ファイルにグループ化されたデータが含まれていない場合、グループ化されていない
レポートテンプレートのみが利用可能です。相関ファイルにグループ化されたデータが含まれ
ている場合、ファイル名に "grouped" を含むレポートテンプレートのみが表示されます。

8. 必要なバージョンのレポートファイルを作成したり、レポートを印刷したりするには、該当する
Formats チェックボックスをオンにします。

注: 複数のフォーマットを選択できます。

9. 選択した各フォーマットバージョンについて、Browse をクリックし、Browse For Folder ダイア
ログで、レポートファイルの特定の保存場所に移動し、選択します。

10. OK をクリックします。
Browse For Folder ダイアログが閉じます。

11. 選択した各フォーマットバージョンについて、表示されるフィールドにレポートの名前を入力しま
す。

12. Generate Report をクリックします。

13. Print report オプションを選択している場合は、Print ダイアログで必要な印刷オプションを選
択し、OK をクリックします。
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ソフトウェアがレポートを生成します。

グラフのコピー & ペースト
グラフは、Results ワークスペースだけでなく、Compound Library ダイアログや Processing
Parameters ダイアログからもコピーできます。

1. コピーするグラフを右クリックし、Copy Selected Graph をクリックします。
グラフがクリップボードにコピーされます。

2. グラフを Microsoft Word などの他のアプリケーションに貼り付けます。

代謝物候補の表をコピー & ペーストする
1. 表を右クリックし、Results ワークスペースの Copy Table をクリックします。

表がクリップボードにコピーされます。

2. 表を Excel に貼り付けます。
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アナログ積分 11
アナログデータは、質量分析装置で検出された代謝物が偽陽性ではなく、実際の代謝物であること
を確認するために使用されます。質量分析装置でアナログインラインを使用するユーザーは、この
機能を使用して、アナログ領域の積分を最適化し、MS ピークとアナログピークの関連性をより良く
可視化することができます。

アナログデータを含む Results ファイルを開くと、Potential Metabolites 表の Analog Integration
ボタンが有効になります。

Analog Integration をクリックすると、Analog Integration ダイアログが開きます。

Results ワークスペースの元の Potential Metabolites 表が表示されます。ただし、以下の例外が
あります。

• 質量ピークを持たないアナログピークはすべて表示されますが、MS 関連の列は空です。

• アナログ対照データが存在する場合は、Analog - R.T. (min) 列の直後に Analog Signal in
Control 列が追加表示されます。アナログ対照データがない場合、この列は表示されません。

Analog Signal in Control 列には、以下の情報が表示されます。

• アナログピークのサンプル / 対照比が処理パラメータで指定された値より大きい場合、その列に
x が表示されます。

• アナログピークのサンプル / 対照比が処理パラメータで指定された値より小さい場合、その列に
チェックマークが表示されます。

アナログデータを手動で積分する

前提条件:

• 結果がアナログデータで処理されていること。

1. Workspace パネルで Results をクリックします。
Results ワークスペースが開きます。

2. Open をクリックします。
Open Results ダイアログが開きます。

3. 適切なファイルに移動し、選択します。

注: Results ファイルには、アナログクロマトグラムが含まれている必要があります。

4. OK をクリックします。
Results ビューが表示されます。Results ファイルにアナログデータが含まれている場合、
Potential Metabolites 表の Analog Integration ボタンが有効になります。Results ファイル
にアナログデータが含まれていない場合、このボタンは使用できません。

5. Analog Integration をクリックします。
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Analog Integration ダイアログが開きます。

Potential Metabolites 表に加え、2 つのクロマトグラムが表示されます。最初のクロマトグラム
である Analog Sample クロマトグラムは、一般的な処理パラメータの Chromatographic Data
タブで指定した保持時間範囲内のすべてのアナログピークを表示します。Chromatographic
Data タブを参照してください。2 つ目のクロマトグラム、MS Sample の抽出イオンクロマトグラ
ム（XIC）には、選択した行のすべてのピークが表示されます。XIC は、Potential Metabolites　
表で異なる行を選択するたびに更新されます。

6. Analog Sample クロマトグラムを選択した後、必要に応じて以下の作業を行い、データを統合
します。

• ピークを手動で統合する

• 既存のピークの統合を変更する

• ピークを削除する

変更を加えると、ソフトウェアは自動的にアナログサンプルクロマトグラムを更新します。

7. （オプション）Show Controls チェックボックスをオンにします。

Analog Sample クロマトグラムのタイトルの下に、最大 5 つの対照サンプルが表示されます。
Show Controls を参照してください。

8. （オプション）Baseline Subtract をクリックします。
ベースライン減算が、アナログサンプルと任意の対照サンプルの両方に適用されます。Analog
Sample クロマトグラムのタイトルと対照サンプルに "baseline subtracted" のフレーズ

が付加されます。ベースライン減算の実行を参照してください。

9. （オプション）R.T. Offset を変更します。R.T. Offset の変更を参照してください。
R.T. Offset は、アナログサンプルと対照トレースの両方に適用されます。

10. （オプション）アナログ積分 Options を適用します。アナログ積分オプションの設定を参照してく
ださい。

11. 次のいずれかの操作を行います。

• Update Table をクリックします。表を更新を参照してください。

• Update Results and Close をクリックします。結果を更新して閉じるを参照してください。

12. 次のいずれかの操作を行います。

• 現在開いている Results ファイルを保存し、既存のバージョンを上書きするには、Save をク
リックします。

• 現在開いている Results ファイルを新しい名前で保存するには、Save As をクリックしま
す。既存の Results ファイルは更新されません。

Show Controls
1. Analog Integration ダイアログの Chromatograms ペインで、Show controls チェックボック

スをオンにします。
該当する場合は、Chromatograms ペインの Analog Sample タイトルの下に最大 5 つの対照
サンプルが表示されます。該当する場合は、XIC ペインの MS Sample タイトルの下に最大 5
つの対照サンプルが表示されます。
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2.  アイコンをクリックするとリストが展開され、Analog Sample とアナログ対照の両方、または
MS Sample と MS 対照の両方が表示されます。

3.  アイコンをクリックすると、リストが折りたたまれ、Analog Sample または MS Sample のみ
が表示されます。

4. Show controls チェックボックスを再度オンにすると、ビューから対照が削除されます。

ベースライン減算の実行
1. Analog Integration ダイアログの Chromatograms ペインで、Baseline Subtract をクリックし

ます。
Analog Sample クロマトグラムがベースライン減算されます。ベースライン減算が、アナログサ
ンプルと対照トレースの両方に適用されます。Analog Sample クロマトグラムの名前に
"baseline subtracted" のフレーズが付加されます。

2. Baseline Subtract をもう一度クリックすると、ベースライン減算が解除されます。
Analog Sample クロマトグラムの名前から "baseline subtracted" のフレーズが削除さ

れます。

R.T. Offset の変更
Analog Integration ダイアログの Chromatograms ペインで、R.T. Offset フィールドの上下の矢印
を使用して保持時間オフセットを変更します。
Analog Sample クロマトグラムのピークが、指定した保持時間のオフセット分、シフトします。
Potential Metabolites 表が更新されたとき、または結果が更新されたとき、Analog R.T. (min) 列
の値は指定した保持時間オフセットのシフトを反映するように更新されます。オフセットは、アナログ
サンプルと対照サンプルの両方に適用されます。

アナログ積分オプションの設定
1. Analog Integration ダイアログの Chromatograms ペインで、Options をクリックします。

Analog Integration Options ダイアログが開きます。

2. 適用する各オプションのチェックボックスをオンにします。

オプション 説明

Overlay XIC for
peaks at the
same analog
retention time

アナログ保持時間が同一のこれらのトレースの MS サンプル XIC を重ね合
わせます。

Link x-axis Analog Sample クロマトグラムと XIC クロマトグラムの X 軸をリンクさせま
す。

3. OK をクリックします。

表を更新
Analog Integration ダイアログで変更を行うと、Update Table オプションが有効になります。
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Update Table をクリックします。

Potential Metabolites 表の以下の列の情報は、アナログピーク積分、アナログ保持時間、およびベ
ースライン減算に加えられた変更を反映して更新されます。

• Analog Sample クロマトグラムに割り当てた Peak ID は、手動による積分を反映するために更
新される場合があります。アナログピークの保持時間と MS ピークの保持時間が指定した許容
値内で一致した場合は、MS ピークと一致したと判断します。

• Analog - Peak Area は、新たに積分された領域があれば、それを反映して更新されます。

• Analog - % Area は、アルゴリズムに変更があれば、それを反映して更新されます。Analog -
% Area は、処理パラメータで指定した時間範囲内で、MS ピークに関連するものと関連しないも
のの両方を含め、すべてのアナログピークに基づいて計算されます。アナログピークが複数の
MS ピークと関連している場合、特定の M# にリストアップされているアナログピーク領域は、そ
の M# の XIC MS 領域に基づいて比例的に計算されます（関連するすべての MS ピークのピー
ク領域を合計として使用）。

• Analog - R.T. (min) は保持時間オフセットに加えられた変更を反映して更新されます。

注: これらの変更は Results ファイルには保存されず、Cancel をクリックして元に戻すことができま
す。

結果を更新して閉じる
Analog Integration ダイアログで変更を行うと、Update Results and Close オプションが有効に
なります。

1. Update Results and Close をクリックします。
変更した内容に基づくアナログ情報の更新が必要なことを確認するメッセージが表示されま
す。

2. Yes をクリックします。
Analog Integration ダイアログが閉じます。Potential Metabolites 表の以下の列の情報は、ア
ナログピーク積分、アナログ保持時間、およびベースライン減算に加えられた変更を反映して
更新されます。

• Analog Sample クロマトグラムに割り当てた Peak ID は、手動による積分を反映するため
に更新される場合があります。アナログピークの保持時間と MS ピークの保持時間が指定
した許容値内で一致した場合は、MS ピークと一致したと判断します。

• Analog - Peak Area は、新たに積分された領域があれば、それを反映して更新されます。

• Analog - % Area は、アルゴリズムに変更があれば、それを反映して更新されます。
Analog - % Area は、処理パラメータで指定した時間範囲内で、MS ピークに関連するもの
と関連しないものの両方を含め、すべてのアナログピークに基づいて計算されます。アナロ
グピークが複数の MS ピークと関連している場合、特定の M# にリストアップされているア
ナログピーク領域は、その M# の XIC MS 領域に基づいて比例的に計算されます（関連す
るすべての MS ピークのピーク領域を合計として使用）。

• Analog - R.T. (min) は保持時間オフセットに加えられた変更を反映して更新されます。
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トラブルシューティング 12
特定の問題についてのヘルプは、該当するリンクを選択してください。

• 構造ファイルが開かない

• ユーザー権限の変更

• 代謝物の候補が見つからない

• 見つかった代謝物の候補が多すぎる

• 長い処理時間

• ProgramData　フォルダーを表示する

• 既知の問題と制限事項

構造ファイルが開かない
構造ファイルが、これらの規則に従っていることを確認してください。

• フォーマット: mol

• バージョン: v2000 または v3000

• 内容: テキストを含まない

ユーザー権限の変更
Molecule Profiler ソフトウェアをインストールすると、インストールしたユーザーデータフォルダー内
のファイルの読み取り、書き込み、削除の権限がすべてのユーザーに付与されます。権限を変更す
ると、ソフトウェアが正常に動作しなくなる可能性があります。

注: インストールされたユーザーフォルダーのデフォルトの場所は
C:\ProgramData\SCIEX\Molecule Profiler Data です。

代謝物の候補が見つからない
目的のサンプルに含まれている代謝物をより多く見つけるには、次の手順を実行します。

• 別のピーク検出戦略を選択する。ピーク検出戦略の概要を参照してください。

• Chromatographic Data タブでクロマトグラム強度の最小値を小さくする。Chromatographic
Data タブを参照してください。

• MS Parameters タブで m/z Tolerance グループの MS m/z tolerance を大きくする。MS
Parameters タブを参照してください。

• MS Parameters タブで m/z Tolerance グループの Minimum MS peak intensity を小さくす
る。MS Parameters タブを参照してください。
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• （オリゴヌクレオチドワークフロー）MS Parameters タブで Isotope Pattern Tolerances グループ
の Intensity tolerance を大きくする。

見つかった代謝物の候補が多すぎる
代謝物候補の検出数を減らすには、次の手順を実行します。

• 別のピーク検出戦略を選択する。ピーク検出戦略の概要を参照してください。

• Chromatographic Data タブでクロマトグラム強度の最小値を大きくする。Chromatographic
Data タブを参照してください。

• Chromatographic Data タブで保持時間ウィンドウを縮小する。Chromatographic Data タブを
参照してください。

• MS Parameters タブの質量範囲ウィンドウを縮小する。MS Parameters タブを参照してくださ
い。

• MS Parameters タブで Isotope Pattern Tolerances グループの Minimum MS peak
intensity を大きくする。MS Parameters タブを参照してください。

長い処理時間
処理時間は、データの複雑さ、処理パラメータ、ワークステーション、オペレーティングシステムな
ど、多くの要因に左右されます。

処理に必要な時間を短縮するには、次の操作を行います。

1. ワークステーションで起動している他のアプリケーションをすべて終了します。

2. 処理パラメータの値を変更します。例：

• 選択したアルゴリズムの数を減らす。

• Chromatographic Data タブでクロマトグラム強度の最小値を大きくする。

• Chromatographic Data タブで保持時間ウィンドウを縮小する。

• MS Parameters タブで MS ピーク強度の最小値を大きくする。

• MS Parameters タブの質量範囲ウィンドウを縮小する。

• 選択した質量不一致・誤差フィルターの数を減らす（低分子のみ）。

• 生体内変換の数を減らす。

• （ペプチド、オリゴヌクレオチド、抗体薬物複合体ワークフロー）化合物固有のパラメータを調
整することで、生成される異性体の数を減らす。

ProgramData　フォルダーを表示する
Microsoft Windows オペレーティングシステムが C:\ProgramData フォルダーを非表示にする

場合があります。Molecule Profiler ソフトウェアのインストール後、すべてのユーザーが
C:\ProgramData\SCIEX\Molecule Profiler Data フォルダーを表示できることを確認し

てください。フォルダーが表示されていない場合は、以下の手順を実行します。

トラブルシューティング
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1. File Explorer で View > Options をクリックします。
Folder Options ダイアログが開きます。

2. View タブを選択します。

3. Hidden files and folder > Show hidden files, folders, or drives をクリックします。

4. Apply をクリックします。

5. OK をクリックします。

既知の問題と制限事項

結果データ

• MS ピーク領域を判定する際、時間換算係数 60 を適用して計算するようにしました。

解釈

• 構造割り当ての準備をするときは、Interpret Data ダイアログで変更を行った後に必ず Find を
クリックしてください。ソフトウェアは、選択した設定に基づいて、利用可能な式のリストを再計算
します。

相関

• 特定の代謝物の相対感度係数（RRF）が変化した場合は、MS 領域に RRF の値を乗じること
で、その代謝物が計算されます。選択した代謝物の更新された MS 領域は、Correlation
Details ペインの折れ線グラフ、棒グラフ、表のそれぞれに表示されます。

レポート作成

• レポート作成時に　Microsoft Word　のレポートテンプレートとの間に競合が発生する場合は、
すべての Microsoft Office アプリケーションを終了したことを確認してから、再度お試しください。
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カスタムオリゴヌクレオチドの例 A
5′ 末端チオリン酸にベンジルペンタンリンカーを結合したチオホスホルアミド酸オリゴヌクレオチド。

配列 化学構造、化学式、モノアイソトピック質量

5′-
ATCGATCGTTTAAA-
3′

図 A-1 : C149H203N65O57P 14S14 （4695.7400）

もう 1 つの末端を作成する
5' リンカー部分を構成する部分構造を同定するための一般的なスキームに従ってください。
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図 A-2 : もう 1 つの末端

1. Edit > Custom Elements をクリックします。

2. Oligo List タブで、New をクリックします。
New Oligo Residue or Terminus ダイアログが開きます。

3. Name フィールドに、たとえば 5' benzyl-pentane terminus のような名前を入力しま

す。

4. Symbol フィールドに、たとえば /CustomBP/ のような記号を入力します。

5. Composition Type フィールドで Other Terminus を選択します。

6. もう 1 つの末端のフィールドに入力します。

表 A-1 : もう 1 つの末端フィールド

フィールド 値

Terminus Moiety C11H15
Terminus Linker O
Phosphate Core HOPS

7. OK をクリックします。
次のメッセージとともに、Warning ダイアログが表示されます: The "Terminus Moiety"
field is usually odd electron.Do you want to continue?
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8. OK をクリックします。

内部残基をその他の残基として作成する
カスタム塩基を構成するサブストラクチャを同定するための一般的なスキームに従ってください。

図 A-3 : その他の残基

1. Edit > Custom Elements をクリックします。

2. Oligo List タブで、New をクリックします。

ヒント! カスタム残基を作成する場合は、4　つのヌクレオチドをすべて定義します。1 つのヌクレ
オチドを作成した後に New From をクリックして、残りの 3 つのヌクレオチドを作成することを
お勧めします。

New Oligo Residue or Terminus ダイアログが開きます。

3. アデニンヌクレオチドについては、次の手順を実行します。

a. Name フィールドに Custom dA と入力します。

b. Symbol フィールドに /CustomdA/ と入力します。

c. Composition Type フィールドで Other Residue を選択します。

d. その他の残基のフィールドに入力します。
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表 A-2 : その他の残基のフィールド

フィールド 値

Base C5H4N5
5' Linker O
Sugar Core C5H70
3' Linker NH
Phosphate Core HPOS

e. OK をクリックします。
次のメッセージとともに、Warning ダイアログが表示されます: The "Sugar Core"
field is usually odd electron.Do you want to continue?

f. OK をクリックします。

4. 残りの 3 つのヌクレオチドそれぞれについて、次のようにします。

a. /CustomdA/ を選択し、New From をクリックします。
New Oligo Residue or Terminus ダイアログが開きます。

b. NameSymbolBase を入力します。基本式については、次の表を参照してください。

表 A-3 : 基本式

ヌクレオチド 名前 シンボル 塩基

チミン Custom dT /CustomdT/ C5H5N2O2

グアニン Custom dG /CustomdG/ C5H4N5O

シトシン Custom dC /CustomdC/ C4H4N3O

c. OK をクリックします。

カスタム配列を書く
1. New > Oligonucleotide をクリックします。

2. Sequence ペインで以下を入力します。

/CustomBP/ /CustomdA//CustomdT//CustomdC/ /CustomdG//CustomdA//CustomdT/ /
CustomdC//CustomdG//CustomdT/ /CustomdT//CustomdT//CustomdA/ /CustomdA//
CustomdA/

3. Chemical formula フィールドをクリックします。
C149H203N65O57P14S14 がフィールドに表示されます。

カスタムオリゴヌクレオチドの例
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用語集 B
ソフトウェアによる代謝物の命名方法
代謝物候補の命名方法は 2 つあります。ピークが予測される代謝物の場合は、一致する生体内変
換、開裂代謝物、またはその 2 つの組み合わせに基づいて名前が付けられます。ピークが想定外
の代謝物である場合は、Loss of または Gain of と命名されます。

また、このソフトウェアは、各代謝物に式の候補を割り当てます。ユーザーは、ソフトウェアによる提
案式のリストから別の式を選択するか、式を手入力することで式を変更できます。

IDA
IDA メソッドは、測定中にフルスキャンスペクトルでイオンを検出し、その後に MS/MS で分析するイ
オンをリアルタイムで決定するメソッドです。

ピーク ID
ソフトウェアは、保持時間と m/z 値に基づいて、代謝物の候補を M1、M2、M3 ... のようにラベル付
けします。

相対感度係数
相対感度係数（RRF）は、ピーク領域に乗じることでピーク領域を人為的に増加または減少させる
値です。これにより、相関詳細グラフにおける当該ピーク領域のブロッティングを変更できます。

基準スペクトル
代謝物の候補を特定する際に用いられる、特定の化合物の MS/MS スペクトルです。

用語集
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お問い合わせ先

お客様のトレーニング
• 北米：NA.CustomerTraining@sciex.com

• ヨーロッパ：Europe.CustomerTraining@sciex.com

• ヨーロッパおよび北米以外：sciex.com/education

オンライン学習センター
• SCIEX Now Learning Hub

SCIEX サポート
SCIEX およびその代理店は、十分に訓練を受けた保守／技術専門要員を世界中に有しています。
システムまたは起こり得る技術的問題に関するご質問にお答えします。詳細な情報については、
SCIEX ウェブサイト (sciex.com) を参照するか、以下の連絡先までお問い合わせください。

• sciex.com/contact-us

• sciex.com/request-support

サイバーセキュリティ
SCIEX 製品のサイバーセキュリティに関する最新のガイダンスについては、sciex.com/
productsecurity を参照してください。

ドキュメント
このバージョンのドキュメントは、以前のすべてのバージョンのドキュメントに優先します。

このドキュメントを電子的に閲覧するには Adobe Acrobat Reader が必要です。最新バージョンを
ダウンロードするには、https://get.adobe.com/reader にアクセスします。

ドキュメントの最新版は SCIEX の web サイト（sciex.com/customer-documents）で入手できます。

注: このドキュメントの無料の印刷版を請求するには、sciex.com/contact-us までお問い合わせくだ
さい。
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